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B e g i n n i n g  w i t h  t h e  T I - N s p i r e ™  M a t h  
a n d  S c i e n c e  L e a r n i n g  H a n d h e l d   

Materials 
• TI-Nspire™ Math and Science 

Learning Handheld 

Overview 
Explore the functionality of the TI-Nspire ™ math and science learning 
handheld. 

 

Key Name Function 

x Click Key 
Selects an object on the 
screen.    

/ + x grabs an 
object on the screen. 

          Nav Pad 
 
 

Press the arrow keys to 
move the cursor/pointer.   

d Escape Key 
Removes menus or 
dialog boxes from the 
screen. 

e Tab Key 
Moves to the next entry 
field. 

c Home Key 
Displays the home 
menu. 

b Menu Key 
Displays application or 
context menu. 

Figures 1 and 2 

Figure 3 

Nav Pad Cursor 
Controls 

The Calculator Application  

1. Turn on the TI-Nspire ™ learning handheld. 
If the screen shown in Figure 3 is not 
displayed, press c and choose the 
Calculator application (Figure 3).  

 
Note: To select a menu option, you can highlight 
the option and press x or ·. Alternately, 
you can press the number key for that option. 
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2. Perform the operations shown in Figure 4-10. 

Note: screen shots for the CAS handheld 
may be different. 

• For an approximate value, press /·. 

• To clear the calculator screen, press b. 

Then press 1 for 1:Tools and 5 for 
5:Clear History.  
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 

 
 
 

• To access the square root command, press 
/q and choose the square root 
template or type sqrt(. 

• To access the absolute value command, press 
/r and choose the absolute value 
template or type abs(. 
 
 
 
 

Figure 4 

Figure 5 

Figure 6 
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• To access the degree symbol, press /�

k to go to the symbols menu. 
o Arrow to the right and select the o symbol 

and press ·. 
 
 
 
 
 
 
 

• Press /r to access the templates for 
matrices.  
 
 
 
 
 

Figure 7 

Figure 8 

Figure 9 

Figure 10 
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The Graphs & Geometry Application 
Basic Graphing 

1. Press c, then press 2 to choose 
2:Graphs & Geometry (Figure 11).  
• The Graphs and Geometry selection is now 

page two of the document.  
 
Note: The graphing window shown is the default 
window setting with a screen aspect ratio of one. 
 
 
 
 
2. The function notation f1(x) is shown in the 

entry line (Figure 12). 
 
 
 
 
 
 
 
 
 
 

3. Type 2x2-x+1 and press · (Figure 13). 
 
 
 
 
 
 
 
 

4. Rescaling the Axes. 

• Press d. 

• Place the cursor on one of the axes so that the 

hand appears and the tic marks flash  
(Figure 14).  

Figure 11 

Figure 12 

Figure 13 

Figure 14 
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• Press /x to grab a tick mark. Use the 

Nav Pad arrow keys to increase or decrease 
the maximum or minimum value and the 
scaling of the axes (Figure 15).  

• This method will rescale both axes and will 

maintain the aspect ratio of the default 
window. 
 
 

Alternate Graphing Method 

1. Open a new Graphs & Geometry application 
page. 

2. From the graphs screen, press b. 

• Press 1 for Tools and 5 for 5:Text 
(Figure 16). 
 
 
 
 
 
 

3. Click anywhere on the screen to open a text 
box. 

• In the text box, type 2x^2-x+1 and press 

· (Figures 17 and 18). 
 
 
 
 
 
 
 
 
 
 
 

Figure 15 

Figure 16 

Figure 17 

Figure 18 
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 4. Press d to exit the text mode.  
5. Use the Nav Pad arrow keys to move the 

cursor over the equation until the hand 
appears (Figure 19). 

• Press /x or hold down x until the 
hand closes.  
 
 
 
 
 
 

6. Drag the equation to the x-axis. 

• When the graph appears, press ·  
(Figures 20 and 21). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Document Model 

While creating your calculations and graphs, you 
should have noticed the tabs at the top of your 
screen. 
 

Moving Between Pages 

1. Press / and then ¡ (on the Nav Pad) to 
move back one page (Figure 22). 
  

Figure 19 

Figure 20 

Figure 21 

F(igure 22 
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2. To view all of the pages of the problem, 

press / and then £ (on the Nav Pad). 
See Figure 23. 

 
Note: This screen allows you to move from one 
page to another. To open the page that you wish 
to view, highlight the page by moving left or 
right with the Nav Pad. When the appropriate 
page is highlighted, press ·.�
�
 

Saving a Document 

1. Press /c to choose Tools.  

2. Press 1 for 1:File and 4 for 4:Save 
As…(Figure 24).  
 
 
 
 
 
 

3. When the Save As…dialog box appears, 
enter Parabola for the file name (Figure 25).  

4. Press e until OK is highlighted and press 
· to save the document.  

5. Check to see if the document was saved. 
 
 
 
 
 
 
 
 

6. Press c6 to select 6:My Documents 
(Figure 26).  
 
 
 

Figure 23 

Figure 24 

Figure 25 

Figure 26 
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7. The folder will appear showing the document 
that you have just saved (Figure 27). 

8. To reopen the document, highlight the file 
you wish to open and press ·. 
 

Note: All work done on the TI-Nspire™ learning 
handheld is contained within a document. Each 
document contains one or more problems with a 
maximum of 30 problems. Each problem 
contains one or more pages with a maximum of 
50 pages. Functions, stored variable, and data are 
retained throughout a problem  

 

Figure 27 
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B a s i c  G r a p h i n g  a n d  I n t e r p r e ta t i o n  
To o l s  f o r  t h e  T I - N s p i r e ™  M a t h  a n d  

S c i e n c e  L e a r n i n g  H a n d h e l d  

Materials 
• TI-Nspire™ math and science 

learning handheld 

Overview 
Graphing and Analyzing Functions 

 
 
 
 
Open a New Document 

1. Press c and 5 for 5:New Document 
(Figure 1).  
 
 
 
 
 
 
 
 

2. Press 2 for 2:Add Graphs & Geometry 
(Figure 2).  

 

 
 
 
 
 
 
 
 

Figure 1 

Figure 2 
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Graphing Functions 

1. If the Equation Entry Line window is in the 
“white” background, then you may simply 
start typing a function from the keyboard 
immediately (Figure 3).  
 
 
 
 
 
 
 
 
 
 

Note: A grayed out Equation Entry Line is shown 
in Figure 4. In this case, either press e or 

move the pointer to this window, and press x 
to activate the entry line.  

 
 
 

 
2. Type a function definition into the 

Equation Entry Line (Figure 5). Once the 
function definition is typed, press · to 
graph the function (Figure 6). 
 
 

 
• As the graph appears on the screen, a copy of 

the function definition appears on the screen. 
The function entry window scrolls to the next 
open slot in the function definition table, 
ready for the next function to be entered and 
graphed (Figure 6).  

 
 
 
 
 

Figure 3 

Figure 4 

Figure 5 

Figure 6 
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3. After the graph appears, readjust the 

viewing window. 

• Press d to get the pointer (Figure 7).  
• Place the cursor over one of the four axis 

values.  
 
 
 
 
 
 
 
 
 

• Press · or x twice (Figure 8). 
 
 
 
 
 
 
 
 
 

• Enter a new value and press · (Figure 9). 
Note: This method of adjusting the viewing 
window will not maintain the aspect ratio of the 
default window. 
 
 
 
 

4. The function definition for f1(x) appeared 
on the screen near the graph. This 
definition can be dragged to any convenient 
location on the screen, edited directly, or 
hidden from view. 

• Move the active pointer (or cursor) over the 
function until the hand appears (Figure 10).  

• Press /x to grab the function. 
 

Figure 7 

Figure 8 

Figure 9 

Figure 10 
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Figure 11 

 
 

• Drag the function to any location on the screen 
(Figure 11).  

• Press · or x to drop the function. 
Note: If the pointer (an arrow) is not visible, press 
d. 

 

Changing the Function Definition 

There are two ways to change a function definition 
after it is graphed. The first, and probably the most 
obvious, is to return to the Equation Entry Line 
and change the definition. 

1. If this entry line is “white,” simply press £ 
to scroll to the previous definition, f1(x) in 
this case (Figure 12). The cursor appears at 
the right end of the entered function 
definition. 

2. Use the arrow keys to scroll across the 
definition or . to erase unwanted 
characters. 

 
3. Type the new values into the definition, and 

press · to draw the new graph  
(Figures 13 and 14). 

 

 

 

 

 
 

 

 
 
 
 
 
 

Figure 12 

Figure 13 

Figure 14 
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A Different Method to Change the 
Definition of a Function 

1. Press d to make pointer active  
(Figure 15).  

• Hover over the function definition until a 
hand appears. 
 
 
 
 
 

2. Press · or x twice to open an edit 
box around the function definition  
(Figure 16).  

• The edit cursor is at the right end of this 
box. 

 
 
 
 
3. Once the edit box is open, use the arrow 

keys or . to enter new values and 
press · to graph the function  
(Figures 17 and 18).  

Note: This technique will work for any 
function definition appearing on the screen. 

 
 
 
 
 
 
 

Figure 15 

Figure 16 

Figure 17 

Figure 18 
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Entering Multiple Function Definitions 

Entering additional function definitions can be 
accomplished in several ways. One way is to 
simply type a new function in the Equation 
Entry Line. 
 
1. Type a new function definition into any 

open “slot” in the Equation Entry Line 
(Figure 19).  
 
 
 
 
 

• Press · to graph the new equation 
(Figure 20). 

 
 

 
 
 
 
2. Move your equations so that both can be 

seen separately (Figure 21). 
3. The list of functions can be scrolled with 

the £ and ¤ keys. 
4. The order of entry is not important but, 

after each entry, the list will scroll to the 
next available “slot” (Figure 21). 
 
 

A second way to enter another function is to 
clear the entry line and enter a new function. 
1. Use . to clear the entry line  

(Figure 22). 
 
 
 
 
 
 
 
 

Figure 19 

Figure 20 

Figure 21 

Figure 22 
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2. Type the function, e.g., g(x)=4+2x-x2, 

and press · (Figures 23 and 24). 

 

 

 

 
 
 
 
 

Scaling by Dragging an Axis 

Note: As previously indicated, the viewing 
window may be changed by editing the four 
axis values.  
 
 
 
1. Place the cursor on the x-axis so that the 

hand appears and the tic marks flash 
(Figure 25). 

2. To “grab” only the x-axis tic marks, for 
altering only the x-axis scale, press the 
g key and then the x key. 
 

3. Use the NavPad cursor control’s arrow 
keys to increase or decrease the 
maximum or minimum value and the 
scaling of the chosen axis  
(Figure 26). 

• Note: This method will not maintain the 
aspect ratio of the default window.  

Figure 23 

Figure 24 

Figure 25 

Figure 26 
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A third way to add more functions and their 
graphs to the screen is by direct entry on the 
Graphs & Geometry screen. 
 

1. Press c, and 2 for  
2:Graphs & Geometry to add a new page 
(Figure 27). 

 
 
 
 

2. Press /b and then 4 for 
4:Hide Entry Line (Figure 28).  
• Alternate way to hide the entry line: 

Press b, then 2 for 2:View, 

and 3 for 3:Hide Entry Line. 

 

 

 

3. Press b, then 1 for 1:Tools, and 5 for 
5: Text (Figure 29). Move to any location 
on the screen and press · for a text 
box. 

 

 
 
4. Type the definition of any function on the 

screen such as x2 + 2. Press ·  
(Figure 30). 

 
 

Figure 27 

Figure 28 

Figure 29 

Figure 30 
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5. With the cursor bar over the definition, 

press /x to grab the definition. 
• Drag the function definition onto the x- or 

y-axis.  
• As the definition hovers over the axis, a 

“ghost” of the function’s graph will appear 
(Figure 31). 

 
 

6. Press ·, and the function graph will 
appear as a solid line (Figure 32). 

 

 

 

 
Actively Manipulating Functions 

First, move and resize the graphing window for 
this function. To move the graphing window: 
1. Place the cursor in the first quadrant. 

Press d in case some other tool is 
active.  

2. Press /x to “grab” the graph 
screen (Figure 33).  
 
 
 
 
 

3. Use the NavPad arrow keys to move the 
graph on the screen (Figure 34).  

 

4. Resize the graphing window by dragging 
the endpoints of an axis. 
 
 
 
 

Figure 31 

Figure 32 

Figure 33 

Figure 34 
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• Place the cursor at the end of one of the 

axes (Figure 35).  

 
 
 

 

 

5. Press /x to grab the arrow at the 
end of the axis.  

• Use the NavPad arrow keys to increase or 
decrease the length of the axis.  

• This will change the maximum or 
minimum value but not the scaling of the 
axis (Figure 36). 
 
 
 
 
 

As you move the pointer close to the graph of a 
function, two different types of cursors appear. 
The two-directional arrow stretches the 
function (Figure 37). 
 
 
 
 
 
 
 
 
The four- directional arrow translates the 
function (Figure 38). 
 

Figure 35 

Figure 36 

Figure 37 

Figure 38 
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1. Place the pointer near the graph until the 

two-directional arrow appears. Press 
/x and use the NavPad arrow 
keys to stretch the function.  

• Note that the position of the vertex does 
not change. The new function definition is 
displayed as the graph is stretched  
(Figure 39). 

 
2. Place the pointer near the vertex of the 

graph until the four-directional arrow 
appears.  

• Press /x and use the  
NavPad arrow keys to translate the 
function.  

• The new function definition is displayed as 
the graph is translated  
(Figure 40). 
 

 

Tracing on a Function 

Press c and 2 for 2:Graphs & 
Geometry to add a new page. 
1. Enter the exponential function  

f3(x) = 1500(1+.05) x describing, for 
example, how $1500 grows at 5% in a 
system of yearly compounding interest 
over a number of years x. Press · 
(Figures 41 and 42). 

 
 
 
 
 
 
 
 
 
 

Figure 39 

Figure 40 

Figure 41 

Figure 42 



Basic Graphing and Interpretation Tools for the TI-Nspire™ Math and Science Learning Handheld 

T3 PROFESSIONAL DEVELOPMENT SERVICES FROM TEXAS INSTRUMENTS 

TI-NSPIRE™ TRAINING      © 2007 TEXAS INSTRUMENTS INCORPORATED 

 

 
Obviously, the graph is not displayed in 
this viewing window.  

1. Press b, choose 4 for 
4:Window, and 1 for 1:Window 
Settings (Figure 43). 

 
 
 

 
 
2. Enter the window parameters shown in 

Figure 44.  
 
 

 
 

 
 

3. Press e to highlight OK, and press 
· to display a graph that shows 
growth over the next 60 years  
(Figure 45). 

 
 
 
 
 
 
 

Figure 43 

Figure 44 

Figure 45 
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Figure 46 

 
 

4. Press b5 for 5:Trace. Use the left 
and right NavPad arrows to trace on the 
function (Figures 46 and 47). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

5. To find the function value at a specific 
value of x, enter the number while in the 
trace mode and press ·�
(Figures 48 and 49). 

 
 
 
 
 
 

 
 

 
 
 

 
 
 
 

Figure 47 

Figure 48 

Figure 49 
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Figure 50 

 
6. To mark a point on the graph of the 

function while in the trace mode, press 
x at the desired location (Figure 50). 

 
 
 
Decimal places may be added or removed from 
a number on the screen.  

1. Press d to exit the tracing mode.  
2. Hover over a number with the pointer 

until a hand appears and the number 
begins to blink (Figure 51).  

 
 
 
 
 
 
 

3. Press /b and choose 2 for 
2:Attributes.  

• The Attributes box appears  
(Figures 52 and 53).  

 
 
 
 
 
 
 
 
 
 

 
 
 
 
 

Figure 51 

Figure 52 

Figure 53 
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Figure 54 

 
4. Use the NavPad left and right arrow keys 

to decrease or increase the number of 
decimal places displayed (Figures 54). 

• Press · to exit the Attributes option. 
Note: Sometimes when you attempt to add 
decimal places to a number, nothing appears to 
happen. This means that there are no rounded 
digits hidden. 

 
Change the x-value of the marked trace point 
on the graph to a different year, in this case the 
25th year. 
1. Hover the pointer over the x-coordinate 

of the point, and press · or x twice 
to open a text box around the number  
(Figure 55). 
 
 
 
 
 
 

 
 

2. Enter the new value for x and press · 
(Figures 56 and 57).  

 
3. After 25 years of yearly compounding at 

5% interest, our original investment of 
$1500 will grow to be $5,079.53. 

 
 
 
 

Figure 55 

Figure 56 

Figure 57 
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The editing technique used to change the input 
value of the x-coordinate of the trace point can 
also be used for the y-coordinate. This has 
interesting mathematical implications. We can 
now ask “What value of f(x) will produce a 
specific value of x?” This can be a more 
important question than “What value of x will 
produce a specific value of f(x)?” For example, 
when will the value of the investment reach 
$10,000? 
1. Hover the pointer over the y-coordinate 

of the point and press the · or x 
key twice to open a text box around the 
number (Figure 58). 
 

2. Enter the new value for y and press · 
(Figure 59).  

• Note: This is a discrete problem, so the 
answer makes mathematical sense but not 
actual sense in this problem setting. 
 
 

Save the document. 

1. Press /c for the tools menu.  
2. Press 1 to select 1:File, and 4 for 4:Save 

As…(Figure 60).  
 
 
 
 
 
 

3. Enter the file name basic2 (Figure 61).  

4. Press the e key to highlight OK and 
press ·. 
 

Figure 58 

Figure 59 

Figure 60 

Figure 61 
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Growth at Various Interest Rates 

1. Add a new document.  
• Press c, and then press 5 to choose 

5:New Document.  
• Press 2 to choose 2:Graphs & 

Geometry.  
2. Compare the growth of our original 

$1500 under various interest rates (5%, 
6%, and 7%) by graphing all three 
models on the same axes.  

• Enter and graph f1(x) = 1500(1+.05)x,  
f2(x) = 1500(1+.06)x, and  
f3(x) = 1500(1+.07) x.  

• Choose an appropriate window (Figure 62).
 
 

3. Press b and choose 5 for 5:Trace 
(Figure 63).  

 
 
 
• Press the right or left NavPad arrow to 

scroll on the first function (Figure 64). 
• Press the up or down NavPad arrow to 

move from function to function. 
 
 

 
 
 
• Press the up or down NavPad arrow until 

the trace points appear on all three 
functions (Figure 65). 
o Note: Once the three trace points are 

displayed, pressing the right or left  
NavPad arrow key moves all three 
points simultaneously. 
 

Figure 62 

Figure 63 

Figure 64 

Figure 65 
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What are the various input values for x that 
produce a given output value for all of the 
defined functions, f1(x), f2(x), and f3(x)? This 
amounts to simultaneously solving all the 
graphed functions. For this problem, how 
many years will it take to reach a savings 
amount of $10,000 at each interest rate?  

1. Press d.  

2. Press e to move to the equation entry 
line. 

3. Enter f4(x) = 10000 and press · to 
graph (Figure 66 and 67). 

 
 
 
 
 
 
 

4. Press b, and choose 6 for 6:Points 
& Lines, and then 3 for 3:Intersection 
Point(s). See Figure 68. 

 
 
 
 
 

5. Move the cursor to the intersection of 
horizontal line and one of the functions. 
Both should appear dashed.  

• Press x or · to mark the point of 
intersection (Figure 69). 

 
 
 
 
 
 

Figure 66 

Figure 67 

Figure 68 

Figure 69 
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6. Repeat this procedure for each of the 

other points of intersection (Figures 70). 
 
 
 
 

7. Move the coordinates of the points of 
intersection to display all three clearly. 

• Move the cursor to hover over an ordered 
pair.  

• Press /x, and drag the ordered pair. 
• Repeat for the other two ordered pairs. 

(Figure 71). 
 
 

8. Compare the number of years for each 
interest rate.  

Note: Again, this result is mathematical, and 
not realistic given the discrete nature of yearly 
compounding interest in this problem setting. 

 
Change f4(x), and determine how many years 
it will take to reach a savings amount of 
$15,000 at each interest rate  
(Figures 72 and 73). 
 
 
 
 
 
 

Figure 70 

Figure 71 

Figure 72 

Figure 73 
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B a s i c  G e o m e t r y  

Materials 
• TI-Nspire™ Math and Science 

Learning Handheld 

Overview 
Our experience has shown that people who have had prior experience with 
any interactive geometry software (handheld or computer) will learn to use  
the TI-Nspire™ learning handheld more easily than others. It is important to 
master some basic geometry skills in order to facilitate learning. 

 

Introduction 

The following problems related to triangles will 

introduce you to the Graphs & Geometry 

application on the TI-Nspire™ math and science 

learning handheld. 

 
Opening a New Graphs & Geometry 
Document 

1. Press c5 for Home, 5:New Document 

(Figure 1). 

Note: If a Save option appears, select Yes or No 

to save the document that was open when 

the TI-Nspire™ handheld was last used. 

2. Press 2 for 2:Add Graphs & Geometry  

(Figure 2). 

 

 

 

 

 

 

 

Figure 1 

Figure 2 
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Figure 3 

Figure 4 

Figure 5 

Figure 6 

Hiding the Axes and the Entry Line 

1. Press b 2 for Menu 2:View. 

2. Press 1 or · to choose 1:Hide Axes 

(Figures 3 and 4). 

3. Press b 2 for Menu 2:View. 

 

 

 

 

 

 

 

 

 

 

4. Press 3 to choose 3:Hide Entry Line 

(Figure 5 and 6). 

Note: An alternate way to select a menu option 

is to press b and then use the NavPad 

cursor controls to highlight the desired 

option. Then, press the center x key or 

the · key to select the option. 

 

Exploring the Page 

1. Use the NavPad cursor controls to explore 

moving around on the page. 
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2. Press b, and look at the options in the 

following submenus: 

• Menu 6:Points & Lines 

• Menu 7:Measurement 

• Menu 8:Shapes 

• Menu 9:Constructions 

• Menu A:Transformation 

3. After pressing the ¢ key to investigate 

submenu options in a particular menu 

selection, press the d key to exit that list 

of menu options. 

4. Press d a second time to exit the Menu 

structure entirely. 

 

Interior Angles of a Triangle 

Construct a triangle, ∆ABC.  

1. Choose the Triangle tool by pressing b 

8 2 for Menu 8:Shapes, 2:Triangle 

(Figure 7). 

2.  Using the NavPad cursor controls, position 

the pointer to construct a triangle near the 

center of the screen. 

3. Press the x key or the · key to place 

the first vertex on the screen. 

• One way to label vertices and points is to 

type the label immediately after pressing 

x or · to place the vertex or point on 

the screen. (Point should be flashing.) 

• For capital letters, press the g key before 

pressing the letter key (Figure 8). 

 

Figure 7 

Figure 8 
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4. Using the NavPad again, move the cursor to 

a second location for the next vertex. 

5. Press x or · to place the second vertex. 

6. Type the label immediately. 

7. Repeat these steps to create a third non-

collinear location for the third vertex, and 

type its label. 

8. Move away from the label, and press the 

d key to deselect the triangle tool. 

• If you didn’t label one or more of the vertices 

when constructing the triangle (as shown in 

Figure 9), you can label the vertex using the 

Text tool. 

9. Press b 1 5 for Menu 1:Tools,  

5:Text (Figure 10). 

10. Use the NavPad cursor controls to move 

close to the vertex. 

• The vertex should blink. Be sure that the 

entire triangle does not blink. 

 

11. Press x or · to open an edit box 

(Figure 11). 

12. Press the appropriate letter key and · to 

close the edit box. 

 

 

 

 

 

 

 

Figure 9 

Figure 10 

Figure 11 
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13. Press the d key to deselect the Edit tool 

(Figure 12). 

 

Dragging a Label 

Drag a label to another location on the screen.  

1. Use the NavPad cursor controls to move 

close to the object that is to be moved, e.g., 

label ‘C’. 

2. When an open hand appears, press the / 

key followed by the x key to “close” the 

hand. 

Note: If the open hand does not appear when 

the arrow key is close to the object to be 

moved, press the d key. 

Note: When the open hand appears, holding 

down the click key x will also “close” 

the hand. 

3. Drag the label to the desired location, and 

press · (Figure 13). 

• If the label appears shaded after moving 

away from the label, press the d key. 

 

Changing Document Settings 

If the Settings information at the top of the page 

indicates RAD for Radian (see Figure 13 above), 

change this document setting to Degree. 

1. Press c 8 for Home 8:System Info. 

2. Press 1 for 1:Document Settings  

(Figure 14). 

3. Press the e key to move to Angle. 

Figure 12 

Figure 13 

Figure 14 
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 • The box to the right of the word Angle 

should be highlighted (outlined). 

4. Press the down on the NavPad cursor control 

to highlight Degree. 

5. Press · (Figure 15). 

6. Press · again to exit Document Settings. 

• Alternately, press the e key until the box 

containing OK is highlighted, and then press 

· to exit. 

 

Measuring the Three Interior Angles 

1. Press b 7 4 for Menu  

7:Measurement, 4:Angle (Figure 16). 

2. Move the cursor on the screen with the 

NavPad to select each vertex. 

• The vertices must be selected in either a 

clockwise or counter-clockwise direction, 

just as angles are named. 

Note: To select a vertex, use the NavPad cursor 

controls to move close to a vertex. When 

the “pencil” shape on the screen changes 

to a “hand” shape, press · or x to 

select the vertex (Figure 17). 

Note: Regardless of direction, the vertex of the 

angle to be measured must be selected 

second. Not only is the angle drawn, but 

the angle being measured is temporarily 

marked. 

 

 

 

Figure 15 

Figure 16 

Figure 17 
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3. After pressing · or x at the third 

vertex, drag the measured angle value to an 

appropriate location on the screen, and press 

· (Figure 18). 

 

 

 

 

4. Repeat to measure the other two angles 

(Figure 19). 

 

Calculating the Sum of the Three Angles 

Note: For a calculation, an expression or 

statement must first be entered on the 

page. 

1. Press b 1 5 for Menu 1:Tools,  

5:Text. 

2. Position the pointer in an empty location on 

the screen. 

3. Press · or x to open the edit box 

(Figure 20). 

4. Type the statement s = a + b + c on 

the screen using the keypad, and press · 

to affix the statement to the screen  

(Figure 21). 

Note: You cannot put an equals sign at the end 

of this type of statement, but you can 

start with a word or letter like ‘s’ as long 

as it is not a reserved word like ‘cos.’ 

5. Press b 1 7 for Menu 1:Tools,  

7:Calculate to select the Calculation tool. 

Figure 18 

Figure 19 

Figure 20 

Figure 21 
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6. Point at the statement s = a + b + c 

and press · to select this calculation rule 

(Figure 22). 

• As you move away from the calculation rule 

and near an angle measurement, a box will 

appear with a message asking for the first 

variable in the calculation. 

 

• In this example, the message is ‘Variable a?’ 

(Figure 23).  

7. Move near the first measurement. 

 

 

 

8. When a “hand” appears, select the angle 

measurement by pressing · or x 
(Figure 24). 

• When you move away from the first angle 

measurement, the second variable value is 

requested. 

9. Move to the second angle measurement and, 

when the hand appears, select it by pressing 

· or x. 

10. Repeat this procedure to select the remaining 

angle measurement. 

• A sum will appear on the screen as you move 

away from the last measurement selected.  

11. Press · to affix the sum to a convenient 

location on the screen (Figure 25).  

 

 

Figure 22 

Figure 23 

Figure 24 

Figure 25 
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• If desired, use the Text tool to label this 

numerical result (Figure 26). 

 

 

 

 

Drag one of the vertices, and make a conjecture 

about the sum of the interior angles of a triangle 

(Figure 27). 

Note: To drag a vertex, follow the steps 

described earlier for dragging a label. 

Does your conjecture hold for any type of 

triangle? Explain your reasoning. 

 

Increasing or Decreasing the Number of 
Decimal Places Displayed 

1. Press b 1 3 for Menu 1:Tools,  

3:Attributes. 

2. Select a number (e.g., an angle measurement) 

on the screen (Figure 28). 

3. Type the number of desired decimal places 

from the keypad, or use the NavPad right or 

left cursor controls to increase or decrease 

the number of decimal places displayed 

(Figure 29). 

4. Press ·. 

5. Press the d key to exit the Attributes tool. 

 

 

 

Figure 26 

Figure 27 

Figure 28 

Figure 29 
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Note: There is an alternate method for 

increasing or decreasing the number of 

decimal places. 

Press the d key and point to the 

measurement. When a hand appears, 

press the plus key (+) to increase the 

number of decimal places displayed or 

the minus key (-) to decrease the 

number of decimal places displayed. If 

the measurement is exact to a given 

decimal place, no non-significant digits 

will appear. 

 
Saving the Document 

1. Press / c 1 4 for 1:File,  

4:Save As (Figure 30). 

2. Enter the name ‘triangle,’ and press · to 

save the file (Figure 31). 

 

 

Inserting a New Problem and 
Constructing a Triangle 

1. Open a new problem by pressing / c 

2 8 for 2:Edit, 8:Insert Problem 

(Figure 32).  

2. Select 2:Add Graphs & Geometry. 

3. Press b 2, and choose 1:Hide Axes.  

4. Press b 2 again, and choose 3:Hide 

Entry Line. 

5. Construct a triangle, ∆ABC, near the center 

of the screen. 

Figure 30 

Figure 31 

Figure 32 
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 • Choose the Triangle tool by pressing b 

8 2 for Menu 8:Shapes, 2:Triangle. 

• Label the vertices as you construct the 

triangle, entering the letter after pressing 

· to construct each vertex (Figure 33). 

 

Measuring Lengths of the Sides and 
Perimeter of the Triangle 

Measure the lengths of the sides of the triangle. 

1. Press b 7 1 for Menu  

7:Measurement, 1:Length. 

2. Select two vertices of the triangle to measure 

the length of a side. 

• After two vertices are selected, the 

measurement will appear with a “hand” 

attached. 

3. Drag the measurement to the desired 

location, and press · (Figure 34). 

4. Repeat to find the length of the other two 

sides. 

Measure the perimeter of the triangle. 

5. With the Measurement (Length) tool active, 

select a side of the triangle.  

6. The entire triangle should blink (Figure 35).  

7. Drag the perimeter measurement to a desired 

location, and press ·. 

8. Press d to exit the Length tool.  

 

 

 

Figure 33 

Figure 34 

Figure 35 
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 9. Label the perimeter (Figure 36). 

 

Finding the Sum of the Measures of the 
Three Sides 

1. Press b 1 5 for Menu 1:Tools,  

5:Text, and press · to open an edit box.  

 

 

2. Enter the expression a+b+c, and press · 

(Figure 37). 

3. Use the Calculation tool (Menu 1:Tools,  

7:Calculate) to find the sum of the three sides 

of the triangle. 

4. Select the expression and then the three 

measures of the sides. 

5. Move the sum next to the expression a+b+c, 

and press · (Figure 38). 

6. Press d to exit the Calculate tool. 

 

 

 

Drag a vertex of the triangle, and make a 

conjecture about the definition of the perimeter 

of a polygon (Figure 39).  

 

Saving the Document 

1. Press / c 1 3 for 1:File,  

3:Save. 

Note: Pressing / S will also save the 

document. 

Figure 36 

Figure 37 

Figure 38 

Figure 39 
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Investigate 

Interior Angles of a Triangle 

Dragging a vertex of the triangle should suggest 

that the sum of the angles of a triangle is equal to 

180°. 

Perimeter of a Triangle 

Dragging a vertex of the triangle should suggest 

that the sum of the sides of a triangle is equal to 

the perimeter of the triangle. 

 

Measuring the Area of the Triangle 

1. Press b 7 2 for Menu  

7:Measurement, 2:Area. 

2. Move the cursor close to a side of the 

triangle. 

• The entire triangle should blink. 

3. Press · or x. 

4. Move the measurement to a convenient 

location on the screen, and press ·. 

5. Label the area (Figure 40). 

 

Measuring the Altitude of the Triangle 

Note: The length tool will measure the 

perpendicular distance from a point or 

vertex to a line, line segment, or ray. 

Construct a line on one side of the triangle using 

the line construction tool. 

1. Press b 6 4 for Menu  

6: Points & Lines, 4: Line (Figure 41). 

Figure 40 

Figure 41 
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2. Select two vertices. 

• A line on side AB was constructed in this 

example. 

3. Press b 7 1 for Menu  

7:Measurement, 1:Length. 

4. Select vertex C and the line constructed on 

the opposite side of the triangle. 

• In this example, the measurement is the 

perpendicular distance from vertex C to the 

line on side AB (Figure 42). 

5. Move the measurement to a convenient 

location on the screen, and label the altitude 

(Figure 43). 

6. To hide the line, press b 1 2 for 

Menu 1:Tools, 2:Hide/Show. 

7. Move close to the line until an “eye” appears, 

and press · or x. 

8. Press d to exit the Hide/Show tool. 

 
Calculating .5bh 

1. Press b 1 5 for Menu 1:Tools,  

5:Text. 

2. Move the cursor to an empty space on the 

screen. 

3. Press · or x to open the edit box. 

4. Enter .5b*h from the keypad, and press 

· (Figure 44). 

5. Press b 1 7 for Menu 1:Tools,  

7:Calculate. 
6. Select the expression .5bh. 
7. Next, select the base and height 

measurements. 

Figure 42 

Figure 43 

Figure 44 
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 8. Move the result of the calculation next to the 

expression .5b*h and press ·  

(Figure 45). 

 

 

 

Drag a vertex of the triangle, and make a 

conjecture about the area of a triangle  

(Figure 46). 

 

Constructing an Altitude    

First, construct a line through a vertex 

perpendicular to the opposite side. 

1. Press b 9 1 for Menu  

9:Construction, 1:Perpendicular. 

2. Select a vertex and the opposite side. 

• In this example, vertex C and side AB were 

selected (Figure 47). 

Note: Either the vertex or the side may be 

selected first. 

Overlay the altitude on the perpendicular line 

using the segment tool.  

3. Press b 6 5 for Menu 6:Points & 

Lines, 5:Segment. 

4. Select the vertex and then the intersection of 

the perpendicular line and the base of the 

triangle (Figure 48). 

Note: Both the perpendicular line and the 

triangle should blink when selecting the 

intersection of the perpendicular line and 

the base of the triangle. 

Figure 45 

Figure 46 

Figure 47 

Figure 48 
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 5. Hide the perpendicular line by pressing b 

1 2 for Menu 1:Tools, 2:Hide/Show. 

6. Select the line, press ·, and move the 

cursor away from the line when it appears 

dashed. 

7. Press d (Figure 49). 

Note: The hidden axes also show when in 

Hide/Show mode. 

8. To Show the line, select the Hide/Show tool 

again, select the dashed line, and press ·. 

 

Storing the Height, Base, and Area 
Measurements as Variables 

Note: To provide additional space, hide the two 

side measurements. 

Select the height measurement.  

1. Move the arrow close to the measurement.  

2. When the hand appears, press ·.  

• The measurement should appear shaded 

(Figure 50). 

3. Press h, the var key (Figure 51). 

4. Select 1:Store Var by pressing · or 1. 

• A box with var: = appears. Var is the 

default variable name. 

5. Type ht to overwrite var. 

 

 

 

 

 

Figure 49 

Figure 50 

Figure 51 
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 6. Press · (Figure 52). 

• If desired, drag the measurement and variable 

name to another location on the screen. The 

variable name ht should appear in bold text. 

Note: A measurement can also be stored by 

highlighting the measurement and 

pressing / h. The var: = box 

appears. 

7. Press d before selecting the second 

measurement. 

8. Select the base measurement, and press 

/ h. 

9. Type the variable name b to overwrite var.  

10. Press · and then d (Figure 53).  

 

 

11. Repeat to assign the variable name area to 

the area value (Figure 54). 

12. Hide the original height and area labels, if 

desired. 

13. Hide the altitude and its point of intersection 

with the base.  

 

Comparing .5b*ht and Area on a  
Calculator Page 

1. Add a new page by pressing c  

1:Calculator (Figure 55). 

 

 

 

 

Figure 52 

Figure 53 

Figure 54 

Figure 55 
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 Note: A new page can also be added by 

pressing / c 2 7 for  

2:Edit, 7:Insert Page. 

2. Enter .5b*ht, and press · (Figure 56).  

Note: As b and ht are entered, they appear in 

bold text since they are variable names. 

 

3. Enter area, press ·, and compare the 

values (Figure 57). 

Note: If one of the document settings shown at 

the top of the page is EXACT rather than 

AUTO, press / · for an 

approximate answer. 

Note: To change the document setting to 

AUTO, press c 8 for System Info. 

Press 1 for Document Settings. Press 

the e key until the box to the right of 

Exact or Approx. is highlighted. Use the 

NavPad cursor controls to highlight Auto. 

Press · to choose Auto and · 

again to store the setting. The page 

should show the word AUTO at the top.  

 

Return to the Graphs & Geometry Page 

1. Press / ¥ (left of the NavPad) to return 

to the previous page which was the Graphs & 

Geometry page. 

2. Drag a vertex to change the values on the 

screen (Figure 58). 

 

 

Figure 56 

Figure 57 

Figure 58 
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Figure 59 

Return to the Calculator Page 

1. Press / ¦ (right of the NavPad) to 

return to the Calculator page. 

2. Move up using the NavPad to highlight the 

expression.5b*ht (Figure 59). 

3. Press · to copy the expression to the 

command line, and press · again to 

perform the computation. 

4. Move up using the NavPad to highlight the 

word area. 

5. Press · twice. (Figure 60). 

6. Compare the values. 

 

Constructing a Line Parallel to Side AB not 
passing through Point C 

1. Press / ¥ to return to the Graphs & 

Geometry page. 

• If necessary, drag the triangle to a lower 

location on the screen to leave space above 

the triangle. 

2. Show the parallel line constructed on side 

AB by pressing b 1 2 for Menu  

1:Tools, 2:Hide/Show. 

3. Select the line, and press d to exit the 

Hide/Show tool. 

4. Press b 9 2 for Menu  

9:Construction, 2:Parallel. 

5. Select the segment previously constructed on 

side AB (Figure 61). 

 

Figure 60 

Figure 61 
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6. Move the parallel line to an open space on 

the screen, and press · (Figure 62).  

Note: Since no specific point on the screen was 

selected, a point was placed on the 

screen. 

 

Redefining Point C to be on the Parallel Line 

1. Press b 1 8 for Menu 1:Tools,  

8:Redefine. 

2. Select point C, and then select the parallel 

line (Figure 63). 

Note: When selecting the parallel line, be sure 

not to select the defining point of the line. 

• The point (vertex C) will be constructed on 

the line as if it were constructed there 

initially when the triangle was constructed. 

3. Press d. 

4. Hide the line constructed on side AB. 

Drag the point (vertex C) on the parallel line, 

and make a conjecture about the area of the 

triangle (Figure 64). Explain the conjecture. 

 

Investigating the Area of a Triangle 

Dragging a vertex of the triangle should suggest 

that the area of a triangle is equal to one-half the 

base times the height, or A = .5bh. 

Dragging a vertex of the triangle on a line 

parallel to the base of the triangle should suggest 

that the area of the triangle stays the same since 

there is always a common base and a common 

height. 

Figure 62 

Figure 63 

Figure 64 
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B a s i c  D a ta  A n a l y s i s  

Materials 
• TI-Nspire™ Math and Science 

Learning Handheld 

Overview 
This data set is taken from a biology activity and revised to use with 
the TI-Nspire™ learning handheld. 

 

Figure 1 

Introduction 

The following table shows the weight/blood 

volume relationship in humans: 
 

Weight in Pounds Blood Volume in Pints 
60 5 
84 7 
108 9 
132 11 
156 13 
180 15 
204 17 
228 19 
252 21 
276 23 
300 25 

We will use this data to explore the graphing 
capabilities of the TI-Nspire™ learning 
handheld. 

 
Creating a List 
In order to enter data and then graph it, you will 
need to open a New Document. 

1. Press the Menu key c and 5 to select 

New Document. (Figure 1). 
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Figure 2 

Figure 3 

Figure 4 

2. Press 3 to choose 3: Add Lists & 

Spreadsheet (Figures 2 and 3). 

 

 

 

 

 

 

 

 

 

 

 

 

3. Enter the weights into column A (Figure 4). 

Use the Fill down function for the blood volume. 

4. Enter 5 and 7 into the first two rows of 

column B. 

5. Move up using the NavPad cursor control 

until 5 is boxed in. 

6. Press the g key and the down arrow ¤ at 

the same time. This will highlight 5 and 7 

(Figure 5). 

 

 

 

 

Figure 5 
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7. Press b 3 3 to choose Menu 

3:Data, 3:Fill Down (Figure 6). 

 

 

 

 

8. Move down using the NavPad until the 

highlighted border is across from 300. 

(Figure 7). 

9. Press the · key to fill the column. 

 

10. Label the columns.  

• Using the NavPad, move up and left to the 

white space next to the “A” column heading, 

and type in ‘weight’ (Figure 8).  

•  Press the · key. 

 

 

 

 

11. Do a similar operation for column ‘B’ 

labeling it ‘pints’ (Figure 9). 

 

 

 

 

 

Figure 6 

Figure 7 

Figure 8 

Figure 9 
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Graphing the Data 

In order to graph the data, you will need to add a 

new page to this problem. 

1. Press the c key, and press 2 to add a 

Graphs & Geometry page (Figure 10). 

 

 

2. The default graph screen is shown in  

Figure 11. 

 

 

 

 

 

3. Press b 3 3 to choose Menu 

3:Graph Type, 3:Scatter Plot (Figure 12). 

 

 

 

 

 

4. Press x to open the x-values list, arrow 

down to ‘weight,’ and press x to choose 

weight (Figure 13). 

 

 

Figure 10 

Figure 11 

Figure 12 

Figure 13 
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5. Move to the right to highlight the y-values 

list, and press x. 

6. Select ‘pints,’ and press x. (Figure 14) 

 

 

 

7. Press b 4 9 to choose Menu 

4:Window, 9:Zoom – Stat (Figures 15  

and 16). 

 

 

 

 

 

 

 

 

 
Graphing and Regression Lines 

Let’s determine the regression equation for the 

set of data.  

1. Press / ¥ (to the left of the NavPad) to 

return to the spreadsheet.  

(Figure 17). 

 

Figure 14 

Figure 15 

Figure 16 

Figure 17 
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2. Press b 4 1 to choose Menu  

4: Statistics, 1:Stat Calculations, and press 

3 to choose 3:Linear Regression (mx+b) 

(Figures 18 and 19). 

 

 

 

 

 

 

 

 

 

 

3. The Linear Regression (mx+b) set up box 

will appear on the screen (Figure 20). 

 

 

 

 

 

 

4. Press the down arrow on the NavPad cursor 

control to choose ‘weight,’ and press x  

(Figure 21). 

�

�

�

Figure 18 

Figure 19 

Figure 20 

Figure 21 
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 �

5. Press the e key to change to the Y-List.  

Press the down arrow key and choose ‘pints’ 

(Figure 22). 

 

 

 

 

6. Press e until OK is highlighted, and press 

the x button (Figures 23 and 24) 

 

 

 

 

 

 

 

 

 

 

 

7. Press / ¦ to return to the Graphs & 

Geometry page (Figure 25). 

 

 

 

Figure 22 

Figure 23 

Figure 24 

Figure 25 
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8. Press b 3 1 to choose Menu 

3:Graph Type, 1:Function (Figures 26  

and 27). 

 

 

 

 

 

 

 

 

 

 

 

9. Press the £ key so that f1(x) appears in the 

Entry Line, and then press the · key. 

(Figures 28 and 29). 

 

 

 

 

 

 

 

 

 

 

 

Figure 26 

Figure 27 

Figure 28 

Figure 29 
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Hiding Equations and Moving Labels  

1. Press the d key to move up from the 

entry line and get an arrow cursor  

(Figure 30). 

 

 

2. Press b 1 2 to choose Menu 

1:Tools, 2:Hide/Show (Figure 31). 

 

 

 

 

 

3. Move the cursor over the equation until the 

hide cursor appears, and press the x key 

(Figures 32 and 33). 

 

Figure 30 

Figure 31 

Figure 32 

Figure 33 
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4. Press the d key to exit Hide/Show. 

5. Move the cursor over the label ‘weight’ and 

press the / and x keys to grab the 

label on the screen (Figures 34 and 35). 

 

 

6. While the hand is closed, drag the label to a 

location where it can be viewed, and press 

the x key to release the label and affix it to 

the new location on the screen (Figure 35). 

 

 

 

 

 

 

Explore Various Weights with the 
Regression Equation 

1. Press b 5 to choose Menu 5:Trace 

(Figure 36). 

 

 

 

 

 

2. Press the £ key on the NavPad to change 

from the plot to the equation (Figure 37). 

 

 

 

Figure 34 

Figure 35 

Figure 36 

Figure 37 
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3. Press the ¡¢ keys on the NavPad to move 

left and right on the graph of the regression 

equation until you reach your weight  

(Figure 38). 

4. Type 200, and the value will appear on the 

screen. (Figure 39). 

5. After typing the number, press · to find 

the number of pints of blood at 200 pounds. 

 

Other Ways to Analyze the Data  

Place a point on the line, and manipulate the  

x-value to determine y or manipulate the y-value 

to determine the x.  

1. Press the d key to exit trace mode. 

2. Press b 6 2 to choose Menu 

6:Points &Lines, 2:Point On (Figure 40). 

 

 

 

 

3. Move the cursor pencil onto the line until an 

ordered pair appears, and press the x key 

to drop the point on the line. (Figure 41). 

 

4. Press the d key to exit the Point On 

mode. 

 

 

Figure 40 

Figure 38 

Figure 39 

Figure 41 



Basic Data Analysis 

T3 PROFESSIONAL DEVELOPMENT SERVICES FROM TEXAS INSTRUMENTS 

EXPLORING MATHEMATICS WITH TI-NSPIRE™ TECHNOLOGY   © 2007 TEXAS INSTRUMENTS INCORPORATED 

 

  

5. Place the cursor over the x-coordinate, and 

press the x key twice (Figure 42). 

6. Enter a new value for weight, and press the 

x key to see the number of pints. 

Change the pints to determine the weight.  

 

7. Place the cursor over the y-coordinate and 

press the x key twice (Figure 43). 
 

 

 

 

 

 

8. Enter the new number of pints (y), and press 

the x key to see the new weight (x) 

(Figure 44). 

 

 

 

Figure 42 

Figure 43 

Figure 44 
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D i f f e r e n c e s  b e t w e e n  T I - N s p i r e ™  
H a n d h e l d  a n d  C o m p u t e r  S o f t w a r e  

Materials 
• TI-Nspire™ Math and Science 

Learning Handheld 
• TI-Nspire™ Computer Software for 

Math and Science 

Overview 
This document provides a quick reference guide explaining the minor 
differences between using the TI-Nspire™ math and science learning 
handheld versus the TI-Nspire™ computer software for math and science. 

 

Introduction 

In designing the TI-Nspire™ math and science 

learning technology, Texas Instruments has 

taken into consideration the innate differences 

between handheld technology and computer 

software. 

When using the TI-Nspire™ handheld 

technology, users access menus and operations 

through keys and the multi-directional NavPad 

cursor control. 

Computer software users rely on the computer 

keyboard and mouse when using the TI-Nspire™ 

computer software. 

These native differences necessitate differences 

in navigation and access between TI-Nspire™ 

handhelds and computer software. By taking 

advantage of these native differences, TI is able 

to provide improved usability for both the 

handheld and computer software user while 

maintaining a parallel learning and teaching 

experience. 
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Except for the HOME screen and Page Tools 

menu of the TI-Nspire™ handheld, the 

underlying structure of the menus in each 

application is the same for both the TI-Nspire™ 

handheld and computer software. However, users 

will find differences between the handhelds and 

the computer software in the ways in which they 

access menus. 

 

 

This document provides an overview of the differences users will find in tasks and menus: 

 
Task Handheld Desktop Software 

Browse and organize 
documents My Documents MS Windows® file system 

Organize problems and 
pages within a document 

Page Sorter  
(must be accessed) Page Sorter (optional side pane) 

Access applications, 
documents, system 
information, and hints/help 

Home Screen 
Desktop menus: 
• File 
• Insert 

Manage/edit documents, 
manage pages, and select 
applications 

Page Tools Menu 

Desktop menus: 
• File 
• Edit 
• Insert 

Change views 

Fonts: 
• small 
• medium 
• large 

Views: 
• Standard/Default 
• Presentation  
• TI-Nspire™ Handheld  
• Keypad 

Move between applications 
on a handheld CTRL+Tab Key n/a 

Move between the page 
sorter, application menu 
bar, and page workspace in 
the computer software 

n/a CTRL+Tab Key 

Navigate the screen 
NavPad cursor controls 
Tab and Arrow Keys 

Mouse 
Keyboard Tab and Arrow Keys 
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Tasks 

Task: Browse and organize documents 

TI-Nspire™ handheld: 

The handheld has its own document browser 

called My Documents. 

With this document browser, users can organize 

all the documents stored on a handheld, creating 

multiple folders and storing documents in the 

order that works best for them (Figure 1). 

To go to My Documents: 

1. From the Home Screen, select 6: My 

Documents. 
 

TI-Nspire™ computer software:  

The computer software uses the File menu to 

open TI-Nspire™ documents and the Microsoft 

Windows® file system to organize documents 

and folders (Figure 2). 
 

 

 

 

 

 

 

 

 

 

Figure 1 

Figure 2 
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Task: Organize problems and pages  
within a document 

TI-Nspire™ handhelds: 

The handheld Page Sorter allows users to see and 

sort all the pages in a document in one place 

(Figure 3).  

To go to the Page Sorter: 

1. Press / and £ (Up Arrow key on the 

NavPad) from within a document. 
 

TI-Nspire™ computer software: 

The computer software has a vertical page sorter 

pane on the left, visible at all times except when 

in Presentation View (See Figure 4). 
 

Task: Access applications, documents, 
system information, and hints/help  

TI-Nspire™ handheld: 

Only the handheld has the Home Screen that 

allows handheld users to quickly launch an 

application, create new documents, open existing 

documents, return to an open document, access 

system information, and refer to handheld hints 

(Figure 5).  

To go to the Home Screen: 

1. Press c (Home) from within a document. 
 

TI-Nspire™ computer software: 

The computer software uses three menus to 

execute actions similar to those found on the 

handheld’s Home Screen. They are: Insert, File, 

and Help. 

Figure 3 

Figure 4 

Figure 5 
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Here is a detailed comparison of the TI-Nspire™ 

handheld’s Home Screen and the similar 

functionality in the TI-Nspire™ computer 

software. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Handheld Desktop 
1:Calculator Insert>Calculator  
2:Graphs & Geometry Insert>Graphs & Geometry  
3:Lists & Spreadsheets Insert>Lists & Spreadsheets  
4:Notes Insert>Notes  
5:New Document File>New Document 
6:My Docs n/a, or File>Open Document… 
7:Current Document n/a 
    1:Full Page View n/a – just click on page 
    2:Page Sorter On the left-hand side when not in 

Presentation View 
8:System Info  
   1:Document Settings… File>Document Settings… 
   2:System Settings… n/a 
   3:Handheld Status n/a 
   4:About Help>About 
9:Hints Help>TI-Nspire Help (different content) 
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Task: Manage/edit documents, manage 
pages, and select applications 

 TI-Nspire™ handheld: 

Only the handheld has the Page Tools menu 

(Figure 6). 

To go to the Page Tools menu: 

1. Press / and c (Home) from within a 

document. 
 

TI-Nspire™ computer software: 

The computer software uses the File, Edit, and 

Insert menus to execute actions similar to those 

found on the handheld’s Page Tools menu. 

 

 

The next page shows a detailed comparison of 

the TI-Nspire™ handheld’s Page Tools menu 

and the similar functionality in the TI-Nspire™ 

computer software. 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 6 
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Handheld Software 

1:File File 

  1:New Document File>New Document 

  2:My Documents File>Open Documents… 

  3:Save Document File>Save Document 

  4:Save As… File>Save As… 

  5:Send n/a 

  6:Document Settings… File>Document Settings… 

2:Edit Edit 

  1:Undo Edit>Undo 

  2:Redo Edit>Redo 

  3:Cut Edit>Cut 

  4:Copy Edit>Copy 

  5:Paste Edit>Paste 

  6:Delete Edit>Delete 

  7:Insert Page Insert>Page 

  8:Insert Problem Insert>Problem 

3:Back n/a, use page sorter or Ctrl+right/left 
arrow (same as on handheld) 

4:Forward n/a 

5:Page Sorter On the left-hand side, when not in 
Presentation View 

6:Page Layout View>Layout 

  1:Custom Split n/a – click and drag separator bar to get 
custom layout 

  2:Select Layout View>Layout> 

  3:Swap Applications Edit>Swap Applications 

7:Select App Edit>Select Application 

8:Delete Page n/a – select page in page sorter pane and 
Delete (using keyboard, toolbar, menu) 
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Task: Change views 

TI-Nspire™ handhelds: 

On the handheld, users can change the font size 

using the System Settings dialog box (Figure 7). 

To change the font size: 

1. From the Home Screen, select 8:System 

Information and 2:System Settings. 
 

TI-Nspire™ computer software: 

In the computer software, the default view is 

sized in proportion to the computer window 

setting. The page sorter pane is on the left, and 

the font is set to regular size (Figure 8). 

Changing views:  

1. From the View menu, users can toggle into 

and out of the following views: 

• TI-Nspire™ Handheld View – increases 
image size (text, objects, icons), but 
everything is in proportion to the screen 
size/ratio of the handheld (i.e., 320x240) 
(Figure 9). 

• Presentation View – removes page sorter 

pane and increases image size (text, objects, 
icons) while page is still sized in proportion 
to the screen resolution setting. (How does 
this relate to the 320x240 mentioned in the 
previous bullet?) 

• Keypad – displays the handheld keypad for 
users to input information (Figure 9). 

 

 

Figure 7 

Figure 8 

Figure 9 
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 Task: Move between applications  
on a page 

TI-Nspire™ handhelds: 

On the handheld, users can move between 

applications on a page by pressing / e. 
 

TI-Nspire™ computer software: 

In the computer software, users click on the 

applications in a split layout to move between 

applications. 
 

Task: Navigate the screen 

TI-Nspire™ handheld: 

Users use the multi-directional NavPad cursor 

controls to navigate around the handheld screen.  

• Graphs & Geometry: Users can move around 
the screen using the NavPad. 

• Other applications: Users use a combination 

of the e and £¤ ¢ ¡ Arrow keys on 

the NavPad (north, south, east and west 

directions) to move around the screen.  
 

TI-Nspire™ computer software: 

Use either a mouse or the keyboard’s Tab and 

arrow keys to navigate within the computer 

software. 
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Menus 

Except for the Home Screen and Page Tools 

menu on the TI-Nspire™ handheld, the 

underlying structure of the menus in each 

application is the same for both the TI-Nspire™ 

handheld and computer software. 

However, there are some differences in the way 

in which users access the menus due to the innate 

differences between using handhelds and 

software. 
 

 Menus Handheld Computer Software 

Application 
menus 

Select by pressing number or 
alpha keys (e.g., 1:Pointer) or 
by using arrow keys. 

Select by clicking on an icon. 

Context 
menus 

Use / and b keys 
for access. 

Right-click mouse button for access. 

 



Lesson Plan Notes for Factoring 

T3 PROFESSIONAL DEVELOPMENT SERVICES FROM TEXAS INSTRUMENTS 

EXPLORING MATHEMATICS WITH TI-NSPIRE™ TECHNOLOGY   © 2007 TEXAS INSTRUMENTS INCORPORATED 

L e s s o n  P l a n  N o t e s  f o r  F a c t o r i n g  

Materials 
• TI-Nspire™ CAS Math and Science 

Learning Handheld 
• Factoring student worksheet 
• Access to the Internet for the 

Extension 

Overview 
In this activity, students will use inductive methods to discover rules for 
factoring. The activity consists of three parts and an extension. In Part 1, 
students discover how to factor the difference of squares. In Parts 2 and 3, 
they discover how to factor the difference and sum of two cubes. The 
extension discusses applications of factoring in cryptography and computer 
security. 

 
NCTM Standards 
All students should…. 

Grades 9-12 Algebra Standards: 

1. understand the meaning of equivalent forms 
of expressions, equations, inequalities, and 
relations 

2. use symbolic algebra to represent and explain 
mathematical relationships 

3. judge the meaning, utility, and 
reasonableness of the results of symbol 
manipulations, including those carried out by 
technology 

4. draw reasonable conclusions about a 
situation being modeled 

 

Prerequisite Knowledge: 

Students should be able to multiply two 
binomials and multiply a binomial by a 
trinomial. 

 

Pedagogy: 

This activity uses the TI-Nspire™ CAS to allow 
students to discover rules and patterns. When 
students discover a mathematical concept, they 
have a sense of ownership that promotes interest 
and retention. Their experience is closer to that 
of a real mathematician.  
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As students look at the results of several 
examples on their calculators, they will begin to 
notice patterns. When asked to describe the 
patterns, they may use somewhat vague 
descriptions and nonmathematical terms. 
Encourage them to use concise symbolic 
descriptions. Help them appreciate the power of 
algebraic representations. 

 

Activity Notes: 

1. In Part 1, step 10, you should note that 
factor(x2-a2,x) produces a result that 
looks different from factor(x2-a2,a).  

• factor(x2-a2,x)factors the expression 
with respect to x. 

• factor(x2-a2,a) factors the expression 
with respect to a. 

• This will also be an issue in Part 1, step 11. 

2. In the Extension of Part 1, you might want to 
note the difference between  
factor(x2-5,x) and factor(x2-5).  

• When giving the command “factor the 
expression with respect to x,” the factor 
command factors over the real numbers. 

• Without the command “factor the expression 

with respect to x,” the factor command 
factors over the integers. 

3. In Parts 2 and 3, students will use the 

exponent key l to write expressions such 

as x3-1. 

• They must press the right arrow ¢ on the 

NavPad cursor control to exit the exponent 
mode or the rest of the expression they type 
will also appear in the exponent. 
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Name ____________________________ Factoring 
Student Worksheet 

Class ____________________________ 

In this activity, you are going to use Computer Algebra to discover several factoring patterns.  

When instructed to use the factor command, use your TI-Nspire™ CAS handheld.  

When asked to make a prediction, you should use only paper and pencil. 

After you have written your prediction, you may then use your calculator to check your 

work. Look for patterns in both your calculator and paper and pencil results. 

Part 1 – Factoring the difference of two squares 

1. Open a new document on the TI-Nspire-CAS handheld. Add a Calculator application 
page. Press b, and then select 4:Algebra to open the Algebra menu. See Figure 1. 

 
Figure 1 

2. Select 2:Factor to copy the factor command to the Calculator work area. 

3. Next, complete the command: factor(x2-1,x) by pressing the following keys: 
X q - 1 , X ·. See Figure 2. 

 
Figure 2 

• The result indicates that )1)(1(12 +−=− xxx .  
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4. Check this result by multiplying the two terms on the right side of the equation. 

5. Now use the factor command to factor the following expressions. Write the result below. 
 

42 −x  ________________________ 
 

92 −x  ________________________ 
 

6. Predict the results of factoring the following expressions. Write your predictions in the 

spaces provided, and then check your prediction with the factor command. 
 

162 −x                                  prediction: ______________________ 
 
 factor command result: ______________________ 
 

492 −x                                 prediction: ______________________ 
 
  factor command result: ______________________ 
 

7. Describe the pattern you have noticed. 
 
 
 

8. Predict the result of factoring the following expression. Write your prediction in the space 

provided, and then check your prediction with the factor command. 
 

22 ax −                                 prediction: ______________________ 
 
    factor command result: ______________________ 
 

• Was your prediction correct? What is the pattern for factoring the difference of two squares? 

 

9. Factor the following expressions with paper and pencil only, and then check your results 

with your TI-Nspire™ CAS handheld. 
 

22 ab −     _______________________ 
 

22 94 yx −   _______________________ 
 

22 2516 qp −   _______________________ 
 

Extension: Predict the result of factoring 52 −x , and then check with your calculator. 
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Part 2 – Factoring the difference of two cubes 

10. Open a new document on your TI-Nspire™ CAS handheld.  

11. Add a Calculator application page. 

12. Enter the following command: factor(x3-1,x). 

13. In order to enter the expression x3-1, press X l 3 ¢ -�1 See Figure 3. 

 
Figure 3 

Note: The ¢ key is the right arrow key on the NavPad cursor control. Pressing this key exits 

the exponent mode. Otherwise, the rest of the expression is included in the exponent. 

• The result indicates that )1)(1(1 23 ++−=− xxxx . 

14. Multiply the two terms on the right side of this expression to verify the result. 

15. Use the factor command to factor the following expressions. Write the results in the 

space provided. Look for patterns. 
 

83 −x   _______________________________ 
 

273 −x  _______________________________ 
 

643 −x  _______________________________ 
 

16. Predict the result of factoring the following expressions. Write your predictions and then 

compare with the results of the factor command. 
 

1253 −x            prediction: ___________________________ 
 

factor command result: ___________________________  
 

3433 −x            prediction: ___________________________ 
 

factor command result: ___________________________ 
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17. Can you describe the pattern in these examples? 
 
 
 

18. Predict the result of factoring 33 ax −  then check your prediction. 
 

       prediction:  _________________________ 
 

factor command result: _________________________ 
 

19. Factor the following expressions with paper and pencil, and then check your results with 

your TI-Nspire™ CAS handheld. 
 

338 yx −  _____________________________________ 
 

33 27qp −  ______________________________________ 
 

 
Part 3 – Factoring the sum of two cubes 

20. Use the factor command to factor the following expressions. Record the results.  
 

13 +x   ______________________________ 
 

83 +x   ______________________________ 
 

273 +x  ________________________________ 
 

21. Based on these results, can you write a conjecture about factoring the sum of two cubes? 
 

33 ax +  _____________________________ 
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Extension: Numeric Factoring 

The factor command can also be used to factor composite numbers. See Figure 4. 

 
Figure 4 

Note:  The third factor in Figure 4 did not produce factors because 256,203,221 is prime.  

Although the TI-Nspire™ CAS handheld factor command is powerful, there is no known 

formula to factor all composite numbers. This fact is the basis for many computer security 

methods. One computer security company offers substantial rewards to anyone who can 

factor certain large composite numbers. You can see these challenge numbers at  

http://www.rsa.com/rsalabs/node.asp?id=2093#RSA640 

 
RSA Challenge number 704: Factor this number, and win $30,000 
 

740375634795617128280467960974295731425931888892312890849362326389727650340

282662768919964196251178439958943305021275853701189680982867331732731089309

00552505116877063299072396380786710086096962537934650563796359  
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R e l a t i o n s h i p  b e t w e e n  
C i r c u m f e r e n c e  a n d  D i a m e t e r  

o f  a  C i r c l e  
Concepts 
• Circumference of a circle 
• Diameter of a circle 
• Scatter plots 
• Equations of line 
• Slope 
• Area 
• Simple Quadratics 
• Transformations 

Materials 
• TI-Nspire™ Computer Software for 

Math and Science 

Overview 
Students will explore the ratio of the circumference to the diameter of a circle.  
After investigating many circles and looking at relationships, students will use 
Lists and Spreadsheets along with a scatter plot to explore the algebraic 
relationship between diameter and circumference. Part 2 will investigate the 
relationship of radius to Area. 

 
Background 

Depending on the background of the students, 
this activity could be done with measuring 
radius, diameter, and circumference of many 
circular objects prior to using the technology. 
Another possibility is to count and compare the 
number of candies in the radius, diameter, 
circumference, and area of circles.  
 
NCTM Standards 

All students should…. 

Grades 6-8 Geometry Standards: 

1. precisely describe, classify, and understand 
relationships among types of two- and three-
dimensional objects using their defining 
properties 

2. understand relationships among the angles, 
side lengths, perimeters, areas, and volumes 
of similar objects 

Grades 9-12 Geometry Standards: 

1. analyze properties and determine attributes of 
two- and three-dimensional objects 

2. draw and construct representations of two- 
and three-dimensional geometric objects 
using a variety of tools 
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 3. use geometric models to gain insights into, 
and answer questions in, other areas of 
mathematics 

Grades 6-8 Algebra Standards: 

1. represent, analyze, and generalize a variety of 
patterns with tables, graphs, words, and, 
when possible, symbolic rules 

2. relate and compare different forms of 
representation for a relationship 

3. model and solve contextualized problems 
using various representations, such as graphs, 
tables, and equations 

Grades 9-12 Algebra Standards: 

1. generalize patterns using explicitly defined 
and recursively defined functions 

2. identify essential quantitative relationships in 
a situation and determine the class or classes 
of functions that might model the 
relationships 

 

Teacher Preparation 

The teacher may opt to lead the students through 
the investigation using the prepared TI-Nspire 
document file. The student activity sheet is a 
companion to the TI-Nspire document file. 
Alternatively the teacher could have the students 
create the document on the handheld or in a lab.  
This document shows the general outline for 
creating the TI-Nspire™ document file on the 
computer. Similar steps would be used if 
creating the document on the handheld.  
Please note that the page and problem numbers 
in this document do not match exactly the 
numbers in the pre-made TI-Nspire document.  

 

Construction 

1. Under the File menu, choose New 

Document, and use the mouse to select a 

Graphs & Geometry application (Figure 1). 
Figure 1 
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Under View on the Toolbar, select TI-Nspire 

Handheld View. 

2. From the View menu , select Hide the Entry 

Line , and Hide Axis . 

3. Construct a segment by selecting Segment 

from the Points and Lines menu (Figure 2). 

• Press Enter or click for one endpoint of the 

segment, move to another location and click 

a second time to complete the segment. 

• Labeling points is not really necessary for 

this construction but can be done if desired.  

• Label points immediately after pressing Enter 

or click. 

Note: Selection in the software is normally 

done with the mouse click. 

4. Construct a circle by selecting Circle from 

the Shapes  icon. Click on one endpoint of 

the segment to place the center of the circle 

at this endpoint. Then move and click on the 

segment to attach the radius point to the 

segment. See Figure 3. 

 

Measurement and Variables 

1. Measure the circumference and the radius by 

selecting Length from Measurement menu . 

2. Move the cursor over the circle, and when 

circle is selected (it will be blinking), left-

click for the circumference. Move the 

measurement to the top left of the screen. 

Press Enter or Click. 

Figure 2 

Figure 3 
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3. With the measurement tool still active, move 

the cursor to the center point, click, move the 

cursor to other radius point, and click again. 

4. Again, drag the radius value to the top left 

corner (Figure 4) and press Enter or Click. 

Press Esc to exit the Measurement tool. 

5. To label and make each measurement a 

variable to be used later, select the 

measurement to be labeled, and select VAR 

on the top menu bar. 

6. After selecting STORE VAR, in place of the 

word VAR, type circum for the 

circumference. Press Enter. 

7. Press d to deselect the circumference 

label and repeat for the radius measurement, 

labeling it radius (Figure 5). 

• Each measurement should now become bold. 

8. Select Text from the Tools  menu, move 

the mouse to an empty location on the 

screen, and press Enter. 

9. At the text insertion point, type 2*r, and 

press Enter (Figure 6). 

10. Next select Calculate from the Tools  

menu. Select the text just entered (2*r), and 

then the radius measurement. 

11. Move this measurement closer to the 2*r 

text and press Enter or Click. 

12. Store this measurement as variable diam, as 

done earlier (Figure 7). 

Figure 4 

Figure 5 

Figure 6 

Figure 7 
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13. To compute the ratio of circumference to 

diameter, open the Text box and type c/d 

(Figure 8). 

• Other letters may be used—there is nothing 

necessarily unique about c and d. 

14. Select Calculate from the Tools  icon. 

15. First, select the expression c/d, then the 

values associated with circum and diam. 

16. Move the new measurement close to the c/d 

text added earlier, as shown in Figure 9. 

17. Drag the radius point back and forth along 

the segment to see which measurements 

change and which remain the same (See 

Figure 10). 

• Dragging is accomplished by clicking on the 

point, holding the left mouse button down 

and moving. 

 
Lists & Spreadsheet 
To store the data, a Lists & Spreadsheet 

application will be used to save the data as the 

radius changes. 

1. First, split the screen by pressing Page 

Layout and moving the selection down to the 

second (vertical split) layout. 

2. Add a Lists & Spreadsheet Application to the 

right side of the page.  

3. Place the cursor in the white space to the 

right of A in column A to name the list. 

Figure 8 

Figure 9 

Figure 10 
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 4. Enter d. 

5. Move to the white space in column B, and 

enter c (Figure 11). 

6. Move the cursor to the formula cell just 

below the column name. 

7. Select Data Capture > Manual Data Capture 

from the Data menu. 

8. Overstrike VAR by pressing the Var 

(computer icon) key in the menu bar. Select 

Link to:, and select diam. Press Enter. 

9. Move to the formula cell just below column 

B, and repeat the process, selecting circum.  

• When Enter is pressed the first row is 

populated by the current values of the 

variables. (Figure 12). 

10. In Column C, in the formula cell, enter a 

formula by following these steps: 

• Press the = key, and then VAR and then Link 

to:.  

• Select c, then press /. 

• Select VAR and then Link to:, and select d.   

• Press Enter (See Figure 13). 

11. To collect more data, click the mouse in the 

Graphs & Geometry work area. 

12. Drag the radius point. To collect data, hold 

down Ctrl and then press the [Period] key. 

Repeat this several more times to collect 

additional data. See Figure 14. 

Figure 11 

Figure 12 

Figure 13 

Figure 14 
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 Graphical Representation 

1. To create a scatter plot of the diameter and 

circumference data, first insert a new page by 

selecting Insert > Graphs & Geometry from 

the menu bar. 

2. From the Graph Type icon, select Scatter 

Plot, and press Enter. 

3. While the x-entry is highlighted, press Enter 

to display the lists, select the list d, and press 

Enter. 

4. Press Tab to move to the y-entry and repeat 

for the list c (See Figure 15). 

• A scatter plot will be graphed immediately.  

5. Select Zoom Stat from the window icon to 

see all the data (Figure 16). 

What type of curve is the relationship of c to d? 

What is true about the plotted points? In which 

quadrants do the plotted points lie? Why? 

6. To fit a line to the data, select Line from the 

Points and Lines menu. 

7. Using the mouse, click on one point of the 

data set, and then click another point. 

8. From the Measurement menu, select Slope, 

move to the line, and press Enter on your 

keyboard. 

9. Find the equation of the line by selecting 

Coordinates and Equations” from the Tools 

menu (Figure 17). 

• What ratio does this slope represent?  

Figure 15 

Figure 16 

Figure 17 
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Part 2: Radius and Area 

1. Mouse click on the Graphs & Geometry side 

of page 1.1. Press Ctrl K. 

2. Next press Ctrl C to copy the Graphs & 

Geometry page. 

3. Select Insert Problem from the menu bar and 

click on the new page.  

4. Press Ctrl V to paste the Graphs & Geometry 

page (Figure 18). 

5. Choose Hide/Show from the Tools  icon, 

and hide all objects except the radius 

measurement (Figure 19). 

6. From the Measurement menu, choose Area. 

Move the cursor to the circle and select it. 

Drag the measurement to the left corner. 

7. Press Esc. Select the measurement by 

pressing Enter, click on VAR, choose Store 

VAR, and type Area. Press Enter. 

• The word Area should become bold. 

8. With the mouse, move the radius point along 

the segment to see the radius and area change 

(Figure 20). 

 

 

Figure 18 

Figure 19 

Figure 20 
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 Lists & Spreadsheet 

To store the data, a Lists & Spreadsheet 

application will be used to save the data as the 

radius changes. 

1. First, split the screen by pressing Page 

Layout and moving the selection down to the 

second (vertical split) layout. 

2. Add the Lists & Spreadsheet application.  

3. Place the cursor in the white space in column 

A to name the list (Figure 21). 

4. Enter r. 

5. Move to the white space in column B, and 

enter a. 

6. Move the cursor to the formula cell just 

below the column name. 

7. Select Data Capture > Automated Data 

Capture from the Data icon. 

8. Overstrike the VAR by clicking on Var, 

selecting Link to:, selecting radius, and 

pressing Enter. 

9. Move to the formula cell just below column 

B, and repeat the process, selecting area.  

• When Enter is pressed the first row is 

populated by the current values of the 

variables (Figure 22). 

10. Click the mouse in the Graphs & Geometry 

work area. Drag the radius point. (Figure 23). 

 

 

 

Figure 21 

Figure 22 

Figure 23 
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Graphical Representation 

1. To see the graphical representation, insert a 

new page by pressing Insert > Graphs & 

Geometry from the menu bar. 

2. From the Graph Type menu, select Scatter 

Plot, and press Enter. 

3. While the x-entry is highlighted, press Enter 

to display the lists, select the list r, and press 

Enter. 

4. Press Tab to move to the y-entry and repeat 

to choose list a (Figure 24). 

5. Select Zoom Stat from the Window menu to 

display all the data (Figure 25). 

• What type of curve does this appear to be?  

 

 

 

6. From the Graph Type menu, select Function 

and enter the function f1(x) = x^2.  

Press Enter (Figure 26). 

7. Press Esc to move the cursor back to the 

Graphs & Geometry screen. 

8. Transform the function by grabbing the curve 

with the mouse and moving the curve. 

• If the four-directional cursor appears, the 

curve will translate, and if the two-directional 

cursor appears, the curve will stretch.  

 

Figure 24 

Figure 25 

Figure 26 
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 9. Manipulate the curve to get the best fit 

(Figure 27). 

• What does the value of the vertical stretch of 

the function represent?  

 

Extension possibilities 

1. Students can look at other relationships of 

radius, diameter, circumference, and area. 

Try creating scatter plots of these 

relationships. 

2. Students can be shown the technique of 

“animation.” 

 

 

 

 

Figure 27 
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Name ____________________________ Relationship between 
Circumference and 
Diameter of a Circle 
Student Worksheet 

Class ____________________________ 

 

Problem 1: ‘Circle, circles, everywhere’ 

1. Open up the D2_1DiaCir.tns file on your TI-Nspire™ handheld by pressing c.  
Select 6: My Documents, scroll to the file, and press ·. Figure 1 shows what the 
D1_6DiaCir.tns file looks like when it is open on your TI-Nspire™ handheld. 

 
Figure 1 

• On page 1.2 of Problem 1 (press / ¦), you will find a circle with a measured radius 
and circumference (Figure 2). 

2. Drag the radius point to see the values change. 
• To drag, move to the point, press and hold the x key until the “hand” closes, and use the 

NavPad cursor controls to move the point around the screen. 

 
Figure 2 

Measurement 

We will now determine the diameter. First we need to enter some text. 

3. Press b 1 5 for Menu 1:Tools, 5:Text. 

4. Move the pointer to an empty location, and press ·. 
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5. At the text insertion point, type 2*r, and press · (Figure 3). 

 
Figure 3 

6. Next, press b 1 7 for Menu 1: Tools, 7:Calculate, move the cursor to select 
the text just entered (2*r), and then select the radius measurement 

7. Move this calculation closer to the 2*r text on the screen (Figure 4). 

 
Figure 4 

8. Once again, drag the radius point to see values change. 

Ratio of Circumference to Diameter 

9. To explore the ratio of circumference and diameter, first select the text tool and enter the 
text c/d on the screen. 

10. Press b 1 7 to select 7:Calculate from the 1:Tools menu. 

11. First, select the expression c/d, then the circumference measurement, and finally the 

diameter measurement. Move the calculation close to the c/d text (Figure 5). 

 
Figure 5 



Relationship between Circumference and Diameter of a Circle 

T3 PROFESSIONAL DEVELOPMENT SERVICES FROM TEXAS INSTRUMENTS 
EXPLORING MATHEMATICS WITH TI-NSPIRE™ TECHNOLOGY   © 2007 TEXAS INSTRUMENTS INCORPORATED 

12. Drag the radius point back and forth along the segment to see which measurements 
change and which remain the same (as in Figure 6). 

 
Figure 6 

13. Answer question 1 at the end of this worksheet, and then proceed to problem 2. 

 
Problem 2: Lists & Spreadsheet 

A Lists & Spreadsheet application will be used to save the data as the radius point moves. 

In the Lists and Spreadsheet application, there are 3 lists: One tracks the diameter (list d), 
another tracks the circumference (list c), and the third the circumference/diameter 
relationship. One set of data is given in Figure 7 below. 

 
Figure 7 

14. To collect data, press / e until you are in the Graphs & Geometry work area. 

15. Drag the radius to a new position. Press / ^ to capture the data and record it in 
the Lists and Spreadsheet work area. Repeat with five different radii values. 

16. Answer questions 2 and 3 at the end of this worksheet. 
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Graphical Representation 

17. To see the graphical representation, / ¦ to advance to the next page.  A scatter plot 
has been set up to show the data (See Figure 8). 

 
Figure 8 

18. Press b 4 9 for Menu 4:Window, 9:Zoom-Stat to see a more appropriate 
window (See Figure 9). 

 
Figure 9 

19. Answer questions 4 to 6 at the end of this worksheet. 
20. To fit a line to the data, press Menu, 6:Points & Lines menu, 4:Line (See Figure 10). 

 
Figure 10 
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21. Move to one data point and press ·, and then press · again on another point. 

22. Press Menu, 7: Measurement, 3:Slope, then move to the line, and press ·. 
23. Find the equation of the line by selecting Menu, 1:Tools, 6:Coordinates and Equations. 

 
Figure 11 

24. Answer question 7, and then proceed to Problem 3. 

 

Problem 3: Radius and Area 

In problem 3, you are given the same circle with only the radius measured. 

25. Press Menu, 7:Measurement, 2:Area. Find the area of the circle by moving the cursor to 
the circle, and press Enter or click to select it. Move the measurement to the left corner 
(See Figure 12). 

 
Figure 12 

26. Drag the radius point to see the values change. Proceed to Problem 4. 
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Problem 4: Lists & Spreadsheet 

27. The Lists & Spreadsheet application will track the data for the radius and the area  
(Figure 13). 

 
Figure 13 

28. To collect more data, press / e to move into the Graphs & Geometry work area. 
29. This time, we will use automated data capture. Drag the radius point to get more data 

which populates the lists automatically (Figure 14). 

 
Figure 14 

30. To see the graphical representation on your TI-Nspire™ handheld, move to page 4.2 
which shows the scatter plot of area versus radius. 
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31. Press b 4 9 for Menu 4:Window, 9:Zoom-Stat to see a more appropriate 
window (Figure 15). 

 
Figure 15 

32. Answer question 8 at the end of this worksheet. 

 
Graph the Function 

33. Press Menu, 3:Graph Type, 1:Function. Enter the function f1(x) = x^2 and press 
Enter (Figure 16). 

 
Figure 16 

34. Press d to move out of the entry line and see a cursor on the graph. 

35. Transform the function by grabbing the curve with the x and moving the curve. 
• If the four-directional cursor appears, the curve will translate, and if the two-directional 

cursor appears the curve will stretch. 
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36. Manipulate the curve to get the best fit (Figure 17). 

 
Figure 17 

 

37. Answer question 9 at the end of this worksheet. 
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Answer the Following Questions 

1. Which measurements are changing? Which measurements are staying the same? 
 
 
 
 
 
2. Make a conjecture about Column C. Use the words of circumference and diameter in 

your conjecture. 
 
 
 
 
 
 
3. Long ago, mathematicians named the circumference/diameter ratio with the  

Greek letter π (pi). 
 
Complete the conjecture:  If C is the circumference and d is the diameter of a circle, then 
there is a number Π such that C = ______________. 
 
Because d = 2r, where r is the radius, then C = ____________. 

 
4. What pattern are the plotted points? 
 
 
 
 
 
5. What type of curve would be a good fit for the plotted points? 
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6. In which quadrant do all of the points lie?  Why? 

 

 

 

 

7. What does the slope represent? 
 
 
 
 
 
8. What type of curve does the area versus radius appear to be? 
 
 
 
 
 
9. What does the vertical stretch of the function represent? 
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Name  ____________________________ Points, Lines, Slopes  
(Oh, My!) 
Student Worksheet 

Class  ____________________________ 

 
In this activity, you will explore: 

• the relationship between coordinates of points and locations on the coordinate plane 
• the relationships of lines with their equations, slopes and y intercepts 
• the relationships of slopes of parallel and perpendicular lines 

 
1. Open the file D2_2PointsandLines.tns on your TI-Nspire ™ Math and Science learning 

handheld (Figure 1).  
 
 
 
 
 
 
 
 
 
 
  
  
 
• Follow along with this document and your teacher.  
 

2. Drag the y-intercept around, and notice the coordinates (Figure 2). 
 
 
 
 
 
 
 
 
 
 
  
  
  

3. Explain any patterns that you observe about y-intercepts.  
 
 
 
 

Figure 1 

Figure 2 
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4. Move to page 1.3. Predict what will happen to the line and the slope if you move the y- 
intercept. Predict what will change as you drag the line (Figure 3).  
 
 
 
 
 
 
 
 
 
 
  
  
 

5. Describe what happens to the slope as the line or the y-intercept moves. Enter your 
responses on page 1.4. 
 

6. Move to page 1.5, and read the instructions.  
 
 
 
 
 
 
 
 
 
 
  
  
 

7. When is the slope positive? When is it zero? When is it ∞ (or undefined)? Describe a line 
with negative slope. Enter your responses on page 1.6. 
 

8. Move to page 1.7 (Figure 5). This page describes what will take place on page 1.8.  
 
 
 
 
 
 
 
 
 
 
 

Figure 3 

Figure 4 

Figure 5 
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• Manipulate the line as before by dragging the y-intercept, and then by dragging points A 

and/or B. How does this impact the slope and/or ratios?  
• Conjecture about slope and measurements in the right triangle. 
• Which ratio represents the slope? (Figure 6). 

 
 
 
 
 
 
 
 
 
 
 
  
  

 
 
 

9. Move to page 1.9 and read the instructions. (Figure 7).  
 
 
 
 
 
 
 
 
 
 
 
  
  
 

10. Move to page 1.10 and drag the y-intercept. Then drag points A and/or B.  
• What is the relationship of the coefficients in the equation of the line and the measured and 

calculated values? Enter your answer on page 1.11. 
 
 

 
 
 
 
 

Figure 6 

Figure 7 
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11. Read the instructions on page 1.12. Predict the relationship between the slopes of parallel 
lines. Check your prediction by finding the slope of each line (Figure 8). 

 
 
 

 
 
 
 
 
 
  
  
 

12. Move to page 1.13. Perpendicular lines and their slopes are shown in Figure 9.   
 
 
 
 
 
 
 
 
 
 
  
  
  
• Predict the relationship between the slopes of perpendicular lines.  
• Drag the lines in Figure 9 to test your prediction. 

 
13. Move to page 1.14 (Figure 10). 

 
 
 
 
 
 
 
 
 
 
  
  
 
• What appears to be true about the product of the slopes of perpendicular lines?   
• Discuss with your group members. 

Figure 9 

Figure 10 

Figure 8 
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P o i n ts ,  L i n e s ,  S l o p e s  ( O h ,  M y ! )  
Concepts 
• Slope 
• y-intercept 

Materials 
• TI-Nspire™ Math and Science 

Learning Handheld 
• TI-Nspire™ Computer Software for 

Math and Science 
• D2_2PointsandLines.tns 
• Points and Lines Student worksheet 
 

Overview 
In this activity, students will investigate the relationships of lines, slopes and 
equations - geometrically and algebraically. The investigation continues with 
parallel and perpendicular lines and their slope relationships. 

 
NCTM Standards 
All students should… 

Grades 6-8 Algebra Standards: 

1. represent, analyze, and generalize a variety of 
patterns with tables, graphs, words, and, 
when possible, symbolic rules 

2. relate and compare different forms of 
representation for a relationship 

3. develop an initial conceptual understanding 
of different uses of variables 

4. explore relationships between symbolic 
expressions and graphs of lines, paying 
particular attention to the meaning of 
intercept and slope 

5. use graphs to analyze the nature of changes 
in quantities in linear relationships 

Grades 9-12 Algebra Standards: 

1. generalize patterns using explicitly defined 
and recursively defined functions 

2. analyze functions of one variable by 
investigating rates of change, intercepts, 
zeros, asymptotes, and local and global 
behavior 

3. understand and compare the properties of 
classes of functions, including exponential, 
polynomial, rational, logarithmic, and 
periodic functions 

4. interpret representations of functions of two 
variables 

5. approximate and interpret rates of change 
from graphical and numerical data 
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Prerequisite knowledge: 

Students should know vocabulary terms to 
include points, equations, parallel and 
perpendicular. 

Activity Overview: 

1. This investigation offers many possible 
extensions depending on the level of the 
student.   

2. At the Pre-Algebra level, this activity can be 
used to introduce or review properties of 
points in the coordinate plane. 

3. At the Algebra I level, this activity can 
review coordinates and then go on to 
introduce or review the relationships of 
points, lines, slopes and equations.  
• The screen could also be split into different 

zones by graphing f(x) = x and f(x) = -x. Ask 
students to generalize the slopes of lines for 
each of these zones. 

4. At the Algebra 1 level, after graphing lines 
and looking at relationships, another point 
could be placed on the plane and students 
could look at the coordinates of the point 
with respect to the line. This could be used to 
introduce inequalities. 

5. In Geometry, the angles formed by horizontal 
lines and parallel lines could be measured to 
begin the discussion of proving lines parallel 
by using measurement of angles. 

6. This activity could also provide the 
opportunity to prove algebraically as well as 
geometrically that the slopes of perpendicular 
lines are negative reciprocals. 

Classroom Management: 

1. This activity can be done by the students 
using the pre-made TI-Nspire document file 
or by them creating the file along with the 
teacher. The following pages illustrate how 
to create the file.  

2. The student worksheet is intended to guide 
students through the main ideas of the 
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activity, while providing more detailed 
instruction on how they are to perform 
specific actions using the tools of  
TI-Nspire™. 

Creating the TI-Nspire Document File 

1. On the computer, open a New document 
under the File Menu. Under View select  
TI-Nspire Handheld View.  
• Insert a Notes page and type the text as 

shown in Figure 1. 
2. Insert another Notes page and choose page 

layout. 
• Select the second option for a vertical split, 

and select a Graphs & Geometry application 
on the right side of the screen.   

• Mouse click back in the Notes page on the 
left and type the text shown in Figure 2. 

3. Mouse click on the right side in the Graphs 
& Geometry page.  
• Drag the origin so that the 1st and 4th 

quadrants are displayed (Figure 3). 
• Extend each axis by dragging the arrows as 

well. 
• Under the View menu, choose Hide Entry 

Line. Select the Line tool under the Points & 
Lines menu and click on the y-axis to attach 
the line to the y-axis (but not on a grid point).  

• Move the mouse to the 1st quadrant and click 
anywhere to finish the line graph. 

• Drag the end of the line to extend it. 
4. Show the coordinates of the y-intercept by 

selecting “Coordinates and Equations” from 
the Tools menu and clicking on the point. 
Drag the coordinates to the desired location 
and press Enter.   
• The appearance of the y-intercept can be 

changed, if desired.   

Figure 1 

Figure 2 

Figure 3 
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o Right click on the point, select 

Attributes, and use the arrow keys to 
select the desired attribute. 

o Press Enter to exit Attributes. (Figure 4).   
5. Click on Insert and select New Page. Do not 

choose an Application. 
6. Click on page 1.2 in the page sorter. Press 

Ctrl K to select the page and then press Ctrl 
C to copy the page.  
Click on the new page and press Ctrl V to 
paste page 1.2 to the new page, page 1.3.   
• On the copied page (page 1.3), delete the 

current notes and change the Notes page to 
read as shown in Figure 5.   

7. Insert another Notes page and choose Q & A 
from the Templates menu. Type the 
sentences shown in Figure 6. 

8. Click on Insert and select New Page. Do not 
choose an Application. 

9. Click on page 1.2 in the page sorter. Press 
Ctrl K to select the page and then press Ctrl 
C to copy the page.  
Click on the new page and press Ctrl V to 
paste page 1.2 to the new page, page 1.5. 
• In the Notes section, type the text shown in 

Figure 7.  
• In the Graphs & Geometry section, find the 

slope of the line by selecting Slope from the 
Measurement menu.  

• To label the slope, double click on the slope 
measurement, and arrow to the beginning of 
the measurement. Type “slope =” and press 
enter or mouse click. Move the measurement 
to a convenient location on the screen. 

Figure 4 

Figure 5 

Figure 6 

Figure 7 



Points, Lines, Slopes (Oh, My!) 

T3 PROFESSIONAL DEVELOPMENT SERVICES FROM TEXAS INSTRUMENTS 

EXPLORING MATHEMATICS WITH TI-NSPIRE™ TECHNOLOGY   © 2007 TEXAS INSTRUMENTS INCORPORATED 

 

10. Insert two new Notes pages and type the text 
as shown in Figures 8 and 9. 

11. Click on Insert and select New Page. Do not 
choose an Application. 

 
12. To copy only the graph shown in Figure 7, 

click on the Graphs & Geometry portion of 
page 1.5. Press Ctrl K to select the 
application (the Graphs & Geometry window 
should be flashing). Press Ctrl C to copy the 
window. 

 
13. Click on the new page (page 1.8). Press Ctrl 

V to paste the Graphs & Geometry window 
to this page. 

 
14. Select the Point tool from the Points & Lines 

menu and place 2 points on the line. Label 
each point immediately after clicking the 
point (Figure 10).  
• You can also use the text tool to label the 

points.   
• Drag the arrows of each axis to extend the 

graphing window.   
• Delete the Drag Me text and the vector 

pointing to the y intercept. 
 

15. To construct the right triangle, select the 
Perpendicular tool in the Construction menu. 
• Click on point A and then on the y-axis to 

construct the line through point A 
perpendicular to the y-axis.  

• For the second perpendicular line, select 
point B and the x- axis (Figure 11). 

• After constructing both perpendicular lines, 
select Intersection Point(s) from the Points & 
Lines tool and click on each line.  

• Immediately label the point C. 
16. From the Tools menu, select Hide/Show and 

hide each perpendicular line. 
 

Figure 8 

Figure 9 

Figure 10 

Figure 11 



Points, Lines, Slopes (Oh, My!) 

T3 PROFESSIONAL DEVELOPMENT SERVICES FROM TEXAS INSTRUMENTS 

EXPLORING MATHEMATICS WITH TI-NSPIRE™ TECHNOLOGY   © 2007 TEXAS INSTRUMENTS INCORPORATED 

 

 
17. Select the Triangle tool From the Shapes 

menu.  
• Construct a triangle with vertices A, B and C.  
• From the Measurement menu, select the 

Length tool and click on the points B and C 
to measure the length of BC.   

• Repeat to find length AC.   
• Label the two measurements (Figure 12). 

 
18. Using the Text tool from the Tools menu, 

type the expression BC/AC and the 
expression AC/BC.    
• From the Tools menu, select Calculate and 

first select the text by clicking on it. Then, 
click on each variable needed for the 
computation.   

• Move the measurements close to the 
appropriate text (Figure 13). 

   
• To shorten the number of decimal places 

displayed for any measurement, first hover 
the mouse over the measurement until a hand 
appears.  

• Press the - key to decrease or the + 
key to increase the number of decimal places 
displayed. 
 

19. Insert a Notes page and enter the text as 
shown in Figure 14. 
 

20. Add a new page and copy page 1.8 to this 
page, (page 1.10). 

 
21. Add the equation of the line by choosing 

Coordinates and Equations from the Tools 
menu. Select the line.   
• Drag the equation to a location so that is easy 

to see all of the relationships (Figure 15).  
 

Figure 12 

Figure 13 

Figure 14 

Figure 15 
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22. Insert a Notes page, choose the Q & A 

template, and add the question shown in 
Figure 16.  
 

23. To explore the relationship of parallel lines 
and their slopes, add a new page after the 
Notes page shown in Figure 16. Copy page 
1.3 and paste it to the new page, (page 1.12).  
• Revise the Notes pages information as shown 

in Figure 17. 
• To construct a parallel line, select Parallel 

from the Construction menu and click on the 
given line and then anywhere in the 
coordinate plane.  

 
24. To explore the relationship of perpendicular 

lines and their slopes, add a new page. Copy 
page 1.3 and paste it to the new page, (page 
1.13).   
• Revise the Notes pages information as shown 

in Figure 18. 
• On the Graphs & Geometry page, construct a 

perpendicular line by selecting Perpendicular 
from the Construction menu.   

• Click on the original line and then anywhere 
in the coordinate plane.  

• Find the slope of each line and label the 
slopes as before.   

 
25. Copy and paste page 1.13 to a new page. 

• Revise the Notes page as shown in Figure 19.  
• On the Graphs & Geometry page, select the 

text tool from the Tools menu and press enter 
to open a text box.   

• Type “m1*m2” and press Enter to close the 
text box.  

• Select Calculate from the Tools menu. Click 
on the text and on each slope measurement. 
Place the result next to the text. 
 

Figure 16 

Figure 17 

Figure 18 

Figure 19 
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Reflections: 

26. Reflect on how this activity, built in the 
document model, could enhance student's 
understanding of slope, y-intercepts, parallel 
lines and perpendicular lines. 

 
27. What advantages are there to investigations 

in this format? 
 
28. Share your thoughts with a neighbor.  
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Name  ____________________________ The Open Topped Box 
Student Worksheet 

Class  ____________________________ 

 
 

Introduction 
You will investigate this problem in five ways. 

• You will use pieces of paper to model the problem and construct several physical models. 
• Using the Graphs & Geometry application, you will manipulate a geometric model. 
• Using the geometric model, you will create a function that you can graph and find the 

maximum function value. 
• Using the Lists & Spreadsheet application, you will create a numeric model. 
• Finally, using the CAS tool, you will find the optimum algebraically. 

 
You should find that the solutions are close regardless of the approached used. Part of your 
task will be to determine the advantages and disadvantages of each approach. 
 
For the physical model, work in groups of three students.  

• Each student will use three sheets of 8.5 by 11 inch paper. 
 

1. The first member of the group will cut a 0.5” square out of each corner, and fold up the 
flaps that were created to form a box.  
• Tape the vertical edges together.  
• Measure the length, width and height of the box, and record those measurements along with 

the volume of your box. 
 

2. The first member should also cut out a corner of 1.25” from a second sheet and 2” from a 
third sheet. 
 

3. The second member should cut out corner of 0.75” from their first sheet, 1.5” from their 
second sheet and 2.25” from their third sheet. 
 

4. The third member should cut out corner of 1” from their first sheet, 1.75” from their 
second sheet and 2.5” from their third sheet. 
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Analyzing Data 
5. Complete the following table as a group with all the data you have collected: 

 
Cut Size Height of Box Length of Box Width of Box Volume of Box 

0.50”  
 

   

0.75”  
 

   

1.00”  
 

   

1.25”  
 

   

1.5”  
 

   

1.75”  
 

   

2.00”  
 

   

2.25”  
 

   

2.50”  
 

   

x h= 
 

l= w= V= 

 
6. Examine the table and determine which of these cut sizes produces the maximum 

volume? 
 
   
7. Examine the patterns and determine the mathematical formulae that can be used to find 

the height, length, width and volume as functions of the size of the square cut out.  
(Cut size is represented by x.)  
Place those formulae in the last row. 

 
8. To graph a relationship, we will let the size of the corner be the independent variable and 

let x represent this quantity. The dependent variable will be the volume of the box.  
• Construct a scatter plot of the data. 
• Draw a curve through the points.  
• How would you describe the shape of the curve?  
• On your graph, circle the point which indicates the greatest volume.  
• Interpret the meaning of the coordinates of this point with respect to the paper and box. 
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TI-Nspire™ Math and Science Learning Technology 
 
Locate the TI-Nspire™ learning technology file entitled “D2_3BoxProblem.tns”. Open this 
file and read the first two pages of the TI-Nspire document and follow the instructions.  
 
Note:  
This file has some of the basic setups created for you for each type of solution, along with 
Notes pages with questions, comments and instructions. Be sure to read each page. 
 
When you are finished, your TI-Nspire™ learning technology file will be collected. Be sure 
to use appropriate units in your work. 
 
9. Throughout the file, the terms “cut size” and the “height” are used interchangeably. Is 

this appropriate? Explain. 
 
 

10. On page 1.3 of the file, you dragged point P up and down line segment AD. The point is 
only allowed to go to the midpoint of AD. 
•  Explain why the geometric model was set up in this way. 

 
 

11. What value of h gives you the maximum volume? 
• Cut size ___________________ 

 
12. What is the volume at this point? 

• Volume ____________________ 
 
13. Is this the optimum volume? Explain. 

 
 
 

Return to the TI-Nspire™ document file and go to page 1.4 and follow the instructions.  
After completing page 1.9, answer question 14. 
 
14. Referring to the scatter plot on page 1.7, what type of function did you choose to model 

the relationship between cut size and volume when you did the regression on page 1.9? 
•  Explain your choice of model–what lead you to choose this type of function rather than 

others? 
 

 
 
 
 
• After answering question 14, return to the TI-Nspire™ file and go to page 1.10. 
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15. On page 1.11 you graphed the function on a clean Graphs & Geometry page.  

• What problems did you have in finding the maximum volume? 
 
 
 
 

 
16. What value did you get for the cut size and maximum volume using this model? 

• Cut size   _____________  
• Volume ______________ 

 
 

After answering questions 15-16, return to the TI-Nspire™ file and go to page 1.12. 
 
17. On page 1.12, you are asked to do a numerical analysis of the problem using the  

Lists & Spreadsheet on page 1.13. Pages 1.14 and 1.15 provide more information about 
the iteration process.  
• The first iteration is done for you. 
• In each table, you are required to list three rows from your spreadsheet.  

o The middle row should be the maximum volume for that iteration. 
o The row above should be the row preceding the maximum volume from your table. 
o The row below should be the row following the maximum volume from your table.  

• You will keep repeating these steps. 
• Each step is called an iteration. You may want to look up the meaning of the word. 
• You may not need four iterations, so explain why you stopped when you did. 

 
First iteration 
 

o Lower bound: 0 
o Upper bound: 4.25 
o Increment: 0.25 

 
 Height Volume
 1.25 63.75 
Maximum 1.5 66 
 1.75 65.625 

 
Second iteration 

o New lower bound: 1.25 
o New upper bound: 1.75 
o New increment: 0.1 

 
Revise the sequence command in the List and Spreadsheet to reflect the new lower and 
upper bounds and increment. You will need to select “OK” to overwrite the original data. 
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Complete the table below and repeat the process for subsequent iterations.  
  

 Height Volume
   
Maximum   
   

 
Third iteration 

o New lower bound ______  
o New upper bound ______  
o New increment ________ 

 
 Height Volume
   
Maximum   
   

 
Fourth iteration 

o New lower bound ______  
o New upper bound ______  
o New increment ________ 

 
 Height Volume
   
Maximum   
   

 
 
What value did you obtain for the cut size and maximum volume using this model? 
• Cut size _____________ 
• Volume _____________ 

 
 
18. Explain why you stopped at the iteration you selected. 

 
 

 
 
 
 

• Return to the TI-Nspire™ file and go to page 1.16. 
 
 
 
 
 
19. For the CAS solution, record the function f1(x). 
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20. Use CAS to determine the first derivative function first(x) 
What polynomial do you get for the first derivative function? 
 
 
 

21. Continue to use CAS to determine what value(s) of cut size produces the maximum 
volume? 
 
 
 

22. If there is more than one solution, explain why you can eliminate the other solution(s). 
 
 
 

23. What is the maximum volume? 
 
 
 

24. How did you get that value? 
 
 
 

Summary 
25. Which of the four solutions gives the most accurate answer? Explain your choice. 

 
 
26. Which type of solution did you prefer? Explain your choice? 

 
 
27. What would you do if the problem started with a sheet of metal that was 50cm by 30cm?  

• Would all of the steps be the same or would you need to change any of the processes that 
were used in the solution above? 
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Rubric for the Open Topped Box Problem using 
TI-Nspire ™ Math and Science Learning Technology 

Knowledge/Skills Level 1 Level 2 Level 3 Level 4 
Thinking/Inquiry/ 
Problem Solving 
• Prepares a plan to solve 

the problem 
• Carries out the plan 

Needs extensive 
assistance to 
begin organizing 
a plan and needs 
clearly laid out 
steps to follow. 

Needs some 
assistance to 
begin organizing 
a plan and needs 
some steps to 
follow. 

Needs minimal 
assistance to 
organize and 
implement an 
effective 
strategy. 

Needs no 
assistance to 
organize and 
implement an 
effective 
strategy. 

Knowledge/Understanding 
• Models the problem with 

paper 
• Creates a scatter plot and 

regression function 
• Inputs values into the 

spreadsheet to simulate 
the problem 

• Uses CAS tools to find the 
derivative function and its 
roots 

Demonstrates 
limited 
understanding of 
using a physical, 
geometric, 
and/or numeric 
model. Needs 
extensive 
assistance to use 
CAS tools. 

Demonstrates 
some 
understanding of 
using a physical, 
geometric, or 
numeric model. 
Needs some 
assistance to use 
CAS tools. 

Demonstrates 
considerable 
understanding of 
using a physical, 
geometric, and 
numeric model. 
Needs minimal 
assistance to use 
CAS tools. 

Demonstrates 
thorough 
understanding of 
using a physical, 
geometric, and 
numeric model. 
Needs no 
assistance to use 
CAS tools. 

Application 
• Uses several physical 

models to approach the 
optimal solution 

• Manipulates the 
geometric model to 
approach the optimal 
solution 

• Finds the maximum 
value of the regression 
function in an 
appropriate domain 

• Manipulates the 
intervals between input 
values in a spreadsheet 
to approach the optimal 
solution 

• Interprets the 
information from the 
CAS solution to find 
the optimal solution 

Interprets the 
information 
ineffectually. 
Has difficulty 
manipulating 
and applying 
data from a 
physical, 
geometric, 
and/or numeric 
model. Needs 
extensive 
assistance to 
interpret the 
information 
from using the 
CAS tools. 
Solutions 
include major 
errors. 

Interprets the 
information 
somewhat 
effectually. Has 
some difficulty 
manipulating 
and applying 
data from a 
physical, 
geometric, or 
numeric model. 
Needs some 
assistance to 
interpret the 
information 
from using the 
CAS tools. 
Solutions 
include minor 
errors. 

Interprets the 
information with 
considerable 
effectiveness. 
Has little 
difficulty 
manipulating 
and applying 
data from a 
physical, 
geometric, and 
numeric model. 
Needs minimal 
assistance to 
interpret the 
information 
from using the 
CAS tools. 
Solutions are 
accurate. 

Interprets the 
information with 
a high degree of 
effectiveness. 
Has no difficulty 
manipulating 
and applying 
data from a 
physical, 
geometric, and 
numeric model. 
Needs no 
assistance to 
interpret the 
information 
from using the 
CAS tools. 
Solutions are 
accurate and 
include an 
explanation for 
disallowed 
negative 
answers. 

Communication 
• Includes clear 

explanations and full 
justifications 

• Correctly uses 
mathematical language, 
mathematical form and 
measurement units 

Does not clearly 
explain or justify 
solutions. 
Maintains the 
correct units and 
good 
mathematical 
form in some of 
the solutions. 
 

Explains and 
justifies 
solutions 
somewhat. 
Maintains the 
correct units and 
good 
mathematical 
form throughout 
most of the 
solutions. 
 

Explains and 
justifies 
solutions fully. 
Maintains the 
correct units and 
good 
mathematical 
form throughout 
the solutions. 
 

Explains, 
justifies and 
shows insight 
into the 
complexities of 
the solutions. 
Maintains the 
correct units and 
good 
mathematical 
form throughout 
the solutions. 



 The Open Topped Box 

T3 PROFESSIONAL DEVELOPMENT SERVICES FROM TEXAS INSTRUMENTS 
EXPLORING MATHEMATICS WITH TI-NSPIRE™ TECHNOLOGY  © 2007 TEXAS INSTRUMENTS INCORPORATED 

 
This page intentionally left blank. 
 



Lesson Plan Notes for the Open Topped Box 

T3 PROFESSIONAL DEVELOPMENT SERVICES FROM TEXAS INSTRUMENTS 

EXPLORING MATHEMATICS WITH TI-NSPIRE™ TECHNOLOGY   © 2007 TEXAS INSTRUMENTS INCORPORATED 

L e s s o n  P l a n  N o t e s  f o r  t h e   
O p e n  To p p e d  B o x  

 Course(s): Algebra 1, Geometry, Pre-Calculus 
and Calculus 
 
Topic(s): Scatter plots, functions, graphing, 
geometric modeling, equations, recursive 
sequences, rotations, reflections, nets, volume, 
derivatives, and local maximums. 
 

Related NCTM Standards:  

1. Number and Operations Standards 
• Students should judge the reasonableness of 

numerical computations and their results. 
2. Algebra Standards: 

• Students should generalize patterns using 
explicitly defined and recursively defined 
functions. 

• Students should use symbolic algebra to 
represent and explain mathematical 
relationships. 

• Students should identify essential 
quantitative relationships it a situation and 
determine the class or classes of functions 
that might model the relationships. 

• Students should draw reasonable conclusions 
about a situation being modeled. 

• Students should approximate and interpret 
rates of change from graphical and numerical 
data. 

• Students should analyze functions of one 
variable by investigating rates of change, 
intercepts, zeros, asymptotes, and local and 
global behavior. 

• Students should judge the meaning, utility, 
and reasonableness of the results of symbol 
manipulations, including those carried out by 
technology. 

• Students should draw reasonable conclusions 
about a situation being modeled. 
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3. Geometry Standards 
• Students should use Cartesian coordinate and 

other coordinate systems, such as 
navigational, polar or spherical systems to 
analyze geometric situations. 

• Students should understand and represent 
translations, reflections, rotations and 
dilations of objects in the plane by using 
sketches, coordinates, vectors, function 
notation and matrices. 

• Students should investigate conjectures and 
solve problems involving two- and three-
dimensional objects represented with 
Cartesian coordinates. 

• Students should construct representations of 
two- and three-dimensional objects using a 
variety of tools. 

4. Measurement Standards 
• Students should make decisions about units 

and scales that are appropriate for problem 
solving situations involving measurement. 

• Students should analyze precision, accuracy, 
and approximate error in measurement 
situation. 

 

Suggested Total Time: Three hours. 
 

Specific Pre-requisite knowledge: Students 
should be familiar with the following: 

• Finding volume of a rectangular solid 
• Manipulating a geometric model by dragging 

points 
• Using spreadsheet formulae 
• Recursive sequences 
• Constructing a scatter plot 
• Finding the function of best fit 
• Derivatives of functions 
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Materials Required/Classroom  
Set-up/Preparation: The following equipment 
will be needed: 

• Paper, scissors and tape. 
• Each student should have access to a  

TI-Nspire ™ math and science learning 
handheld with the file  
“D2_3BoxProblem.tns” pre-loaded. 

• If the CAS solution is to be done, then 
students should have access to a TI-Nspire™ 
CAS math and science learning handheld. 

 

Lesson Notes:  

1. The step-by-step solutions present four 
models for solving this problem but each 
solution fits a different course. This is a 
problem that you can re-visit from year to 
year.  
• In Algebra 1, you could use the physical 

model to generate data that gives a  
scatter plot and function found by using an 
appropriate regression. The “function 
maximum” feature could be used to find the 
optimal point. 

• In Geometry, the scale model can be used as 
well as one or both of the approaches. 

• In Pre-Calculus, the cubic function can be 
developed and a discussion of the nature of 
the function is applicable in that course. 

• In Calculus, the derivative function can be 
generated through the CAS tool to find the 
optimal solution. 

 
2. The rubric was set up in order to address the 

entire activity. You may want to consider the 
following guidelines when using the rubric.  
• The Thinking/Inquiry/Problem Solving 

portion is generic and addresses the manner 
in which the student addresses the question. 

• The Knowledge/Understanding category is 
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 more specific and you will see bullets that 
address each of the models in the problem, 
where appropriate. 

• The Application category is also more 
specific to each of the five models. 

• Finally, the Communication category is more 
generic addressing how well the student 
justifies and explains as well as the use of 
proper mathematical form.  
 

3. As students are working through the 
solutions, you may want to keep the 
following issues in mind. 
• It is likely that the students will do quite well 

on the first two models (physical and 
geometric). 

• Anticipate some problems with the graphical 
model as some students will resist the 
instruction to create a clean graph with just 
the function and attempt to find the 
maximum on the graph with the scatter plot. 

• Even those students who use a new graph 
may find it difficult to locate the maximum 
as they tend to drag points quickly and a 
slower approach works better here. 

• In the numeric model, students may 
experience some problems in identifying the 
smaller domain and then more trouble when 
trying to re-define the sequence. 

• The CAS model is the most straightforward, 
although younger students would have no 
appreciation for the mathematics involved in 
this solution. 

 
4. Students will need to be kept on task. Each 

model may take some time and they may 
become discouraged. 
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T h e  O p e n  To p p e d  B o x  
Concepts 
• Nets and Scatter plots 
• Functions and Graphing 
• Sequences 
• CAS (optional) 

Materials 
• TI-Nspire™ Math and Science 

Learning Handheld  
• (CAS model is needed for the 

optional section)  

Overview 
In the student activity, students explore solving the problem of maximizing 
volume by various approaches. In this portion, the teacher notes, we will cover 
how to construct the models for the student document. 

 

• Constructing the Models 

In this activity we will provide instructions on 
the creation of the various document models, 
Geometric, Scatter Plots, Numeric, Algebraic. 
 

Geometric Model 

1. Open a Graphs and Geometry page.  

• To hide the axes press b, select the View 

menu by pressing 2 and choose Hide 

Axes, option 1. 

2. Construct a rectangle to model the problem. 
Press b, choose 8: Shapes, and then 
3: Rectangle.  
• Move your cursor out into the open area of 

the screen and press · on three of the 
corners of your rectangle (Figure 1). 
 

3. Label the corners A, B, C and D.  
• Construct line segments AB and BC. 

Measure the lengths of these segments 
(Figure 2).  
 

4. In order to make the measurements realistic, 
we will use the Scale feature.  

• Press b, select 2: View, and then 

4: Show Scale (Figure 3). 

Figure 1 

Figure 2 

Figure 3 
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5. The default unit is centimeters.  
• Click twice on the scale and change the units 

from “cm” to “in”.  
6. To make the model more like the real sheet 

of paper, follow these steps: 

• Press x twice on the measurement to edit 

it. Hold the g key and use the ¡ and ¢ 
keys to highlight the measurement for the 
length. Press / and C (to copy). 

• Move over to the scale, press x twice to 

edit the scale. Use . to remove the digit.  

• In its place, type in “11” press p, and 

press / and V (to paste). 
• This will paste the measurement from the 

diagram into the scale calculation.  

• Press ·. The unit of measurement will 
change and the length of your rectangle will 
adjust to 11 inches.  

• To set the width to 8.5 inches, click on the 
measurement, press . to remove the 
existing value and type in 8.5.  

• Your rectangle will immediately adjust to 
this length. You now have a “sheet of paper” 
on your screen (Figure 4).  

• You may need to move the figure back into 
the work space. 
 
 

7. Press b. Choose 9: Construction and 
then 5: Midpoint.  
• Click on each of the four sides of the 

rectangle (Figure 5). 
 
 

8. Construct a line segment connecting A to the 
midpoint of AD. 

9.  Press b6:Points & Lines and then 
2:Point On to construct point P on this 
line segment. See Figure 6. 

Figure 4 

Figure 5 

Figure 6 
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10. In the next step you need to rotate point P 
through an angle of 90o to get an image point 
on AB. In order to accomplish this, you need 
to ensure that the settings for angle 
measurements have been changed to degrees. 
If you look at the top of Figure 6 above, you 
will see that the default is radians.  

• Press / followed by c.  

• Choose option 1: File and then 6: 
Document Settings.  

• Press e to move to the Angle window 

and press ¤ to open the window.  

• Scroll down to Degree and press · to 
change the setting. See Figure 7. 

• Press e to move to the OK button at the 
bottom of the window.  

• Press · to return to the Graphs and 
Geometry window.  

• You should now see DEG at the top. 
11. In an open area, enter the text “90”. This will 

serve as the angle of rotation. See Figure 8. 

12. Press b followed by A: Transformation 
and 4: Rotation.  
• Click on Point A then click on the text “90”, 

and finally, click on point P. This will create 
a new point on AB that is the same distance 
from A as point P is from A (Figure 8).  

13. Label the new point as Q. 
• Construct line segments connecting the 

vertical and horizontal midpoints (Figure 9). 
 
 

14. Press b followed by A: Transformation 
and choose option 2: Reflection.  
• Using the vertical line segment as the line of 

reflection, reflect points P and Q in this line 
(Figure 10). 

 
 

Figure 7 

Figure 8 

Figure 9 

Figure 10 
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15. Using the horizontal line segment as the line 
of reflection, reflect points P, Q and the two 
new points in this line (Figure 11). 
 
 
 
 
 
 

16. Hide the two line segments and the four 
midpoints and construct line segments as 
shown in Figure 12.  
• Describe what happens as you drag point P. 

 
 
 

 
 
 
 

17. Press b 6: Points & Lines and  
3: Intersection Point(s) to construct points 
of intersection where the vertical and 
horizontal segments intersect (Figure 13). 
 
 
 
 
 
 
 
 

18. Hide all of the line segments, leaving just the 
four points of intersection (Figure 14).  
 
 

Figure 11 

Figure 12 

Figure 13 

Figure 14 
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19. Press b followed by 8: Shapes and 
4: Polygon.  
• Click on all four points in the center of the 

screen, and click a second time on the first 
point selected. This will construct a 
rectangle. This will serve as the base of the 
open topped box (Figure 15).  
 
 
 
 
 
 

20. Use the polygon tool to construct a square in 
each corner of the original rectangle  
(Figure 16). 
 
 
 
 
 
 
 
 

21.  Press b 1 3 for Menu, Tools, 
Attributes. Click on each square and a dialog 
box will open. 

• Press ¤ to the first section and then press ¢ 
to select a shading for the square (Figure 17). 
 
 
 
 
 
 

22. For each square press ¤ twice to move to 
the last section in the window.  

• Press ¢ to change the line style to either 
dotted or dashed (Figure 18). 
 
 
 
 

Figure 15 

Figure 16 

Figure 17 

Figure 18 
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23. When you are finished all four squares, you 

should have a sketch that resembles  
Figure 19.  
• The shaded corners are the areas to be cut out 

along the dashed lines. 
 
 
 

24. Drag point P, and describe what happens to 
the different sections in the original 
rectangle.  
• Hide the labels for points P and Q and add 

the measurements shown in Figure 20. 
• For the open topped box, which measurement 

is the height?  
• Which measurement is the length?  
• Which measurement is the width? 

 
 
 
 

25. To assign variables to the measurements in 
the construction, click on the variable and 
press / followed by h (Figure 21). 
•  Type in the name of the variable, “h”. 
• Assign variables (l and w) to the 

measurements  for length and width.  
 
 

26. Press b followed by 1: Tools and 
5: Text to add the expression l*w*h in an 
open space. This expression will be used to 
calculate the volume of the open topped box. 
(Figure 22). 
 

Figure 19 

Figure 20 

Figure 21 

Figure 22 
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27. Press b followed by 1: Tools and  
7: Calculate. Click on the expression for 
volume.  
• As you move away from the expression, a 

caption appears asking you to identify a 
variable.  

• The volume expression is highlighted and a 
caption asking for variable h is shown in 
Figure 23.  

• Move the variable and click on it. 
 

28. Continue selecting variables.  
• When you are finished, the value of the 

expression will appear.  
• Move this to the right of the volume 

expression (Figure 24). 
 

29. Drag point P until the value of volume 
expression is a maximum. This value for 
volume should be linked to a variable as you 
did with h, l and w. Use “v” for this result. 
See Figure 25. 

 
30. Alternate Construction of Model:  

In the previous steps 9 to 13 point P is 
rotated to obtain point Q.  
• These two points were reflected in the 

vertical line segment connecting the 
midpoints of AB and CD to obtain points 
about point B. Finally these four points were 
reflected across the line segment joining the 
midpoints of AD and BC to obtain points 
about C and D.  

• An alternate approach would be to construct 
a line segment AP, and use the Compass tool 
(press b followed by 9: 

Constructions and 7: Compass).  
• You would then need to find points of 

intersection of each of these circles with AB, 
BC, CD and AD.  

• In the end, the amount of work is about the 
same, but you might prefer to emphasize the 
compass tool over rotations and reflections. 
See Figure 26. 

Figure 23 

Figure 24 

Figure 25 

Figure 26 
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 Constructing a Scatter Plot 

1. The data from this geometric model will be 
captured in the Lists & Spreadsheet tool.  

• Press c and select option 3 3: Lists 
& Spreadsheet (Figure 27). 

 
 
 

 
2. Type the headings “cut” in column A and 

“volume” in column B.  

• Press b followed by 1: Actions and 

2: Resize. At this point, the entire 
column will be highlighted. (Figure 28). 

• Pressing ¢ will widen the column.  

• Press · to save that width.  
• Repeat for column B.  

 
 

3. In order to capture data from the geometric 
model, move to the row where you see the  
♦ Symbol (between the column header and 
row 1).  

• Press b followed by 3: Data,  

2: Data Capture, and 1: Automated 
Data Capture (Figure 29). 
 
 

 

 
 

4. When this option is selected, the formula 
capture(var,1) will appear in the cell with the 
word “var” highlighted (Figure 30). 
 
 

Figure 27 

Figure 28 

Figure 29 

Figure 30 
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5. Referring back to the geometric model, the 
cut refers to the height of the box, so we will 
replace “var” with “h”.  

• When you press ·, you may get a 
Conflict Detected dialog box. The software 
wants you to choose between the variable h 
from the Graphs & Geometry page or column 
H in the Lists & Spreadsheets page.  

• Press ¤ to open the options box and scroll 
down to Variable Reference. See Figure 31. 

 

 

6. Press · and e to move to the OK box.  

• Press · to close the dialog box.  
• Repeat for column B by capturing data from 

variable v. See Figure 32. 
 

 

 

7. Note in Figure 32 that the first row now 
contains values. These are the current values 
from the Graphs & Geometry page.  

• Press / followed by ¡ to go back to the 
Graphs & Geometry page.  

• Drag point P through its range and return to 
the Lists & Spreadsheet page (Figure 33).  
 
 
 
 
 

8. As point P was dragged, each location of the 
point generated another row of data in the 
Lists & Spreadsheets page.  
• You can use these lists to generate a 

scatterplot in a new Graphs & Geometry 
page, page 1.3 (Figure 34). 
 
 

 

Figure 31 

Figure 32 

Figure 33 

Figure 34 
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9. Select Zoom–Stat to see the entire scatter 
plot.  

• Press b followed by 4: Window and 

9: Zoom – Stat. See Figure 35. 
 

 
 

10. Since this relationship is the product of three 
variables we could safely conclude that this 
might be a cubic relationship.  
• Open a Calculator page (Page 1.4). 

• Press b followed by either  

6:Statistics in TI-Nspire or  

7:Statistics in TI-Nspire CAS.  

Next, press 1: Stat Calculations and 

7: Cubic Regression. 
• Complete the dialog box as shown in  

Figure 36. 

• Press e to select OK and press ·. 
 
 

11. The results of the linear regression 
calculation are shown in Figure 37.  
• Note that some of the coefficients are 

“messy”. 
 
 
 
 

 

12. Move back to the Graphs & Geometry page. 

•  Press b followed by 3: Graph Type 

and 1: Function.  

• Scroll up to f1(x) and press ·  
(Figure 38).  

 

Figure 35 

Figure 36 

Figure 37 

Figure 38 
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13. With the scatter plot on top of the function, it 
is difficult to use a Trace Point to determine 
the optimal value.  
• Insert a new Graphs & Geometry page (Page 

1.5) in your document and plot the function 
f1(x) in this window (Figure 39). 

 

 
 
 
 

14. For this graph, you can alter the window 
settings yourself.  

• Press b followed by 4: Window and 

1: Window Settings.  
• Change the values as shown in Figure 40. 

 

 
 
 
 
 
 

15. The graph will appear without the scatter 
plot. See Figure 41. 

 

 
 
 

16. You can add a Trace Point that will allow 
you to find the maximum value.  

• Press b followed by 5: Trace. A 
point and its coordinates will appear near the 
origin.  

• Pressing ¡ or ¢ will move this point along 
the curve. See Figure 42. 
 
 

Figure 39 

Figure 40 

Figure 41 

Figure 42 
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17. Press · to anchor the point on the curve. 
• Drag the point until you see a caption with a 

capital letter M.  
• This point is a local maximum (Figure 43). 

 

 

Exploring  A Numeric Solution 

1. Create a new Lists and Spreadsheet page.  
• On this page, you will look for a numeric 

solution.  
• Label the first two columns as ht and vol 

(Figure 44). 
• It will be helpful to make the two columns as 

wide as possible. 

• Press b followed by 1: Actions and 

2: Resize. At this point, the entire 
column will be highlighted. 

• Pressing ¢ will widen the column.  

• Press · to save that width.  
• Repeat for column B. See Figure 45. 

 

2. For column A (ht) we will set up a sequence 
to enter height values from 0 to 4.25 inches 
in steps of 0.25.  
• Move to the row where you see the  

♦ Symbol (between the column header and 
row 1. Here we will enter in our formula.  

• Type =seq (x, x, 0, 4.25, 0,25). Lower bound 
and upper bound and increment.  
 

3. After you have pressed ·, Column A will 
fill with values for the height. See Figure 46. 

Figure 43 

Figure 44 

Figure 45 

Figure 46 
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4. The volume can be calculated using the 
expression  
height*(11 – 2*height)*(8.5 – 2*height).  
• Enter this expression, starting with an = sign, 

in the formula row for column B using “ht” 
to represent height (Figure 47). 
 
 
 

 

5. Press · to complete the calculation. 
Column B should fill with values 
(Figure 48). 

 

 
 
 
 
 

 

6. Scroll down column B and look for the 
largest value for volume (Figure 49). 

 

 

 

 

7. The maximum in this table occurs for a cut 
size of 1.5 inches. However, this is not 
necessarily the maximum value. The actual 
maximum could occur on either side of this 
value, so we could safely assume that the 
optimal value occurs for a cut size between 
1.25 and 1.75 inches.  
• Move to the column formula for height and 

press ·. Note that the formula is now 
ready for editing. See Figure 50. 

Figure 47 

Figure 48 

Figure 49 

Figure 50 
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8. Scroll across the entry, change the values for 

the lower bound, upper bound and increment, 
as shown in Figure 51. 

 

 
 
 
 
 
 

 

9. When you press Enter a dialog box will 
appear asking you to confirm that you want 
to replace the data. Select OK and the values 
in both columns will update as shown in 
Figure 52. 

 

 
 
 
 
 

10. Scroll down column B looking for the 
maximum value of the volume (Figure 53). 

 

11. As before, we could argue that the optimal 
volume occurs for a cut size is somewhere 
between 1.45 and 1.65 inches. 
• Update the formula by reducing the 

increment to 0.01, the lower bound to 1.45 
and the upper bound to 1.65. 

 
12. Keep repeating this process to find the 

maximum value of the volume. 
• This process could be repeated several times 

until the desired accuracy is obtained. 
 

 

Figure 51 

Figure 52 

Figure 53 
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An Algebraic Solution Using CAS 

1. The final solution uses the CAS features to 
approach the problem with a Calculus 
solution. Open a Calculator page, Page 1.7. 
• You already have the function stored in f1(x), 

so you can use that in a new calculator page 
(Figure 54). 
 
 
 
 
 

 

2. Define a new function first(x) as the 
derivative of f1(x) with respect to x.  

• Press b followed by 1: Tools and 

1: Define.  
• Type in the function name as first(x).  

• Press = then b followed by 5: 

Calculus and 1: Derivative.  
• Complete the expression as shown in  

Figure 55. 
 

 

 

3. Press · to complete the calculation.  
• Type the expression first(x) to display the 

derivative function (Figure 56). 
 

 
 
 
 

Figure 54 

Figure 55 

Figure 56 
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4. To find the optimal value, solve for the roots 
of the first derivative function.  

• Press b followed by 4: Algebra and 

1: Solve.  
• Complete the expression as shown in  

Figure 57. 
 

 
 
 

 
 
 

• Press · to complete the calculation  
(Figure 58). 

 
 
 
 
 
 
 
 

 

 

5. Two solutions arise since the function is a 
cubic and has two turning points. However, 
the solution x = 4.91 is outside the domain of 
x for this problem and should be discarded. 
Use the smaller value to find the value for the 
maximum volume.  
• One way to do this is to type in the name of 

the volume function f1(), position the cursor 
between the parenthesis, move up to the 
previous line in the history area where the 
roots of f1(x) occur and press ·.  

• Then remove the extraneous solution, along 
with the phrases “x=” and press ·  
(Figure 59). 

Figure 57 

Figure 58 

Figure 59 
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L e s s o n  P l a n  N o t e s  f o r  C A S  
A c t i v i t i e s  f o r  A d v a n c e d  A l g e b r a  

 Course(s): Algebra 2, Pre-Calculus and Calculus 
 

Topic(s): Recursive sequences, division of 
polynomials, Factor Theorem, Remainder 
Theorem, function notation, graphing, solving 
equations, exact and approximate roots, complex 
roots, inequalities, scatter plots, regressions, 
slope, rates of change, limits, instantaneous rates 
of change, derivatives, maximums and 
minimums, intervals where a function is positive 
or negative and tangent lines. 
 

Related NCTM Standards:  

• Algebra Standards: 
o Students should generalize patterns using 

explicitly defined and recursively defined 
functions. 
 

o Students should use symbolic algebra to 
represent and explain mathematical 
relationships. 
 

o Students should identify essential 
quantitative relationships in a situation 
and determine the class or classes of 
functions that might model the 
relationships. 
 

o Students should draw reasonable 
conclusions about a situation being 
modeled. 
 

o Students should approximate and 
interpret rates of change from graphical 
and numerical data. 
 

o Students should analyze functions of one 
variable by investigating rates of change, 
intercepts, zeros, asymptotes, and local 
and global behavior. 
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o Students should judge the meaning, 
utility, and reasonableness of the results 
of symbol manipulations, including those 
carried out by technology. 
 

o Students should draw reasonable 
conclusions about a situation being 
modeled. 

 

Suggested Total Time: Two hours. 
 

Specific Pre-requisite knowledge:  

Students should be familiar with the following: 

• Some initial experimentation with the Graphs 
& Geometry tool where they were required to 
change the window, manipulate an equation, 
determine local maximum/minimum points, 
and calculate slopes. 
 

• Students should be familiar with the algebra 
menu and the options that are available there. 
 

• The activities in Parts 1 through 4 may have 
already been done by hand in class and 
students may be familiar with these topics. 
On the other hand, some teachers may prefer 
to use this activity to introduce these topics. 

 

Materials Required/Classroom Set-
up/Preparation:  

The following equipment will be needed: 

• Each student should have access to a  
TI –Nspire™ CAS + handheld device with 
the file “D2_4CASAdvancedAlgebra.tns” 
pre-loaded. 
 

• Students should work in pairs of groups of 
three in order to help each other. It might be 
a good idea to seed each group with a strong 
student. 
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Lesson Notes: 
• The most common error committed by 

students (and teachers) is not moving the 
cursor past the exponent. As soon as the 
exponent for any power is entered, you 
should press ¢ to get out of the exponent and 
enter the rest of the expression. 
 

• The final activity on heart rates is a good way 
to introduce the Calculus menu. 
 

• Some students may have an initial problem 
with the symbol for greater than or equal to. 
You need to enter two keys for this symbol. 
Once you execute the command, it appears 
on the screen as a single symbol. 
 

• In the data for the three athletes, some 
students may be confused about what the 
“Number of heart beats” means, confusing it 
with the heart rate. One hopes that no athlete 
has a heart rate of 0 at any time and a heart 
rate of 660 would be of equal concern. 
 

• The work in Activity 2 may need some more 
detail. You could consider providing students 
with a copy of the step-by-step instructions 
or doing demonstrations of some of the steps.
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Name  ____________________________ CAS Activities for 
Advanced Algebra 
Student Worksheet 

Class  ____________________________ 

 
Part 1:  Division by a polynomial 

Questions: Divide the following:  
a) 1)-(by)3522( 23 xxxx −+−  
b) )2(5by)1016415( 232 ++++ xxxx  
c) )12(by)13624( 23 +−−+ xxxx  
d) )12(by)13624( 23 +−−+ xxxx  

 
Part 2: Remainder/Factor Theorem:   

Questions: Find the value of the remainder for each division:  
a)    )2(by)42( 2 −++ xxx  
b)   )1(by)83( 23 ++−+ xxxx  
c)   )52(by)3732( 23 +−−+ xxxx  

 
Part 3: Finding Roots 

Questions: Solve 
a)  031092 23 =+++ xxx  
b)  0866 23 =++− xxx  
c)  01332 234 =+−−+ xxxx  

 
Part 4: Inequalities  

(for ≤  use <= and for ≥  use >=)  
Questions: Find the intervals for the following:  

a)  08126 2345 <−+− xxxx  
 b)  0133 23 ≥−+− xxx  
 c)  04106 23 ≤−+− xxx  

 
Activity 1 with the TI-Nspire™ CAS Calculator Assignment 

1. Consider the polynomial function 496)( 23 +++= xxxxf . 
a) Find the roots. 
b) Find the maximum and minimum points. 
c) Find the interval(s) when the function is positive. 
d) Sketch the function. 

 

2. Answer question #1 for the function 2121523)( 234 +−+−−= xxxxxf . 
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3. Determine the value(s) of k in each equation so that one root is double the other root. 
      a)  0502 =+− kxx    
      b)  032 2 =+− kxx  
 

4. If  2)( xxf =  and  )3)(1)(2()( −−+= xxxxg  find all x for which )()( xgxf < . 
 

Activity 2 Investigating Heart Rates with the TI-Nspire™ CAS Calculator 
 
A coach wants to test the fitness of his athletes. He runs them through a six minute stress test 
while a monitor counts the number of heartbeats from time zero. The data from three 
teammates are shown below: 
 

1. Enter the data into the Lists & Spreadsheet. 
 

2. Using three separate pages, draw a scatter plot of each table.  
 

3. Find an equation for each athlete’s number of heart beats by either doing a regression on 
the calculator or by solving algebraically.   
• Graph the equations found. 

 
4. The coach has established a guideline that the athlete’s heart rate must not exceed 100 

beats per minute at exactly 3 minutes. 
• Do all the athletes seem to meet the criteria? 

 
5. When does each athlete’s heart rate reach 100 beats per minute?   

• Drag the tangent line to the graph of the regression equation to graphically estimate when this 
happens for each athlete. 
 

6. Find the instantaneous rate of change of the number of heart beats for each athlete’s data 
by finding the value of the derivative at time 3 minutes.  
• Are these answers close to your estimates in question 4? 

 
7. Using your equations, when does each athlete’s heart rate reach 100 beats per minute?  

• Are these answers close to your estimates in question 5? 
 

8. As an alternative approach, add a point on the curve and construct the tangent line at this 
point.  
• Measure the slope of the tangent line and drag the point until the slope is close to m = 100. 

Time 
In minutes 

Number of 
heart beats 

   0 0 
1 55 
2 120 
3 195 
4 280 
5 375 
6 480 

Time 
in minutes

Number of 
heart beats

0 0 
1 68 
2 148 
3 240 
4 344 
5 460 
6 588 

Time 
in minutes

Number of 
heart beats 

0 0 
1 85 
2 180 
3 285 
4 400 
5 525 
6 660 
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C A S  A c t i v i t i e s  f o r  A d v a n c e d  
A l g e b r a  

Materials 
• TI-Nspire™ Math and Science 

Learning Handheld 
• D2_4CASAdvancedAlgebra.tns file 

Overview 
This activity introduced various CAS commands suitable for Algebra and Pre-
Calculus and Calculus. 
 

Activity 1–Operations with Polynomials 
 

Part 1:  Division by a polynomial   

Press b followed by 4:Algebra,  
6:Fraction Tools and 1:Proper Fraction. 
Enter the expression in the parentheses using 
separate sets of parentheses for the numerator 
and denominator. Press Enter. See Figure 1. 
 
 
Part 2: Remainder/Factor Theorem 

Enter the polynomial followed by the * key 
(the small gray key below and to the right of the 
/ key). Enter the value of x and press ·. 
See Figure 2. 
 
 
 
 
Part 3: Finding Roots 

Press b followed by 4:Algebra and  
1: Solve. Type in the equation within the 
parentheses and press ·. See Figure 3. 
 

Figure 1 

Figure 2 

Figure 3 
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Time 

in minutes 

Number of 

heart beats 

   0 0 

1 55 

2 120 

3 195 

4 280 

5 375 

6 480 

Time 

in minutes

Number of 

heart beats

0 0 

1 68 

2 148 

3 240 

4 344 

5 460 

6 588 

Time 

in minutes 

Number of 

heart beats 

0 0 

1 85 

2 180 

3 285 

4 400 

5 525 

6 660 

Approximate Roots:  
Enter the Solve command as before but press 
/ followed by · instead of just ·.  
See Figure 4. 
 
Complex Roots: 

Press b followed by 4:Algebra,  
8:Complex and 1:Solve.Enter the 
equation as before and press · to complete 
the operation. See Figure 4. 
 
Part 4: Inequalities  

Press b followed by 4:Algebra and  
1:Solve. Enter the inequality as before using 
< and = for ≤. When needed, use > and 
= for  ≥. See Figure 5. 
 
 

Activity 2 Investigating Heart Rates 

A coach wants to test the fitness of his athletes.  
He runs them through a six minute stress test 
while a monitor counts the number of heartbeats 
from time zero. The data from three teammates 
are shown below: 
 

Figure 4 

Figure 5 
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1. Open a new Lists & Spreadsheet page and 

enter the data into columns A, B, C and D. 
Note the column headings (Figure 6). 
 
 
 
 
 
 

2. Graph a scatter plot of each relationship. 
• Open three new Graphs & Geometry pages 

for the scatter plots of the relationships.  

• Press b followed by 3:Graph Type 

and choose 3:Scatter Plot.  

• Press · to open the x field and select 
time. 

• Press e to move to the y field.  

• Press · and select ath1.  

• Press e to move to the OK button and 

press ·.  
• Repeat for athlete 2 and athlete 3.  
• See Figures 7, 8 and 9. 

 
 
 
 
 
 
 
 

Figure 6 

Figure 7 

Figure 8 

Figure 9 
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3. Find an equation for each athlete’s number of 
heart beats versus time by either doing a 
regression on the calculator or by solving 
algebraically. Graph the equations found. 

• Open a new Calculator page and press b 

followed by 7:Statistics, 1: Stat 

Calculations and 6:Quadratic Regression. 

• Press ¤ to open the x List field. Choose 
time for this field for each regression.  

• Press e to move to the y List field. 
• Choose the appropriate athlete for each 

regression.  
• See Figures 10, 11 and 12. 

 
4. The coach has established a guideline that the 

athlete’s heart rate must not exceed 100 beats 
per minute at exactly 3 minutes. Do all the 
athletes seem to meet the criteria? Draw in a 
line and manipulate the line until it is tangent 
to the function at time 3 minutes. Find the 
slope of the tangent line. 
• Move back to the first scatter plot.  

• Press b followed by 3:Graph Type 

and choose 1:Function. Move to f1(x) 

and press · to graph the curve with the 
scatter plot. See Figure 13. 

• Press e to move to the entry line and 
scroll to f4(x).  

• Type in the equation f4(x) = 80x as an initial 
guess for the line tangent to the curve. A line 
will appear on the screen.  

• Press d to move the cursor into the 
graphing window.  

• Move the cursor to the end of the line to 
change the slope of the line and to the middle 
of the line to change the y-intercept. 

Figure 10 

Figure 11 

Figure 12 

Figure 13 
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• Continue to make adjustments using these 
two tools until you have a line that appears to 
be tangent to the curve at x = 3.  
See Figure 14. 

• Repeat this for the other two scatter plots. 
See Figures 15, 16, 17 and 18. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 14 

Figure 15 

Figure 16 

Figure 17 
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5. When does each athlete’s heart rate reach 

100 beats per minute? Drag the tangent line 
to graphically estimate when this happens for 
each athlete. 
• Drag the end of the line until the slope is 

close to m = 100.  
• Then, drag the line until it appears to be 

tangent to the curve.  
• Using the tic marks on the x-axis, record the 

approximate value of x. See Figure 19. 
• Repeat for the other two curves.  
• See Figures 20 and 21. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 18 

Figure 19 

Figure 20 

Figure 21 
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6. Find the instantaneous rate of change of the 

number of heart beats for each athlete’s data 
by finding the value of the derivative at time 
3 minutes. Are these answers close to your 
estimates in question 4? 
• Open a new Calculator page.  

• Press b followed by 1:Tools and 

1:Define. 
• Enter the function name fp1(x) and press the 
= key.  

• Press b followed by 5:Calculus and 

1:Derivative.  
• Complete the derivation expression as shown 

in Figure 22.  
• On the next line, evaluate the new function at 

x = 3. See Figure 22. 
• Repeat for the other two relationships. See 

Figures 23 and 24. 
 

7. Using your equations, when does each 
athlete’s heart rate reach 100 beats per 
minute? Are these answers close to your 
estimates in question 5?  
• Open a new Calculator page.  

• Press b followed by 4:Algebra and 

1:Solve.  
• Set each derivative function equal to 100. See 

Figure 25. 
 

Figure 22 

Figure 23 

Figure 24 

Figure 25 
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8. As an alternative approach, add a point on 
the curve and construct the tangent line at 
this point. Measure the slope of the tangent 
line and drag the point until the slope is close 
to m = 100. 
• Open a new Graphs & Geometry page and 

plot f1(x).  

• Press b followed by 6: Points and 

Lines and choose 2: Point On.  
• Move to the curve and click. A point and its 

coordinates will appear.  

• Press b followed by 6: Points and 

Lines and choose option 7: Tangent.  
• Move to the point on the curve and click on 

the point.  
• A line tangent to the curve at the point will 

appear. You may need to drag the end points 
out to see the tangent line better.  

• Press b followed by 7: Measurement 

and choose option 3: Slope.  
• Click on the tangent line and move the slope 

value to an open area.  
• Label the slope as shown in Figure 26. 
• Drag the point until the value of the slope 

(m) is close to 100. See Figure 27. 

 

Figure 26 

Figure 27 
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L e s s o n  P l a n  N o t e s   
f o r  t h e  Ta l e  o f  t h e  Ta p e  

 
Course(s): Algebra 1 and Calculus 

 

Topic(s): Scatter plots, functions, graphing, 
equations, recursive sequences, derivatives, and 
local maximums 
 
Related NCTM Standards:  

Algebra Standards: 

1. Students should generalize patterns using 
explicitly defined and recursively defined 
functions. 

2. Students should use symbolic algebra to 
represent and explain mathematical 
relationships. 

3. Students should identify essential 
quantitative relationships in a situation and 
determine the class or classes of functions 
that might model the relationships. 

4. Students should draw reasonable conclusions 
about a situation being modeled. 

5. Students should approximate and interpret 
rates of change from graphical and numerical 
data. 

6. Students should analyze functions of one 
variable by investigating rates of change, 
intercepts, zeros, asymptotes, and local and 
global behavior. 

7. Students should judge the meaning, utility, 
and reasonableness of the results of symbol 
manipulations, including those carried out by 
technology. 
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8. Students should draw reasonable conclusions 

about a situation being modeled. 
 
Suggested Total Time: One hour 
 
Specific Pre-requisite knowledge: 

Students should be familiar with the following: 

• Using spreadsheet formulae 

• Recursive sequences 

• Constructing a scatter plot 

• Finding the function of best fit 

• Derivatives of functions 
 
Materials Required/Classroom Set-
up/Preparation: 

The following equipment will be needed: 

• Each student should have access to a  
TI-Nspire™ math and science learning 
handheld with the file  
“D3_1TaleofTape.tns” pre-loaded. 

• If the CAS solution is to be explored, 
then students should have access to a  
TI-Nspire™ CAS math and science 
learning handheld. 

 
Lesson Notes: 

The step-by-step solutions present three 
approaches for solving this problem. The first 
two could be done by an Algebra 1 student while 
the CAS solution is for Calculus students only. 

1. If CAS is not an option, an alternative could 
be to find the point of intersection with the 
graphs and the x-axis. 
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2. As students are working through the 

solutions, you may want to keep the 
following issues in mind: 

• It is likely that every student or group 
will have a different solution for the 
moveable parabola. This should not 
concern them. Stress that they are not 
trying to get any particular solution 
(which you might demonstrate) and that 
almost every solution has validity. The 
only solutions that should be excluded 
are ones where the maximum point 
occurs after the point (440, 60). 

• Anticipate some problems as students 

move through the regression and 

scatterplots. There is likely to be some 

confusion as to when they should press 

· to open a field and when to press 

¤ on the NavPad cursor control. 

• Encourage students to try different values 
for the coordinates of the third point in 
the second approach. 

• The CAS model is the most 
straightforward, although younger 
students would have no appreciation for 
the mathematics involved in this solution. 

3. Students will need to be kept on task. Each 
model might take some time, and they might 
become discouraged. 
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Name  ____________________________ The Tale of the Tape 
Student Worksheet 

Class  ____________________________ 

 
 

In 1997, Mark McGwire hit a monstrous home run off pitcher Randy Johnson. The ball was 

hit from a height of about 3 feet and it landed in the stands 440 feet from home place, 60 feet 

above the playing surface. At the time, it was claimed that the ball would have traveled 538 

feet if the path were unobstructed. 

Your problem is to investigate the path of the ball three ways and to determine what distance 

you think the ball might have traveled if not stopped by the stands. 

Before you begin the investigation, you might like to try websites such as www.mlb.com 

which has several videos of home runs archived. The site www.HitTrackerOnline.com has 

archived video from long home run hits from the past few years. 

 
Approach 1 – Using a Parabola 

In the first approach to this problem, you will use a moveable parabola to try to physically fit 

a curve to the two points. At one point, you will be asked to determine how close your curve 

fits the two points. 

1. Enter the function evaluations below. 
 

f(0) = _______________ and f(440) = _________________ 
 

2. What is the meaning of the x-intercept in the context of this question? 
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Approach 2 – The Regression Equation 

3. How far did the ball travel in this solution? 
 
 
 
 
 

 
Approach 3 – The CAS solution 

4. In this problem, two different velocities are considered. What is the difference between 
them? 

 
 
 
 
 
 
 

After completing this investigation and looking at the video from the websites: 
 

5. Do you think that 500 feet home runs are possible? 
 
 
 
 
 
 
 
 

6. If so, how many players are capable of hitting such a home run? 
 
 
 
 
 
 
 
 
 
 

7. In the 1950s, Mickey Mantle was the big hitter for the New York Yankees. Try to find 
information about how far some of his home runs traveled. 
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T h e  Ta l e  o f  t h e  Ta p e  

Materials 
• TI-Nspire™ Math and Science 

Learning Handheld 
• D3_1TaleofTape.tns 

Overview 
In this activity, students will model the path of a baseball and solve problems 
related to the distance the ball travels. 

 

Introduction 

In 1997, Mark McGwire hit a home run off of 

Randy Johnson. The claim was made that the 

ball would have traveled 538 feet if it hadn’t 

landed in the stands. 

The ball was hit from a height of about 3 feet, 

and it landed in the stands 440 feet from home 

plate, 60 feet above the playing surface. 

What we have to do is to create a model for this 

situation and determine how far this ball might 

have traveled. 

There are three different approaches to the 

problem: 

1. Using the movable parabola feature. 

2. Using a regression equation. 

3. Using the CAS. In this approach, we add in 

another piece of information and make use of 

some physics formulae. 
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Approach 1: The Movable Parabola 

1. Open a new document. 

2. Add a Notes application page. 

3. Type the information related to this problem 

as shown on page 1.1 in the .tns file. 

4. Add a second and third Notes application 

page to this document to include the 

additional information. 

5. Add a Lists & Spreadsheet application page. 

6. Enter the distances into column A, and label 

this column dis. 

7. Enter the heights into column B, and label 

this column ht. See Figure 1. 

8. Add a Graphs & Geometry application page, 

and press b 3 3 for Menu 3: 

Graph Type, 3: Scatter Plot. 

9. Choose dis for the x-entry and ht for the  

y-entry. 

10. You will need to adjust the window by 

pressing b 4 1 for Menu  

4: Window, 1: Window Settings. 

11. Complete the dialog box using appropriate 

values. Press · (Figure 2). 

12. Insert a Notes application page, and include 

the information given in the .tns file on  

page 1.6. 

13. Press/ ` to display the page sorter.  

14. Highlight page 1.5 (Figure 3). 

15. Press / C to copy the page. 

 

Figure 1 

Figure 2 

Figure 3 
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16. Move to the right to highlight page 1.6. 

17. Press / V to insert a copy of page 1.5 

after page 1.6. 

18. On page 1.7, press b 3 1 for Menu 

3:Graph Type, 1: Function. 

19. For the equation, enter a function that opens 

down. 

20. Discuss the rationale for this beginning 

equation with the students. 

• The function in Figure 4 started as  

f1(x) = -0.001(x-250)2+300. 

21. Move your cursor to one of the ends of the 

parabola, and note the symbol that appears. 

See Figure 5. 

22. Press / x to grab the parabola. 

• You will be able to bend the graph in both 

directions.  

23. When you are satisfied with the shape of the 

parabola, move the cursor close to the vertex, 

and note that a different symbol appears. See 

Figure 6. 

24. Press / x to grab the point, and you 

will be able to drag the parabola to a new 

location. 

25. Move the parabola to a position where it 

appears to pass through the two points. 

• There are an infinite number of graphs that 

are possible solutions. One graph is shown in 

Figure 7. 

Figure 4 

Figure 5 

Figure 6 

Figure 7 
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26. Add a Notes application page. Type the 

information related to this problem as shown 

on page 1.8 in the .tns file. 

27. To test whether the function graphed on page 

1.7 passes through the two points, students 

will be instructed to insert a Calculator 

application page, and find the actual values 

for f1(0) and f1(440) (Figure 8). 

• Comments may be added to a Calculator 

page by pressing b 1 6 for Menu 

1:Tools, 6:Insert Comment. 

• If these function values are close to 3 and 60, 

respectively, you should continue. 

• If not, go back to the Graphs & Geometry 

page, and change the function again. 

28. Add a Notes application page. Type the 

information related to this problem as shown 

on page 1.10 in the .tns file. 

29. If using a CAS device, add another 

Calculator application page, and solve for the 

x-intercept of f1(x). See Figure 9. 

 

Approach 2: Using a Regression 

Note: Pages 2.1 and 2.2 in the .tns document 

are Notes pages. Page 2.3 is a copy of the 

spreadsheet on page 1.4 with the screen 

split vertically and a Graphs & Geometry 

application added. 

The first two rows of the spreadsheet are the 

same as before, using the two points provided in 

the problem. The third point, (220, 100), is 

completely arbitrary. See Figure 10. 

Figure 8 

Figure 9 

Figure 10 
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1. While in the Lists & Spreadsheet work area, 

press b 4 1 6 for Menu 

4:Statistics, 1:Stat Calculations, 6:Quadratic 

Regression. 

2. Press e to move between fields. 

3. Complete the top part of the dialog box as 

shown in Figure 11. 

4. As you move down the Quadratic Regression 

dialog, fill the 1st Result Column entry field 

with d[]. 

Note: The [] comes from typing [ and ]—it is 

not a special symbol. 

5. Press e to move to the bottom of the 

dialog box, and press · on the OK button. 

• You should see the results in columns D and 

E. See Figure 12. 

6. Press / e to move to the Graphs & 

Geometry work area. 

7. Press b 3 3 for Menu 3:Graph 

Type, 3:Scatter Plot. 

8. At the bottom of the work area, for the x 

entry, choose dis, and for the y entry, 

choose ht. See Figure 13. 

9. Press b 4 9 for Menu 4:Window,  

9: Zoom Stat. See Figure 14. 

10. Press b 3 1 for Menu 3:Graph 

Type, 1:Function. 

Figure 11 

Figure 12 

Figure 13 

Figure 14 
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 11. Use the NavPad cursor controls to move up 

to f1(x) in the entry line, and then press ·. 

See Figure 15. 

12. Add a Notes application page. Type the 

information related to this problem as shown 

on page 2.4 in the .tns file. 

 

13. If using a CAS device, insert a Calculator 

application page, and solve for the  

x-intercept(s) of f1(x). See Figure 16. 

 

Note: An interesting aside is shown in this 

approach when you go back to the Lists & 

Spreadsheet page (2.3) and change the height for 

the third point. 

 

As soon as you press ·, you will see the point 

change in the Graphs & Geometry page, as well 

as in the regression equation. See Figure 17. 

However, the last solution for the x-intercept will 

need to be re-calculated.  

 

 

 

 

 

 

 

 

Figure 15 

Figure 16 

Figure 17 
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 Approach 3: Using the CAS 

To create the TI-Nspire document in Problem 3 

insert six Notes application pages. Type the 

information related to this problem as shown on 

page 3.1 to 3.6 of the .tns file.  

The following illustrates potential solutions as 

students insert pages and work through the 

investigation. The page numbering will change 

as students insert pages. 

Note: Additional information is that the ball took  

5.1 seconds to travel from home plate to the 

stands. 

1. On page 3.2, students are instructed to insert 

a Calculator application page, and enter the 

calculation for the forward velocity  

(page 3.3 - Figure 18). 

2. Press / followed by · for an 

approximate answer. 

3. Store this value to variable vf. 

• To get the right arrow, press / followed 

by h. See Figure 18. 

4. On page 3.5 students will be instructed to 

insert another Calculator application page. 

5. Press b 1 1 for Menu 1:Tools, 

1:Define. 

• Define the function h(t) as shown in  

Figure 19. 

• Use v as the coefficient of the second term, 

and be sure to enter a multiplication symbol 

in between v and t.  

Figure 18 

Figure 19 
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6. In the second line, press b 4 1 for 

Menu 4:Algebra, 1:Solve. 

7. On the third line, re-define the function by 

copying the command from the first line, 

pressing the * key, and copying the result 

from the last line. 

8. Enter h(t) and press ·, the updated 

function will be displayed. See Figure 19. 

9. On page 3.7 students will be instructed to 

insert another Calculator application page.  

10. On the first line, solve for the x-intercept of 

the function (Figure 20). 

• Since the first answer is negative, that 

solution should be discarded. 

11. On the next line enter V F h. 

12. To get the constant, move up to the previous 

line, and highlight the results. Press · to 

paste the results, and use the . key to 

edit out all of the variables and the negative 

decimal answer. 

13. Press ·. See Figure 20. 

14. On page 3.9 students will be instructed to 

insert a new Calculator application page. 

15. Define dh(t) to be the derivative of h(t) with 

respect to t (Figure 21). 

• The second line is not necessary, but it does 

show the derivative function. 

16. In the third line, solve for the zero of the 

derivative function. 

17. In the fourth line, note the use of the * key 

between the name of the function and the 

result. See Figure 21. 

Figure 20 

Figure 21 
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L e s s o n  P l a n  N o t e s  f o r   
D e r i v a t i v e s  f o r  A l g e b r a 1  

 Subject:  Calculus 
 

NCTM Standards 
All students should… 

Grades 9-12 Algebra Standards: 

1. generalize patterns using explicitly defined 
and recursively defined functions 

2. analyze functions of one variable by 
investigating rates of change, intercepts, 
zeros, asymptotes, and local and global 
behavior 

3. understand and perform transformations such 
as arithmetically combining, composing, and 
inverting commonly used functions, using 
technology to perform such operations on 
more-complicated symbolic expressions 

4. understand and compare the properties of 
classes of functions, including exponential, 
polynomial, rational, logarithmic, and 
periodic functions 

5. interpret representations of functions of two 
variables 

6. use symbolic algebra to represent and explain 
mathematical relationships 

7. judge the meaning, utility, and 
reasonableness of the results of symbol 
manipulations, including those carried out by 
technology 

8. identify essential quantitative relationships in 
a situation and determine the class or classes 
of functions that might model the 
relationships 

9. draw reasonable conclusions about a 
situation being modeled 
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•  Activity Overview 
As students drag point X along the x-axis, the 
tangent line “slides” along the graph of the 
parabola and the slope of the tangent line 
changes. The slope of the tangent line depends 
on the shape of the graph and the point of 
tangency. Students should be able to verbalize 
these relationships from their observations. 

• They should then construct a locus that 
shows the path of point P.  

• They should be able to describe how this 
locus summarizes information about the 
slope of the parabola.   

• Students will then change the parabola to 
other functions such as a cubic or a sine wave 
and repeat the process. 

The technique of constructing perpendicular 
lines through point X and the transferred point on 
the y-axis is called “cross-hairing” (like the 
cross-hairs in a telescopic sight or surveyor’s 
transit). In a mathematical sense, these two 
perpendicular lines project their individual 
values across the plane allowing the change of 
the two variables to be viewed as the pathway of 
this point (Figure 1). 

Materials Needed 

“D3_2Derivative.tns” document 
Derivative as a Function student worksheet 
 

Prerequisite Knowledge 

Students should be familiar with the concept of 
the derivative as the slope of a tangent line.  
However, they should not know about the 
derivative as a function since this activity will 
help them discover this new way of thinking 
about derivatives. 

Pedagogy 

Students are sometimes confused in Calculus 
when the term derivative is used in one context 
to represent a numeric value and used in another 
context to represent a function. This activity 
should help them understand these two uses of 
the derivative.   

Figure 1 
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Properties that may need some prompting from 
the teacher are related to special positions of the 
tangent line, e.g., when its slope is zero, when 
the direction of rotation changes, why the graph 
of the derivative looks the way it does, or what 
happens off the edges of the screen.   
The idea of mapping the value of the slope of the 
tangent line to the y-axis is the key element in 
the visual technique of this activity. Once this 
value is mapped to the y-axis, the stage is set to 
produce the graph of a function “derived” from a 
variable dependent on the actual shape of the 
original function’s graph.  

Instructions to Create the Document 

1. Open a new document. 
2. Add a Graphs & Geometry application. 

• Enter the function 2)(1 xxf =  in the 
function edit line (Figure 2).   

• Use the Window Settings option in the 
Window menu to set a [-5,5] x [-10,15] 
viewing window.   

• Use the Hide/Show tool in the Tools menu 
to hide the equation f1 in the viewing 
window. 

3. Use the Point On tool in the Points & Lines 
menu to place a point on the x-axis.  
• Take care to place the point between hash 

marks.   
• Immediately after placing the point on the 

axis, press g X to attach a label to the 
point.    

4. Place a line perpendicular to the x-axis at 
point X using the Perpendicular tool in the 
Construction menu.   

5. Use the Intersection Point(s) tool in the 
Points & Lines menu to mark the 
intersection of the perpendicular line and the 
graph of 2)(1 xxf = .    
• Label the point “T” (Figure 3). 

6. Create a tangent line to the curve at T with 
the Tangent tool in the Points & Lines 
menu.    

Figure 2 

Figure 3 
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 • Be certain the point T  is blinking (selected) 
when you place the tangent line.   

7. Find the slope of the tangent line with the 
Slope tool in the Measurement menu. 
• After clicking the tangent line, the value of 

the slope should appear.   
• Move this slope to the upper right-hand 

corner of the screen and click again  
(Figure 4). 

8. Use the Text tool in the Tool menu to insert 
the label “slope =” in front of the slope value. 
• You may need to drag the label to adjust the 

placement.   
• Adjust the precision of the slope to one 

decimal place by hovering the pointer tool 
over the value of the slope and pressing - 
several times (Figure 5). 

9. Now, use the Measurement transfer tool in 
the Construction menu to transfer the value 
of the slope on to the y-axis. A point should 
appear on the y-axis.   
• Label this point S.   
• Use the Perpendicular tool in the 

Construction menu to construct a 
perpendicular line to the y-axis through 
point S.   

• Use the Attributes feature in the Tools 
Menu to change the style of the two 
perpendicular lines to dashed (Figure 6). 

10. Find the intersection of the perpendicular 
lines with the Intersection Point(s) tool in 
the Points & Lines menu.   
• Label this point P.   
• Use the Coordinates and Equations tool in 

the Tools menu to find the coordinates of 
point P.   

• Adjust the precision of the coordinates to one 
decimal place by hovering the pointer tool 
over each coordinate and pressing -.   

• You may need to move the coordinates 
slightly but keep them close to point P. 

11. Drag point X along the x-axis.   
• The tangent line, the slope, and point P 

should adjust accordingly (Figure 7). 

Figure 4 

Figure 5 

Figure 6 

Figure 7 
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12. Store the x-coordinate of point P to a variable 
named px.   
• To accomplish this task, select the  

x-coordinate with the Pointer tool, press 
h, select 1:Store Var, and then press 
PX·..   

• The value of the x-coordinate should now 
appear in bold print.  Press d to return to 
the Pointer tool mode.   

13. Store the value of the slope in a variable 
named slope.   
• To do this, select the slope value with the 

Pointer tool, press h, select 1:Store 
Var. 

• Since the name “slope” already appears in 
the text box, just press ·.  Press d to 
return to the Pointer tool mode.  

14.  Press c and insert a Lists & 
Spreadsheet application.   

15. Name the first column “xc” and the second 
column “slp” (Figure 8). 

16. Link column A to the variable px for manual 
data capture with the following procedure: 
• Move the cursor to the formula entry cell for 

column A and then press b and select 
3:Data.   

• Now select 2:Data Capture and then 
2:Manual Data Capture. A formula should 
open in the formula entry cell.   

• Press h and select 3:Link To: .   

• Highlight variable px, press · to paste 
this variable back to the formula and then 
press · again to save the formula  
(Figure 9).   

17. Use a similar process to link column B to the 
variable slope (Figure 10). 

18. Press / ¡ to return to the Graph & 
Geometry application.   

Figure 8 

Figure 9 

Figure 10 
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19. Press b and select 3:Graph Type and 
then 3:Scatter Plot.   
• Select xc for the x-values and slp for the  

y-values (Figure 11). 
20. Select 1:Function from the Graph Type 

menu to return to function graphing mode. 
21. Even though you are not finished, save the 

file as “tanslope.”   

• To save:  Press /c, select 1:File and 
then 4:Save As.   

• Type in tanslope for the file name and press 
·.    

22. Next, you are going to add another problem 
and repeat steps 2 through 19. However, in 
this problem, you will graph the cubic 
function 253 +−= xxy  in a [-5,5] x [-10,10] 
viewing window.   

• Press /c then select 2:Edit and 
8:Insert Problem (Figure 12). 

23. Now repeat steps 2-19 with the cubic 
function 253 +−= xxy  in place of the 
parabola 2xy = .   
• Use a [-5,5] x [-10,10] window instead of a [-

5,5] x [-10,15] window (Figure 13). 

24. Save the updated activity by pressing / 
c then select 1:File and 3:Save. 

25. Now you will add one more problem and 
repeat steps 2 through 19. However in this 
problem you will add the sine function 

)sin(5 xy =  in a [-7,7] x [-10,10] viewing 
window.   
• Press / c and then select 2:Edit and 

8:Insert Problem.   
• Repeat steps 2 through 19 for the sine 

function (Figure 14). 
26. Select the Save feature from the File menu 

to save the finished activity. 

Figure 11 

Figure 12 

Figure 13 

Figure 14 
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Name  ____________________________ Derivatives for Algebra1  
Student Worksheet 

Class  ____________________________ 

 

In this activity you will explore the changes to the slope of a tangent line as the point of 
tangency changes. This will be done numerically and summarized visually. The visual 
summary can be thought of as a new slope function called a derivative. Next you will 
investigate further what happens to the slope function as the original function changes.  
 

1. Open the file D3_2Derivative.tns. This is the graph of 2xy =  (Figure 1).  
 
 
 
 
 
 
 
 
 
 
  
  
 
Drag point X along the x-axis to move the tangent line. Answer the following questions.  

• When is the slope of the tangent line positive? 
 

• When is the slope of the tangent line negative? 
 

• When is the slope of the tangent line zero? 
 

2. What do the x and y coordinates of the point P have to do with the tangent line? 
 

3. Drag point X and notice the path point P follows.    
• You can plot a point at the current location of point P by pressing / ^.   
• Use the Hide/Show tool to hide the label (xc,slp) that appears when you first press  
/ ^. 

• When you move point P away, you should see a point marking the old location of P. 
• Marking some of the locations of point P should help you see the path point P follows.   
• You can press / ¢ to move to the next page and see the coordinates of the points you 

have marked.   
• Press / ¡ to move back to the graph. Describe the path of point P. 

 
 

Figure 1 
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4. Make a locus of point P as point X changes (Figure 2). 
• Press b. From the Construction menu, choose Locus.   
• Click on point P and then point X.   
• Sketch your results in the window provided. 

 
 
 
 
 
 
 
 
 
 

 
  
  

5. This locus is called a derivative. What does the derivative tell us about the graph of the 
parabola? 

 
 
6. See if you can find an equation for the derivative.   

• Enter the equation in f2(x) to check.  
 

• Does it match the locus?   
 

• Write your equation for the derivative: 
 
 

7. Predict what will happen to the derivative as you make the following changes to the 
parabola. Don’t actually make the changes to the parabola on your calculator until you 
have written down your predictions. 
• Vertical shift 

Prediction: 
Actual: 
 

• Vertical stretch 
Prediction: 
Actual: 
 

• Vertical shrink 
Prediction: 
Actual: 
 
 

Figure 2 
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8. Press / ¢ twice to move to Problem 2.1 (Figure 3).  
 
 
 
 
 
 
 
 
 
 
 
  
  
This is the graph of 253 +−= xxy . Consider what will happen to the slope point P as 
you drag the tangent line.   
• When will point P be below the x-axis? 

 
• When will point P be above the x-axis? 

 
• When will point P be on the x-axis? 

 
9. Predict the graph of the derivative of 253 +−= xxy .   

• Sketch your prediction in the window above. 
• Then check your answer by making a locus of points. 

 
 
10.  See if you can find an equation for the derivative.   

• Enter the equation in f2(x) to check.   
• Does it match the locus?   
• Write your equation for the derivative: 

 
 

11. Press / ¢ twice to move to Problem 3.1 (Figure 4).  
 
 
 
 
 
 
 
 
 
 
  
  

Figure 3 

Figure 4 
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This is the graph of )sin(5 xy = . Consider what will happen to the slope point P as you 
drag the tangent line. 
• When will the slope be positive? 

 
• When will the slope be negative? 

 
• When will the slope be zero? 

 
 

12. Predict the graph of the derivative of )sin(5 xy = .   
• Sketch your prediction in the window above. 
• Then check your answer by making a locus of points. 

 
 
13. See if you can find an equation for the derivative.   

• Enter the equation in f2(x) to check.   
• Does it match the locus?   
• Write your equation for the derivative: 

 
 
 
14. Transform the sine wave (i.e., vertical shift, vertical stretch, vertical shrink).   

• What happens to the derivative? 
 
 
 
15. Explain why sometimes when you are asked to find a derivative in a calculus book the 

answer is a single number and other times the answer is a function. 
 
 
 

Extension 

Add a calculator page and use the CAS derivative command to find the derivative of 2xy = .  

• Does your result match your equation in step 7?   
 

• Use CAS to find the derivatives of  253 +−= xxy   and  )sin(5 xy = .   
 

• Do your answers match the results in steps 11 and 14? 
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C h o r d s  i n  C i r c l e s  

Concepts 
• Chords  
• Loci 
• Ellipses 

Materials 
• TI-Nspire™ Math and Science 

Learning Handheld 

Overview 
In this activity, students will explore: 

• The relationship between the length of a chord and its distance 
from the center of the circle; and 

• The relationship between the lengths of chords and their distances 
from the center of the circle. 

 

 
NCTM Standards 
All students should… 

Grades 9-12 Algebra Standards: 

1. interpret representations of functions of two 
variables 

2. use symbolic algebra to represent and explain 
mathematical relationships 

3. use a variety of symbolic representations, 
including recursive and parametric equations, 
for functions and relations 

4. identify essential quantitative relationships in 
a situation and determine the class or classes 
of functions that might model the 
relationships 

5. draw reasonable conclusions about a 
situation being modeled 

Grades 9-12 Geometry Standards: 

1. analyze properties and determine attributes of 
two- and three-dimensional objects 

2. explore relationships (including congruence 
and similarity) among classes of two- and 
three-dimensional geometric objects, make 
and test conjectures about them, and solve 
problems involving them 

3. establish the validity of geometric 
conjectures using deduction, prove theorems, 
and critique arguments made by others 

4. use Cartesian coordinates and other 
coordinate systems, such as navigational, 
polar, or spherical systems, to analyze 
geometric situations 

5. investigate conjectures and solve problems 
involving two- and three-dimensional objects 
represented with Cartesian coordinates 
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6. draw and construct representations of two- 
and three-dimensional geometric objects 
using a variety of tools 

7. use geometric models to gain insights into, 
and answer questions in, other areas of 
mathematics 

Grades 6-8 Geometry Standards: 

1. use geometric models to represent and 
explain numerical and algebraic relationships 

 

Introduction 

Students can investigate these properties using 

the pre-made TI-Nspire document file, 

“D3_3Chords.tns” which includes some 

constructions done for them. Alternatively 

teachers may desire students to do all the 

constructions themselves. The instructions that 

follow here illustrate all the constructions. 

 

Part 1 

1. Open a new document, and add a Graphs and 

Geometry application page (Figure 1). 

2. Press b 2 1 for Menu 2:View, 

1:Hide Axes and then b 2 3 for 

3:Hide Entry Line (Figure 2). 

3. Construct a circle by pressing b 8 

1 for Menu 8:Shapes, 1:Circle.  

4. After clicking to choose the location of the 

center, immediately label the center by 

pressing g A (Figure 3). 

5. Using the NavPad cursor controls, move 

away from the center to increase the radius,  

Figure 1 

Figure 2 

Figure 3 
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6. Press · a second time to set the radius 

length. 

7. From the Menu, press 6 5 for  

6:Points and Lines, 5:Segment (Figure 4). 

• Construct a chord on the circle. 

• Label the endpoints of the chord immediately 

after pressing · to place each endpoint of 
the segment. 

8. Find the midpoint of chord BC by pressing 

b 9 5 for Menu 9:Construction, 

5:Midpoint. 

9. Label the midpoint D (Figure 5). 

10. Construct a perpendicular line. Press  

b 9 3 for Menu 9:Construction, 

3:Perpendicular Bisector. 

11. Construct a perpendicular line to chord BC 

through point A (Figure 6). 

12. Instruct students to drag point C.  

13. Choose 2:Hide/Show from the 1:Tools menu, 

and hide the line AD. 

14. Construct segment AD by choosing 

5:Segment from the 6:Points and Lines menu 

(Figure 7). 

15. Measure the lengths of chord BC and 

segment AD by pressing b 7�1 

for Menu 7:Measurement, 1:Length. 

Figure 4 

Figure 5 

Figure 6 

Figure 7 
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16. Drag the measurements to the upper right-

hand corner of the screen (Figure 8). 

17. To label each measurement, press · twice 

to select the measurement, move the cursor 

to the left (in front of the measurement), and 

type the appropriate label. 

18. Instruct students to drag point C. 

19. Select 1:Show Axes from the 2:View menu 

(Figure 9). 

• It might be necessary to drag the origin to the 

lower left corner and/or to drag the circle 
with labels and other measurements. 

20. Transfer length BC to the x-axis and length 

AD to the y-axis. Press b 9 8 for 

Menu 8:Constuction, 9:Measurement 

Transfer (Figure 10). 

21. Using the Measurement transfer tool, select 

measurement BC by pressing · and then 

select the x-axis by pressing ·. 

22. Repeat by transferring measurement AD to 

the y- axis. 

• A point should appear on each axis. 

23. Open a text box, and select the point on the  

x-axis. 

24. Label this point BC. 

25. Repeat for the point on the y-axis, and label 

it AD (Figure 11). 

26. Press b 9 1 for Menu 

9:Construction, 3:Perpendicular.  

Figure 8 

Figure 9 

Figure 10 

Figure 11 
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27. Construct a line through the point labeled 

AD perpendicular to the y-axis and another 

line through the point labeled BC 

perpendicular to the x-axis (Figure 12). 

28. Find the intersection of the two lines by 

pressing b 6 3 for Menu  

6:Points and Lines, 3:Intersection Point(s). 

29. Select each line by using the · key or the 

x key. 

• A point should appear. 

30. Label the point immediately by typing letter 

G (Figure 13). 

31. Drag or animate point B or C, and watch 

point G.  

32. Hide the perpendicular lines by selecting 

2:Hide/Show from the 1:Tools menu and 

clicking on each line with the cursor  

(Figure 14).  

33. To construct the locus of point G as point B 

moves on the circle, press b 9 6 

for Menu 9:Construction, 6:Locus. 

34. First, select point G and then point B  

(Figure 15).  

35. Drag point B or C, and then drag the circle to 

observe the behavior of point G. 

Figure 12 

Figure 13 

Figure 14 

Figure 15 
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36. Find the coordinates of point G by pressing 

b 1 6 for Menu 1:Tools, 

6:Coordinates and Equations and selecting 

point G (Figure 16). 

• See the Extension before beginning Part 2. 

 

Part 2  

1. Construct chord HJ in circle A. 

2. Find its midpoint, and label it K. 

3. Construct segment AK. 

4. Measure the length of chord HJ and the 

length of segment AK (Figure 17). 

5. Drag point H or J around the circle, and 

make the length of chord HJ close to the 

length of chord BC (Figure 17). 

6. Optional: Instruct students to plot length HJ 

and length AK on the x- and y-axes, 

respectively.  

• Repeat the locus construction with these 
measurements. Compare the two loci. 

 

Extension: 

1. After constructing the locus, challenge 

students to find the equation of the ellipse 

that fits the locus in terms of diameter and 

radius (Figures 18 and 19). 

• The solution is given here, but not in the 

body of the activity. As shown, the ellipse is 
centered at the origin and has a major axis of 
twice the diameter and a minor axis of twice 
the radius. 

Figure 16 

Figure 17 

Figure 18 

Figure 19 
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Name ____________________________ Chords in Circles 
Student Worksheet 

Class ____________________________ 

You will explore the relationships between the length(s) of a chord(s) and distance(s) from 

the center of the circle. Open the file D3_3Chords.tns on the TI-Nspire™ handheld. 

Part 1 

On page 2 of Problem 1, you are given circle A with chord BC and midpoint D of chord BC 

both drawn. The perpendicular bisector of chord BC is also drawn (Figure 1). 

 
Figure 1 

1. Drag points B or C around the circle, and make a conjecture about the perpendicular 

bisector with respect to the center of the circle. 

2. Answer Question 1 on the worksheet at the end of this handout. 

In Problem 2 (page 2.1), the perpendicular bisector has been hidden and segment AD drawn. 

3. First, measure the lengths of chord BC and segment AD by pressing b 7�1 for 

Menu 7:Measurement, 1:Length. Drag the measurements to a corner of the screen. 

4. To label each measurement, press · twice to select the measurement, move the cursor 

to the left (in front of the measurement), and type the appropriate label (Figure 2). 

 
Figure 2 



Chords in Circles 

T3 PROFESSIONAL DEVELOPMENT SERVICES FROM TEXAS INSTRUMENTS 
EXPLORING MATHEMATICS WITH TI-NSPIRE™ TECHNOLOGY   © 2007 TEXAS INSTRUMENTS INCORPORATED 

5. Drag point C, and answer Question 2 on the worksheet at the end of this handout. 

6. Next, proceed to problem 3. 

In Problem 3 (page 3.1), the length of chord BC has been transferred to the x-axis, and the 

length of segment AD has been transferred to the y-axis (Figure 3). 

 
Figure 3 

7. Drag point C or B to see the values change. 

8. On page 3.1, press b 9 3 for Menu 9:Construction, 3:Perpendicular Bisector. 

9. Select the point labeled BC on the x-axis and then select the x-axis. 

10. Repeat, to construct the line perpendicular to the y-axis through point AD (Figure 4). 

 
Figure 4 

11. Find the intersection of the 2 lines by pressing b 6 3 for Menu  

6:Points and Lines, 3:Intersection Point(s). 

12. Select each line by using the · key or the x key. A point should appear. 

13. Label the point immediately by typing letter G. 

14. Drag point C, and watch the path of point G. Look for a pattern. 
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On page 3.2, the perpendicular lines are hidden, and the path of point G (a locus of points) is 

shown (Figure 5). 

 
Figure 5 

15. Drag point C or B, and then drag the circle. 

16. Observe the behavior of point G. 

17. Find the coordinates of point G by pressing b 1 6 for Menu 1:Tools, 

6:Coordinates and Equations and selecting point G.  

18. Drag point C, and answer the Question 3 on the worksheet at the end of this handout.  

 
Part 2: Investigating Congruent Chords  

Problem 4 (page 4.1) has chord HJ added to circle A. The length of chord HJ and the distance 

from A to K (the midpoint of chord HJ) have been measured and segment AK has been 

constructed (Figures 7 and 8). 

   
Figure 7     Figure 8 

19. Drag H or J around the circle to make the length of chord HJ close to the length of chord 

BC. 

20. Answer Question 4 on the worksheet at the end of this handout.  
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Name  ____________________________ Chords in Circles 
Student Worksheet 

Class  ____________________________ 

1. As point C moves around the circle, what is true about the perpendicular bisector of 

chord BC?   

 

 

2. As point C moves around the circle, how does the length of chord BC relate to the 

distance of the chord from the center of the circle?  

 

 

What is true about chord BC if the distance is 0?  

 

 

3. As point C moves around the circle, describe the path of G by answering each of the 

following: 

a. When point G is at the y-intercept of the locus, what is true about BC and 

AD? 

 

b. When point G is at the x-intercept of the locus, what is true about BC and 

AD? 

 

c. As point G moves from left to right, what happens to the x-coordinate of the 

locus?  What does this have to do with the chord BC?  
 
 

4. Make a conjecture about the relationship of congruent chords and their distances from the 

center of the circle?  
 



 The Minimum Wage 

T3 PROFESSIONAL DEVELOPMENT SERVICES FROM TEXAS INSTRUMENTS 
EXPLORING MATHEMATICS WITH TI-NSPIRE™ TECHNOLOGY   © 2007 TEXAS INSTRUMENTS INCORPORATED 

 

Name ____________________________ The Minimum Wage 
Student Worksheet 

Class ____________________________ 

 
 

Using Technology to Advise the Congress 
Minimum wages for certain industries have been a part of the American labor movement 
since the 1930’s. The first nationally mandated Federal Minimum Wage was established in 
1955 at $0.75/ hour. Over the ensuing years, the minimum wage has been increased at 
irregular intervals reflecting the political and economic climate of the country. (See the 
graph.) In August, 1996 Congress passed and President Bill Clinton signed a new law that 
changed the minimum wage in the United States from $4.25 per hour to $4.75 effective 
October 1, 1996 and to $5.15 effective September 1, 1997. This was the last change to the 
Federal law up until 2006 when it became a campaign issue. 
 
During each election cycle since 1997 this hotly 
debated issue has come to the forefront for new 
consideration. After the 2006 midterm elections, the 
new Democratic Speaker of the House, Nancy 
Pelosi, promised that raising the minimum wage in 
the U.S. would be one of the top priorities for the 
newly elected Congress. She further stated that the 
current minimum wage in 2006, $5.15/hour, 
represents the lowest level of buying power for 
workers in the entire history of the federal minimum 
wage in the U. S. 
 
As is the case with all actions of the government, the minimum wage law always has many 
supporters and detractors. Small business owners usually oppose increases in the minimum 
wage claiming it is inflationary, will cost jobs, and ultimately run them out of business. 
Others contended that most increases are still not enough to balance the effects of higher 
costs of living. This argument seems particularly valid since the minimum wage has not 
changed in 10 years, since 1997. Who is correct? How much should the minimum wage be 
increased, if at all? Does the history of this program shed any light on what should happen in 
the future? In this problem, we will examine ways that mathematics and technology can be 
used to help analyze important decisions that affect our everyday lives. 
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Investigate: 
1. Open the TI-Nspire™ math and science learning handheld document titled 

D3_4MinWage.tns. Page 1.1 contains some background information for the problem.  
• Read the assignment on page 1.2 (Figure 1).  

 
 
 
 
 
 
 
 
 
 
  
  
 

• The data set for the history of the Minimum Wage in the U.S. is on page 1.3 in a spreadsheet 
format (Figure 2). 
 
 
 
 
 
 
 
 
 
 
  
  

 
2. Use the variety of mathematical tools contained in the TI-Nspire™ handheld or computer 

software to complete the assignment.  
• Add pages and/or problems to this document to do a complete analysis.  

 
• Make your recommendation for the Congress to act upon when considering what to do with 

the minimum wage for the United States. 
 
 
 
 
 
 
 
 

Figure 1 

Figure 2 
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Consumer Price Index (Minimum Wage Problem Continued) 
1. There is a second problem in the TI-Nspire™ document which adds new information to 

the minimum wage argument based on the Consumer Price Index (Figure 3).  
 
 
 
 
 
 
 
 
 
 
 
  
  
• Analyze the minimum wage data in light of this new information to see if the assertion about 

the low value of the 2007 minimum wage is true or not.  
 
 
 

2. Reanalyze the minimum wage data in light of the information provided by using the 
Consumer Price Index to adjust each year’s minimum wage for the corresponding values 
in 2007 dollars (Figure 4).  
 
 
 
 
 
 
 
 
 
 
 
  
 
• Apply this analysis to your recommendation to the Congress about what to do with the 

minimum wage in the near future. 

 
 

 
 
 

Figure 3 

Figure 4 
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Update: 

A bill is proposed has within its provisions a section providing an increase in the Federal 
Minimum Wage for the U.S. According to USA Today, the current $5.15 minimum wage will 
increase in $0.70 increments to $7.25 in three steps. Two months after the legislation is signed 
the minimum wage will increase to $5.85. One year later, it will take another $0.70 jump to 
$6.55. And finally, a $0.70 jump another year later to $7.25.  

Compare your predictive models to what will now happen to see which model was the most 
accurate.  
 
 
 
 
NCTM Standards 
 
Grades 9-12 Numbers and Operations Standards: 
 
All students should… 

1. develop a deeper understanding of very large and very small numbers and of various 
representations of them 

 
Grades 6-8 Algebra Standards: 
All students should… 

1. represent, analyze, and generalize a variety of patterns with tables, graphs, words, and, 
when possible, symbolic rules 

2. relate and compare different forms of representation for a relationship 
3. use symbolic algebra to represent situations and to solve problems, especially those that 

involve linear relationships 
4. model and solve contextualized problems using various representations, such as graphs, 

tables, and equations 
5. use graphs to analyze the nature of changes in quantities in linear relationships 

 
Grades 9-12 Algebra Standards: 
All students should… 

1. generalize patterns using explicitly defined and recursively defined functions 
2. interpret representations of functions of two variables 
3. use symbolic algebra to represent and explain mathematical relationships 
4. judge the meaning, utility, and reasonableness of the results of symbol manipulations, 

including those carried out by technology 
5. identify essential quantitative relationships in a situation and determine the class or classes of 

functions that might model the relationships 
6. draw reasonable conclusions about a situation being modeled. 

 
Grades 6-8 Data Analysis and Probability Standards: 
All students should… 

1. select, create, and use appropriate graphical representations of data, including histograms, 
box plots, and scatterplots 

2. discuss and understand the correspondence between data sets and their graphical 
representations, especially histograms, stem-and-leaf plots, box plots, and scatterplots 

3. make conjectures about possible relationships between two characteristics of a sample on 
the basis of scatterplots of the data and approximate lines of fit 
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Name ____________________________ The Swimmer Problem 
Student Worksheet 

Class ____________________________ 

 
 

Problem Statement 
The lifeguard sits near the shore on a straight stretch of Strait Lake beach. Approximately 
150 m down the beach, a swimmer, approximately 60 m off shore, yells for help. 

If the lifeguard can run 8 m/sec on land and swim 2 m/sec in the water, what is the best path 
for the lifeguard to take to reach the swimmer in the shortest amount of time (Figure 1)? 

You will be asked to solve this problem geometrically, numerically, graphically, and 
algebraically (Figure 2). 

 

   
Figure 1      Figure 2 

 
Investigate 

1. Move to page 1.2 of this problem in the TI-Nspire™ .tns document  

D3_5SwimmerProblem.tns. 

• This page contains an interactive model of the problem situation. 

• Point J represents the “jump- in” point where the lifeguard stops running along the 

“shoreline” and begins swimming. 
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2. Drag point J to simulate the various points where the lifeguard could choose to stop 

running and start swimming toward the swimmer in trouble. 

Figures 3 through 5 represent various possible solutions. 

• Figure 3 could be called the “swim only” solution where the lifeguard simply jumps directly 

into the water and swims all the way to the swimmer. 

• What are the advantages and disadvantages of this solution? 

 

 

 Figure 3  

• Figure 4 represents what might be called the “equal method” solution where the lifeguard 

runs and swims equal amounts. 

 

 
Figure 4 



The Swimmer Problem 

T3 PROFESSIONAL DEVELOPMENT SERVICES FROM TEXAS INSTRUMENTS 
EXPLORING MATHEMATICS WITH TI-NSPIRE™ TECHNOLOGY   © 2007 TEXAS INSTRUMENTS INCORPORATED 

 

• Figure 5 represents the “perpendicular” solution where the lifeguard runs down the beach 150 

meters, turns at a right angle to jump in the water and then swims the 60 m to the swimmer in 

trouble. 

• You cannot move the point J to the left of L or more than 150 m down the beach. 

• Why could you immediately dismiss those “solutions?” 

 

 
 Figure 5 

 

3. What are the characteristics of the “best” path in this problem? Explain. 

 

 

 

 

4. Make a conjecture about the best path for the lifeguard to follow to save the swimmer. 

Explain your reasoning. 
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5. In the TI-Nspire™ document, Problems 2, 3, 4, and 5 each contain a copy of the 

Swimmer Problem’s interactive model. Use these 4 work spaces to solve the original 

problem: 

1) Geometrically (Problem 2) 

2) Numerically (Problem 3) 

3) Graphically (Problem 4) 

4) Algebraically (Problem 5 – CAS option) 

• Add as many pages to each problem space as you need to solve the problem by the selected 

method. 

6. After you have completed all of the solution techniques, add a new Problem, Problem 6, 

and complete Notes which compare the various results for accuracy and 

understandability. 

7. Save the entire document with all of your work as Swimmer Problem [your last name], 

and submit this work to your teacher for evaluation. 
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T h e  S w i m m e r  P r o b l e m  

Materials 
• TI-Nspire™ Math and Science 

Learning Handheld 
• D3_5SwimmerProblemTch.tns 

Overview 
This activity describes the steps for creating the document and a potential 
solution for the various approaches to solving the problem. 
 

 
NCTM Standards 
All students should… 

Grades 9-12 Algebra Standards: 

1. generalize patterns using explicitly defined 
and recursively defined functions 

2. interpret representations of functions of two 
variables 

3. use symbolic algebra to represent and explain 
mathematical relationships 

4. judge the meaning, utility, and 
reasonableness of the results of symbol 
manipulations, including those carried out by 
technology 

5. identify essential quantitative relationships in 
a situation and determine the class or classes 
of functions that might model the 
relationships 

6. draw reasonable conclusions about a 
situation being modeled 

Grades 9-12 Geometry Standards: 

1. use Cartesian coordinates and other 
coordinate systems, such as navigational, 
polar, or spherical systems, to analyze 
geometric situations 

2. investigate conjectures and solve problems 
involving two- and three-dimensional objects 
represented with Cartesian coordinates 

3. use geometric models to gain insights into, 
and answer questions in, other areas of 
mathematics 
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Introduction 

One of the most important parts of the problem 
solving process is Polya’s first step—understand 
the problem. Students must experiment with the 
model to come to a good understanding of what 
the problem is asking. 
What is the “best” path for the swimmer? Why is 
time a critical factor in this problem? What 
difference is there between running along the 
beach and swimming in the water? 
Simply dragging point J, the transition point 
from running on the beach to swimming, is the 
first step in this process of understanding the 
problem.  
Several different strategies for the lifeguard 
should be discussed for advantages and 
disadvantages. For example, the “swim only,” 
solution where the lifeguard jumps into the water 
immediately and swims directly to the swimmer, 
is the shortest path, a straight line. Some students 
will ignore the fact that the lifeguard can travel 
much faster on the beach than swimming in the 
water. Is this the “best” path? Likewise, the 
“perpendicular” solution where the lifeguard 
runs down the beach to a position directly 
inshore from the swimmer, makes a right angle 
turn, and swims out to rescue the swimmer, is an 
“obvious” solution. This plan minimizes the 
swimming leg, taking advantage of the 
lifeguard’s speed on the beach. Other solutions 
could be investigated as well.  
Proceeding in this manner, eventually, students 
will see the need to display measurements that 
reveal how long it actually takes for the various 
solution techniques so an accurate judgment can 
be made about the “best” solution.  
A prepared TI-Nspire™ document file is 
included to show a potential solution. It is named 
D3_5SwimmerProblemTch.tns. 
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 You may need to offer assistance, guidance, or 
hints as students work on the various solutions. 
A rubric can be used for assessment purposes. 
  

1) Geometric Solution 

1. Measure the two legs of the lifeguard’s path 

to the swimmer—the running and the 

swimming portions (Figure 1). 

2. Compute the total time it takes for the 

lifeguard to get to the swimmer for any 

position of point J. 
• From the problem statement, we know that 

the lifeguard can run at 8 m/sec and swim at 
2 m/sec. 

• Using the basic distance-rate-time formula, 

D= r*t, we know that each time factor is 

8
running

running

D
t =  

and 
2

min
min

gswim
gswim

D
t = ,  

or the total time is the sum of these individual 

times, or gswimrunning ttTt min+=  

3. Drag point J along the line until the Total 

time is at its smallest value (Figure 2).  

• Notes may be added to the screen using the 
Text tool to identify findings. 

Geometrically, the solution is that it will take the 

lifeguard 47.7976 seconds to swim to the 

drowning swimmer if she runs 134.25 m down 

the beach before jumping into the water and 

swimming the rest of the way. 

 

Figure 1 

Figure 2 
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2) Numerical Solution 

1. Compute the total time (Ttime) for the 

lifeguard to reach the swimmer for any 

distance running down the beach based on 

the run and swim distances and speeds. 

2. Store these three variables into the memory 

using the h key (Figure 3). 

• The variable names can be entered during the 
storing operation (Figure 4). 

 

 

 

 

 

• Dragging point J generates various outputs 

for the run, swim, and Ttime in addition 
to updating the stored values automatically 
(Figure 5). 

 

 

 

 

 

3. Open a new page, and add a Lists & 

Spreadsheet application page (Figure 6). 

4. Label three columns running, swimming, 

and totaltime to serve as collection lists 

for the various outputs. 

 

 

 

Figure 3 

Figure 4 

Figure 5 

Figure 6 
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Note: You cannot name the lists in the 

spreadsheet with the same names used to 

store the variables from the geometric 

construction. The list names running, 

swimming, and totaltime are 

chosen to reflect the variables run, 

swim, and Ttime that will be stored in 

them, respectively. 

The spreadsheet will be used for several 

purposes: 

1) It will collect data from the geometric 

construction as point J is dragged. 

2) It will also send collected values directly 

to the graph screen to be plotted in a 

scatter plot as the data are collected. 

3) And, it will be the place where regression 

analysis will be done on the collected 

data. 

5. Collect the data using the Manual Data 

Collection tool on the Data menu (Figure 7).  

• This command allows the user to specify 
when and exactly how much data is actually 
collected. 

• Figure 8 shows this command entered into 

the “list rule” row of the spreadsheet (the 
gray cell below the column name) in the 
three named columns that are ready to collect 
data from shared variables run, swim, and 
Ttime, which will be generated in the 
geometric construction on page 3.1. 

6. To activate the Manual Data Collection 

command, press / ^. 

Figure 7 

Figure 8 
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• Figure 9 shows the first set of data collected 

in the spreadsheet, and Figure 10 shows the 
state of the geometric construction when 
those data were collected. 

 

 

 

 

 

 

 

 

 

 

7. Before collecting more data points, return to 

page 3.1, the Graphs & Geometry screen, 

press / c 6 1 for Menu 

6:Page Layout, 1:Custom Split (Figure 11).  

 

 

 

 

 

8. Use the + and - to select a 

horizontally split screen as shown in  

Figure 12. 

• Now you have a split screen view of the 

geometry construction modeling the problem 
at the same time you see the scatter plot of 
the collected data as they are being collected 
in the spreadsheet. 

Figure 9 

Figure 10 

Figure 11 

Figure 12 
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• Figure 12 (previous page) shows the split 

screen with a scatter plot (with the axes 
scaled appropriately) of the lists running and 
totaltime, the independent and dependent 
variables for this problem, respectively. 

• Only two data sets have been collected from 

the geometric construction at this point in the 
exploration. 

9. Switch to the geometric construction screen 

using the / e key sequence. 

10. Drag point J to another position along the 

line representing the edge of the beach, and 

press / ^ to collect more data, 

showing the total time as a function of the 

distance the lifeguard runs along the “beach” 

before jumping into the water. Repeat to 

collect more data. 

• Figures 13 and 14 show the scatter plot as the 

data are being collected. Clearly, there is a 
minimum value for the total time variable. 

• The question now becomes what type of 
function might model this data pattern? 

 

 

One way to fit a function to the data is to use one 

of the “transformable” function types like  

f1(x) = x2 (Figure 15). 

 

 

 

 

 

Figure 13 

Figure 14 

Figure 15 
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11. Drag and stretch the function until it “fits” 

the data in the scatter plot (Figure 16). 

• The values in the function definition can also 

be changed manually by directly editing the 
equation. 

 

12. Press b 6 2 for Menu 6:Points & 

Lines, 2: Point-On to put a point on the graph 

of the function (Figure 17). 

 

13. Drag the point along the graph until it 

reaches the minimum value of the function.  

• At that point, a lower case “m” appears 

indicating a local minimum and the 
coordinates of the point “jump” to a 
calculated value for the local minimum, not a 
simple coordinate pair on the function graph 
(Figure 18). 

• The minimum value from the numerical 

analysis of the transformed quadratic 
function seen in Figure 18 is for the lifeguard 
to run 134.5 meters down the beach before 
jumping into the water, giving a total time to 
reach the swimmer of 47.91 seconds. 

• The top part of Figure 18 shows point P 
dragged to the geometric solution of running 
134.25 meters down the beach for a total 
time to reach the swimmer of 47.7976 
seconds. 

• These solutions are relatively close together. 

 

 

 

Figure 16 

Figure 17 

Figure 18 
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Another way to model the data set is with 

regression tools. 

14. Switch to the spreadsheet, and press  

b 4 1 6 for Menu 4:Statistics, 

1:Stat Calculations. . . , 6:Quadratic 

Regression (Figure 19). 

• Once the model is chosen, a dialogue box 
will open where you can choose the lists to 
regress and the storage location for the 
resulting function definition, or you can keep 
the defaults (Figure 20). 

 

 

 

 

 

• Once the lists are specified, the regression 
results appear in the spreadsheet (Figure 21).  

15. Return to the scatter plot, and graph the 

regression model stored in function f2(x).  

 

 

 

16. Using the 2:Point-On tool from the  

6:Points & Lines menu again, drag the point 

to the local minimum value (Figure 22). 

• If the local minimum is not on the screen, 

readjust the scale of the x-axis by dragging 
the hash marks on this axis only. 

 

 

 

Figure 19 

Figure 20 

Figure 21 

Figure 22 
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As seen in Figure 22 (previous page), the local 

minimum is for the lifeguard to run 156.122 

meters down the beach for a total time to the 

swimmer of 47.4059 seconds. 

This solution, while mathematically correct for 

this model, means that the lifeguard actually ran 

past the “perpendicular” point at 150 meters by 

over 6 meters and then turned and swam back to 

the swimmer. 

Compare this solution to the geometric solution 

still showing at the top of Figure 22 (previous 

page).  

• Which is more accurate? 

As another model, Figures 23 and 24 show the 

cubic regression model and its corresponding 

local minimum value of running 135.551 meters 

down the beach for a time to the swimmer of 

48.1111 seconds. 

This may be a viable model until you notice that 

the coefficient of the x3 term in the regression 

equation is nearly equal to zero, making the 

equation nearly quadratic. 

Other models from the list of possible regression 

equations can be used to “fit” the data set. But 

remember, a rule of thumb when using 

regression modeling is that the “best” model is 

usually the “simplest” mathematical model. 

An example of this would be to use the n-1 

degree polynomial model to fit n data points 

exactly. 

 

Figure 23 

Figure 24 
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If you had 50 points in the data set, as long as 

none of the points are on top of each other or 

vertically aligned, as in this data set, then there is 

a 49th degree polynomial that exactly fits the 50 

points. A 49th degree polynomial is not a 

“simple” mathematical model. 

If you are working with a TI-Nspire™ CAS 

learning handheld, there is another way to find 

local minimum values of functions. 

Figure 25 shows the command fMin() used to 

find the x-value of the local minimum value of 

the first quadratic function we transformed to fit 

the data set. 

17. Once the x-value of local minimum value is 

established, evaluate the function at this 

value to produce the function value  

(Figure 25 above). 

 Repeat this procedure for other named 

functions such as the two regression models, 

quadratic and cubic, that are stored currently 

in f2(x) and f3(x). 

• The results are identical as those found using 
the 2:Point-On tool on the graph of the 
functions. 

Note: When a function can have more than one 

minimum value such as the cubic model 

f3(x) in this example, the fMin( ) tool 

requires 4 parameters including the 

function, the variable, a lower bound for 

the search area, and an upper bound for 

the search area (Figure 25 above). 

 

Figure 25 
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 18. Whether you are using a TI-Nspire™ CAS 

handheld or not, add a Page to the document, 

and add a Notes application. 

19. Write a summary of the results of the 

numerical solution for future reference 

(Figure 26). 

 

3) The Graphical Solution 

This solution begins with an analysis of the 

problem so that an algebraic equation that 

represents the problem situation can be written.  

Figure 27 shows a geometric construction of the 

problem (cut and pasted onto a new page (4.1) of 

this document). 

This model is still dynamic by dragging point J. 

However, the measurements have been replaced 

by variable representations. The distance the 

lifeguard runs before jumping into the water is 

represented by x and is the independent variable 

in the problem. 

The swimming distance for the lifeguard is the 

hypotenuse of a right triangle with legs of 60 m 

and (150-x) m. By the Pythagorean Theorem, the 
hypotenuse is equal to 2 260 (150 )x+ − . Given 

a running speed of 8 m/sec and a swimming 

speed of 2 m/sec, the total swimming time is 

given by the function 
2 260 (150 )

( )
8 2

xxTt x
+ −

= +  (Figure 5b). 

 

Figure 26 

Figure 27 
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1. Highlight the right side of the function in 

Figure 28 using the Text tool in combination 

with the Caps Shift key and the arrow keys.  

 

 

2. Press / c 2 4 for Menu 

2:Edit, 4:Copy (or press / C on the 

handheld keyboard) to copy the highlighted 

function definition (Figure 29). 

 

 

 

 

 

 

3. Add a new page to the document, and add a 

Graphs & Geometry application (Figure 30).  

 

 

 

 

 

4. Paste the saved function definition into the 

Function Entry Box using the 2:Edit menu or 

/ V from the keyboard (Figure 31).  

 

 

 

 

 

Figure 28 

Figure 29 

Figure 30 

Figure 31 
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5. Draw the graph of the function, adjusting the 

window as needed (Figure 32). 

A graphical solution is shown in this example 

using the Trace tool to get a point on the function 

that can be dragged to the local minimum instead 

of the Point-On tool. The end result is the same 

for each tool. 

 

6. Press b 5 for Menu 5:Trace  
(Figure 33). 

• A point with its coordinates appears on the 

graph of the function. This point is under 
control of the left and right arrow keys. 

 

• As the Trace point moves along the function, 

the coordinate pairs change to indicate the 
approximate position of the point  
(Figure 34). 

7. Press the · key at any time to place a 

point at the current location of the Trace 

point. 

 

 

 

8. Move the Trace point away to see the new 

point on the graph (Figure 35). 

9. You can repeat this operation as many times 

as you want, leaving a point where the Trace 

point was located. 

• These new points are exactly the same as 
points created with the Point-On tool. 

 

Figure 32 

Figure 33 

Figure 34 

Figure 35 



The Swimmer Problem 

T3 PROFESSIONAL DEVELOPMENT SERVICES FROM TEXAS INSTRUMENTS 

EXPLORING MATHEMATICS WITH TI-NSPIRE™ TECHNOLOGY   © 2007 TEXAS INSTRUMENTS INCORPORATED 

 

 
10. Press the d key to end the Trace, leaving 

any copies of points still on the screen 

(Figure 36). 

 

 

 

 

11. Drag the coordinate pair away from the 

remaining point on the graph (Figure 37).  

 

 

 

 

12. Drag the point toward the function’s local 

minimum value until a lower case “m” 

appears on the screen and the point “jumps” 

to the computed minimum value (Figure 38).  

• Text comments can be added to the screen to 
annotate what the graph shows. 

13. Compare this solution—the lifeguard runs 

134.5081 meters down the beach before 

jumping into the water for a total time of 

47.7974 seconds to get to the swimmer—to 

other solutions found by the geometric and 

numerical methods. 

• Notes can be made on a new page with the 
Notes application (Figure 39). 

 

 

 

 

Figure 36 

Figure 37 

Figure 38 

Figure 39 
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4) The Algebraic Solution (using CAS) 

The algebraic solution to the problem begins in a 

similar way as the graphical solution by 

representing the problem situation as a function 

definition (Figure 40). 

1. This can be page 4.1 copied and pasted onto 

a new page 5.1. 

2. Open another new page (5.2 in this example), 

and add the Calculator application  

(Figure 41). 

 

 

 

 

3. Enter the Define command by either 

selecting it from the Tools menu or typing 

the word “define” on the screen using the 

keyboard (Figure 42). 

 

 

 

 

 

4. Copy and paste the function definition from 

page 5.1, or rewrite it on the Calculator 

screen with the keyboard (Figure 43). 

 

 

 

 

Figure 40 

Figure 41 

Figure 42 

Figure 43 
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5. Execute the Define command to define the 

function Tt(x) (Figure 44). 

 

 

 

 

• Notice that the capitol letter “T” is changed 

to lower case. Function definitions are not 
case sensitive, so the program changes 
everything to lower case (Figure 45) 

 

 

 

 

 

 

6. Open the Operations Template menu by 

pressing / r(Figure 46). 

 

 

 

 

 

 

7. Choose the first derivative tool, and enter the 

function name Tt(x) with respect to the 

variable x (Figure 47). 

 

 

 

 

Figure 44 

Figure 45 

Figure 46 

Figure 47 
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 8. Execute this command to find the first 

derivative of the function Tt(x) (Figure 48).  

 

 

 

 

9. Enter the Solve command from the Algebra 

menu (or by typing it on the screen)  

(Figure 49). 

 

 

 

 

 

10. Press the up arrow to highlight the previous 

answer, the first derivative of the function 

Tt(x) (Figure 50). 

11. Press Enter to copy this definition into the 

Solve command. 

 

 

 

12. Set this expression equal to zero (0) and 

solve with respect to the variable x  

(Figure 51). 

13. Execute the Solve command to find the value 

of x when the derivative is equal to zero. 

• This is where, according to the definition of 

the first derivative of a function, the tangent 
line to the function has a slope of zero. This 
is a local maximum or minimum value.  

Figure 48 

Figure 49 

Figure 50 

Figure 51 
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• Figure 52 shows the output when the Enter 

key is pressed. 

• If your handheld is set in Auto mode, the 
exact answer will appear as in Figure 52.  

14. Press / · to solve the equation again 

but with an answer that is an approximate 

decimal value (Figure 52). 

• If the value of x we just found is the point in 

the domain where a local minimum exists, 
then the function value at this point will be 
the solution to our problem. 

15. Evaluate the function Tt(x) at the value found 

for x (Figure 53). 

• The value for x can be copied down by the 

same technique used for the derivative in the 
previous step. 

16. Scroll up, and press ·. 

17. Finally, as done in the numerical solution, we 

can use the 6:Function Minimum [fMin( )] 

command from the 5:Calculus menu  

(Figure 54). 

 

 

 

 

After the minimum value is calculated, the 

function value is computed in the same way as 

the previous step (Figure 55). 

Notice that the numerical values obtained by 

using the fMin( ) tool are identical to those found 

by solving the first derivative set equal to zero 

for x. This is the expected result.  

 

Figure 52 

Figure 53 

Figure 54 

Figure 55 
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Summary of Solutions 

After 4 different solution techniques, how do the 

various results compare? 

1. Add a new problem to the document, and 

open a Notes application (page 6.1 in this 

example). 

• This summary will take on the personal 
characteristics of each individual student.  

• Figures 56 through 58 represent one possible 
example. 

• Others could include a spreadsheet used to 

summarize all the numerical information 
(Figure 59). 

 

Figure 56 

Figure 57 

Figure 58 

Figure 59 
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Name  ____________________________ Car Depreciation Problem 
Student Worksheet 

Class  ____________________________ 

 

As you complete the “D3_6CarDepreciation.tns” TI-Nspire™ math and science learning 
handheld file, answer the following questions. 
 
For your sixteenth birthday, your parents decide to buy you a car. Your parents pay $9000 for 
your new car. A year after buying the car, the car is worth $7650. When you've had the car 
for two years, the car is worth $6502.50. Use this information to complete the questions on 
the following pages. 
 
1. What is the independent variable? 

 
 

2. What is the dependent variable? 
 
 
 

3. What kind of relationship could exist between the variables? Explain.  
 
 
 

4. What kind of function could model the value of the car as it ages? 
 
 
  

5. Why did you choose this type of function over another? 
 

 
 

Sketch a copy of the graph of what your data looked like when you plotted it (Figure 1). 
 
 
 
 
 
 
 
 
 
 
 
  
 Figure 1 
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6. What do you notice about the value of the car as it gets older?  Explain. 

 
 
 

7. At what rate does the value of the car depreciate each year?  
• Explain how you found your answer. 

 
 
 

8. What is an appropriate domain for your function? Explain. 
 
 
 

9. What is an appropriate range for your function? Explain. 
 
 
 

10. Find an exponential function in the form xy ab=  to model the car's value as it ages. 
 
 
 

11. What is the meaning of 'a'? 
 
 
 

12. What is the meaning of 'b'? 
 
 
 
 
Sketch a copy of graph of what your function looked like when you graphed it (Figure 2). 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

 
 
 
 

Figure 2 
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13. Was your function correct? Why or why not? 
 
 
 
 

14. If your function was incorrect, what can you do to fix your model? Explain. 
 
 
 
 

15. What is your final function? 
 
 
 
 

16. What will the value of the car be when you’ve owned it for 10 years? 
 
 
 
 

17. How long will you have owned the car when it is worth $1000? 
 
 
 
 

18. Will the car ever be worth $0? Explain. 
 
 
 
 

19. If the car had been brought to the used car lot three years before your parents bought it, 
how much was it worth when it was first brought to the used car lot? 
 
 
 
 

20. It appears as though the graph never crosses the x-axis. Why does this happen? 
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21. Sketch a copy of the graph the function f2(x)=1000 (Figure 3).  
• Where does the model for the car's value as it ages and the function f2(x)=1,000 intersect? 

 
 
 
 
 
 
 
 
 
 
 

 
 
 
22. What is the meaning of this intersection point? Explain. 

 
 
 
 

23. What would happen to the values in the spreadsheet and the model for the data change if 
the original price of the car was $7500 and the rate of depreciation remained the same? 
 
 
 
 

24. What would happen to the values in the spreadsheet and the model for the data change if 
the original $9000 value of the car decreased by 7% each year? 

 

Figure 3 
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Name  ____________________________ Dream Car Depreciation 
Student Worksheet 

Class  ____________________________ 

Introduction 

To investigate the value of your dream car over time find the price of the car from ages 0 to 8 

on the Internet. (from the present to 8 years ago.) The price should decrease over time. 
 

1. Add a Lists & Spreadsheet application page to a new document on TI-Nspire™ handheld.  
 

2. Move the cursor until it is in the name box next to A or B, depending on which column 
you are naming (Figure 1).   

 
Figure 1 

 
3. Name the first two columns “age” and “value”, respectively (Figure 2). 

 
Figure 2 
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4. Change the width of the columns by following these steps: 

• Press b and then press 1:Actions (Figure 3). 

• Press 2:Resize (Figure 4). 

   
   Figure 3      Figure 4 

• Press · to set the column width (Figures 5 and 6). 

  
Figure 5      Figure 6 

 

5. Enter the data you found for ages 0 through 8 into the table (Figure 7). 

 
Figure 7 
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6. Add a Graphs & Geometry page to your document. 
 
7. Change the function type to “scatter plot” by pressing b (Figure 8). 

 
Figure 8 

 
8. Press 3:Graph Type, and then select 3:Scatter Plot (Figure 9). 

 
Figure 9 

 

9. Press the · key to bring down the menu. 
• Select the list name for the variable x (Figure 10). 

• Press e to go over to the y variable and follow the same steps (Figure 11). 

  
Figure 10     Figure 11 

 
10. Adjust your window to fit your data. 
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11. Press b and then press 3:Graph Type to change your graph back to function mode 
(Figure 12). 

 
Figure 12 

 
12. Find a function in the form y=a*bx for the data that you found online. 

Go back to the first page of your document and in the third column find the rate of decrease 

in the values for each year to the next (Figure 13).  

 
Figure 13 

 
13. Calculate the average of these rates of decrease. 
14. How do the values of ‘a’ and ‘b’ in your exponential decay function compare to the 

values in your table? Explain. 
 
 

15. When will the car be worth $5000?  
 
 
How much will the car be worth in three and one-half years? 
 
 

16. Why might there be a difference between the value of the car at a certain year and the 
value predicted by your exponential function for that year? 
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L e s s o n  P l a n  N o t e s  f o r   
C a r  D e p r e c i a t i o n  

 
Courses: Algebra 1 and Algebra 2 
Topics: Exponential Decay 
Suggested Total Time:  45 minutes 

Overview 

The student activity Car Depreciation Problem 
could serve as a formative assessment 
opportunity on exponential functions. The 
second student activity, Dream Car Depreciation 
could then be a summative assessment piece.  
These notes which follow include how to create 
the student document file. 

Related NCTM Standards 

Grades 9-12 Algebra Standards: 
1. Students should generalize patterns using 

explicitly defined and recursively defined 
functions. 

2. Students should understand relations and 
functions and select, convert flexibly among, 
and use various representations for them. 

3. Students should understand and compare the 
properties of classes of functions, including 
exponential, polynomial, rational, 
logarithmic, and periodic functions. 

4. Students should draw reasonable conclusions 
about a situation being modeled. 

 

Specific Pre-requisite knowledge:  
• Characteristics of exponential functions and 

how they differ from other functions.  
• How to solve exponential functions using 

logarithms. 
 

Materials Required/Classroom Set-
up/Preparation:  
All TI-Nspire™ handhelds will need the 
“D3_6CarDepreciation.tns” file loaded on them. 
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It is recommended that students work in pairs on 
this file so they can discuss their findings. 
 
Lesson Notes 

• Quickly review the basics of exponential 
decay and growth functions, how the 
parameters of these functions affect their 
graphs, and how exponential functions differ 
from other functions. You might also want to 
review how to solve exponential functions.  

• Split students into partner groups and give 
each group a TI-Nspire™ handheld. 

• Students should open the TI-Nspire™ file, 
“D3_2CarDepreciation.tns”. 

• While students are working, keep an eye on 
their progress and help them make 
connections between their model, 
spreadsheet, and the graphs.  

• As an alternative to the given values of the 
car, students could look up the value of any 
car of their choice, examine the change in the 
value of the car over time, and find the rate 
of decay for their own car. They can then use 
their own data to answer the questions within 
the file. 

• When all students have completed the file, 
bring everyone together for a whole class 
discussion about what they learned. Make 
sure that each student has reached the 
following conclusions: 
o An exponential decay function can be 

used to relate a car’s value over time. 
o Within the exponential decay function, 

xy ab= , the value of ‘a’ is determined 
by the car’s original price. The value of 
‘b’ is determined by the rate of 
depreciation. The value of ‘b’ is the 
percentage of the value that a car 
maintains year after year. 

o The age of a car can be calculated using 
logarithms when you know its value. 

o The value of a car can be calculated 
when you know its age. 
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Creating the TI-Nspire™ Handheld 
Calculator File 
Note: 

This activity has instructions on creating the TI-
Nspire document file on the handheld. However, 
due to the large amount of text entry you may 
desire to use the computer software.  
 
1. Add a notes page and type the following text. 

• Car Depreciation Problem 
For your sixteenth birthday, your parents 
decide to buy you a used car. Your parents 
pay $9000 for your car. A year after buying 
the car, it is worth $7650. When you have 
had the car for two years, the car is worth 
$6502.50. Use this information to complete 
the questions on the following pages. 
 

2. Add a notes page and change the template to 
be “Q&A”.  

• Do this by pressing b, 1: Templates, 1: 
Q&A (Figures 1-3). 
 

3. Type the following text into the question 
box. 
1. What is the independent variable? 
2. What is the dependent variable? 
3. What kind of relationship could exist 

between the variables? Explain. 
 

4. Add a notes page, change the template to be 
“Q&A”, and type the following text. 
4.   What kind of function could model the value 
      of the car as it ages? 
5.   Why did you choose this type of function 

over another?  
 

5. Insert a notes page and type the following 
text. 
• On the next page, complete the table by filing 

in the value of the car as it ages. 

Figure 1 

Figure 2 

Figure 3 
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6. Add a lists and spreadsheet page.  
• Label columns A and B as “age” and “value” 

respectively.  
• Resize the columns so you can see the 

complete labels (Figure 4). 
 
 
 
 
 
 
 
 

7. Under the age column, type in ages 0 through 
10 and under the value column type in the 
value of the car for the first three ages 
(Figure 5). 
 
 
 
 
 
 

8. Split the screen using the “Custom Split” 
feature. Do this by following these steps: 

• Press /c. 
• Press 6: Page Layout (Figure 6). 

 
 
 
 
 
 
 
 
 
 

• Press 1: Custom Split (Figure 7). 
 
 
 
 
 
 
 
 

Figure 4 

Figure 5 

Figure 6 

Figure 7 
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• Use the navigation keys to move the split line 
to the left so that only the first two columns 
in the spreadsheet are being shown.  

• Press · when you have the screen split 
where you want it (Figure 8). 
 
 
 
 
 
 
 

9. Switch to the right side of the screen and add 
a Graphs & Geometry page.  
• Change the graph type to a scatter plot.  
• Let the x variable be ‘age’ and let the y 

variable be ‘value’ (Figure 9). 
 
 
 
 
 
 
 
 

10. Change the window parameters to be  
Xmin: -1, X max: 15, Ymin: -0.5,  
Ymax: 10000 (Figure 10).   
• You may wish to move the scatter plot label 

(age, value). 
 
 
 
 
 

11. Hide the function entry line (Figure 11). 
 

12. Add a notes page, change the template to be 
“Q&A” and type the following text. 
6.   What do you notice about the value of the car 

as it gets older? Explain. 
7.   At what rate does the value of the car  

depreciate each year? Explain how you found 
your answer. 

Figure 8 

Figure 9 

Figure 10 

Figure 11 
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13. Add a notes page, change the template to be 

“Q&A” and type the following text. 
8.   What is an appropriate domain for your  
 function?  Explain. 
9.   What is an appropriate range for your  

function?  Explain. 
14. Add a notes page, change the template to be 

“Q&A” and type the following text. 
10.  Find an exponential function in the form 

y=a*bx to model the car’s value as it ages. 
11.  What is the meaning of ‘a’? 
12.  What is the meaning of ‘b’? 

15. Add a notes page and type the following text. 
• On the next page, type the function into the 

function line to see if your function was 
correct. 

16. Insert a page, but do not add an application. 
17. Go back to the scatter plot that appears 

earlier in the problem.  
• Press Ctrl K to select the application and then 

press Ctrl C to copy the application. 
• Return to your blank page and press Ctrl V to 

paste the scatter plot into the page.  
18. Change the graph type to “function” 

(Figure 12). 
19. Add a notes page, change the template to be 

“Q&A”, and type the following text. 
13.  Was your function correct? Why or why not? 
14.  If your function was incorrect, what can you  
 do to fix your model? Explain. 

20. Insert a notes page and type the following 
text. 
15.  Once you have a model that you think will 

work, go back to the previous graph page and  
change your function to check your answer. 
What is your final function? 

21. Add a notes page, change the template to be 
“Q&A”, and type the following text. 
16.  What will the value of the car be when  
 you’ve had it for 10 years? 
17.  How long will you have owned the car when 

it is worth $1000? 
 

Figure 12 
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22. Add a notes page, change the template to be 
“Q&A” and type the following text. 
18.  Will the car ever be worth $0? Explain. 
19.  If the car had been brought to the used car lot 

three years before your parents bought it, 
how much was it worth when it was first 
brought to the used car lot? 

23. Add a notes page, change the template to be 
“Q&A”, and type the following text. 
20.  It appears as though the graph never crosses 

the x-axis. Why does this happen? 
24. Add a notes page, change the template to be 

“Q&A”, and type the following text. 
• On the next page, the function f2(x) = 1000 

has been graphed. Press “Enter” when your 
function f1(x) is active to see its graph.  

21. Where does the model for the car’s value as 
it ages and the function f2(x) = 1000 
intersect?  

22. What is the meaning of this intersection 
point? Explain.  

25. Insert a page. Copy the scatter plot and 
function, f1(x), from earlier in the problem 
onto the page. Graph the function 
f2(x)=1000. 

26. Add a notes page, change the template to be 
“Q&A”, and type the following text. 
23.  What would happen to the values in the  

spreadsheet and the model for the data if the 
original price of the car was $7500 and the 
rate of depreciation remained the same?  

24. What would happen to the values in the 
spreadsheet and the model for the data if the 
original $9000 value of the car decreased by 
7% each year?  

27. Add a notes page and type the following text. 
• Create a spreadsheet for the car’s value if the 

original price had been $7500 and the car’s 
value depreciated by 7% each year.  

• Then, analyze how the new data and the 
scatter plot compare to the data and scatter 
plot from the original problem. 

• It might help to change the graphing style of 
one of the scatter plots by changing the 
attributes. 
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28. Add a new page and copy the spreadsheet 
from the beginning of the document.  
• Label column C “car2.”   
• Enter the data for the second car in column 

car2. 
29. Add a new page and copy the scatterplot of 

value versus age from the beginning of the 
document.   
• Graph the data for car2 versus age.   
• Change the graphing style of one of the 

scatter plots. 
30. Add a notes page, change the template to be 

“Q&A”, and type the following text. 
• How are the two scatter plots similar? 

Explain. 
• How are the two scatter plots different? 

Explain. 
31. Add a notes page, change the template to be 

“Q&A”, and type the following text. 
• Find a function that would model the data for 

the second car.  
• Explain how you found the values of ‘a’  

and ‘b.’ 
32. Add a notes page, change the template to be 

“Q&A”, and type the following text. 
• Is it possible for these two cars to cost the 

same amount after they have been 
purchased? Why or why not? 

• How would the graphs look if the two cars 
cost the same amount? 
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M a x i m i z e  t h e  A r e a  o f  a  G a r d e n  

Concepts 
• Perimeter 
• Area 
• Optimization 
• Quadratic Functions 
• Derivatives 

Materials 
• TI-Nspire™ Math and Science 

Learning Handheld 

Overview 
This activity describes the steps necessary to create the student .tns file. 
Students will be investigating what is the maximizing area possible with a 
fixed perimeter. 
 

 

Getting Started 

1. Open a new TI-Nspire™ document, and add 

a Notes page. 

2. Enter the title for the activity on the Notes 

page (Figure 1). 

 

 

3. Add another new Notes page, and complete a 

description of the problem (Figure 2). 

4. Add a third new Notes page. 

 

 

 

 

5. Press / c 6 2 3 for 6:Page 

Layout, 2:Select Layout and 3:Layout 3 

(Figure 3). 

• This will create a horizontal split of your 

page. 

• The upper pane will still be active. 

Figure 1 

Figure 2 

Figure 3 



Maximize the Area of a Garden 

T3 PROFESSIONAL DEVELOPMENT SERVICES FROM TEXAS INSTRUMENTS 

EXPLORING MATHEMATICS WITH TI-NSPIRE™ TECHNOLOGY   © 2007 TEXAS INSTRUMENTS INCORPORATED 

 
6. Complete the final set of instructions in the 

upper pane as shown in Figure 4. 

7. Press / e to switch from the upper 

pane to the lower pane. 

 

Graphs & Geometry: Create a Rectangle 

1. Add a Graphs & Geometry page. 

2. Press b 2 1 for Menu 2:View, 

1:Hide Axes. 

3. Press / G to hide the entry line. 

4. Press b 6 4 for Menu  

6:Points & Lines, 4:Line. 

5. Add a line across the screen. 

6. Press b 1 3 for Menu 1:Tools, 

3:Attributes. 

7. Click on the line you drew on the screen, and 

the Attributes Menu will appear. 

8. Press ¢ on the first option to make the line 

appear thick (Figure 5). Press ·. 

9. Press b 8 3 for Menu  

8:Shapes, 3:Rectangle. 

• The rectangle tool requires you to identify 

three corners of your rectangle. 

10. To begin, click on the thick line from the last 

step, move the cursor down, and press · 

to anchor the second point. 

11. Finally, move the cursor right to the third 

point, and press · a final time (Figure 6). 

12. Press b 1 5 for Menu 1:Tools, 

5:Text. 

Figure 4 

Figure 5 

Figure 6 
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13. Use Text tool to add the labels width, 

length, area, and Barn (Figure 7). 

 

 

 

 

14. Press c 4 to add a new Notes page, 

and enter the message shown in Figure 8. 

 

 

 

 

 

15. Press / c 6 2 2 for Menu 

6:Tools, 2:Page Layout, 2:Select Layout, 

2:Layout 2 (Figure 9). 

• This will create a vertical split on the current 

page. 

16. Press / e to switch to the right work 

area. 

 
Lists & Spreadsheet: Data Collection 

1. Add a Lists & Spreadsheet page. 
2. Name the columns ‘wid’ and ‘area’. 

3. In each column, press b 1 2 for 

Menu 1:Actions, 2:Resize. 

4. Press ¢ on the NavPad cursor control to 

widen the column, and press · when you 

have the column width that you want  

(Figure 10). 

Figure 7 

Figure 8 

Figure 9 

Figure 10 
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5. Add the data from your exploration  

(Figure 11). 

 

 

Graphs & Geometry: Scatter plot 

1. Press c 2 to open a new Graphs & 

Geometry page. 

2. Press b 4 1 for Menu 4:Window, 

1:Window Settings. 

3. Change the values as shown in Figure 12. 

 

 

 

 

 

4. Press b 3 3 for Menu  

3:Graph Type, 3:Scatter Plot to change the 

type of graph (Figure 13). 

 

 

 

 

 

5. Choose variables for the scatter plot  

(Figure 14). 

 

 

 

 

Figure 11 

Figure 12 

Figure 13 

Figure 14 
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Lists and Spreadsheet: Quadratic 
Regression  

1. Press / ¥ to move back to Lists & 

Spreadsheet on page 1.4. 

• This is where we will create the regression 

equation. 

2. Press b 4 1 6 for Menu 

4:Statistics, 1:Stat Calculations, 6:Quadratic 

Regression (Figure 15). 

3. Complete the dialog box for quadratic 

regression by choosing column C for the 

field “1st result column” (Figure 16). 

• Tab to highlight OK and press Enter. 

 

 

 

 

• The results of the quadratic regression will 

appear in columns C and D (Figure 17). 

• You may choose to resize these columns. 

 

 

 

 

 

 

 

 

 

 

Figure 15 

Figure 16 

Figure 17 
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 4. Press / ¦ to return to Graphs & 

Geometry page (page 1.5). 

5. Press b 3 1 for Menu  

3:Graph Type, 1:Function. 

6. In the entry line at the bottom of the Graphs 

& Geometry page, scroll up to f1(x), and 

press ·. 

• The regression graph will appear on the 

screen (Figure 18). 

7. Resize the window as needed. 

8. As a first attempt, press b 4 9 for 

Menu 4:Window, 9:Zoom Stat (Figure 19). 

• If necessary, press b 4 1 for 

Menu 4:Window, 1:Window Settings to 

change the settings so that the maximum is 

available. 

9. Press b 5 for Menu 5:Trace  

(Figure 20). 

• By default, the trace will begin on the scatter 

plot. 

10. Press £ on the NavPad to tab to the function 

plot. 

11. Move the trace point by pressing ¡ and ¢ on 

the NavPad. 

12. Press · to set the point. 

13. Grab the Trace Point, and move it left and 

right. 

• When the Trace Point is on the local 

maximum, a caption with the letter “M” will 

appear next to the hand (Figure 21). 

Figure 18 

Figure 19 

Figure 20 

Figure 21 
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 Optional: Using CAS 

Following up on the geometric solution above, 

we can build an algebraic solution on a 

Calculator page. 

1. Press / c 2 8 to insert a new 

problem (2.1) in the same document, if 

desired (Figure 22). 

2. When the choice of tools appears, choose 

1 for 1:Add Calculator. 

• To guide students through the calculus 

solution, you can insert comments on the 

calculator page. 

3. Press b 1 6 for Menu 1:Tools, 

6:Insert Comment (Figure 23). 

 

4. Enter the comments as shown in Figure 24. 

5. Press c 1 to add a new Calculator 

page. 

 

 

 

 

 

6. Press b 1 1 for Menu 1:Tools, 

1:Define (Figure 25). 

7. Enter the name of the function on the left 

side of the equal sign and the algebraic 

definition of the function on the right side of 

the equal sign. 

 

Figure 22 

Figure 23 

Figure 24 

Figure 25 
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8. Add the next comment shown in Figure 26 to 

guide users. 

 

 

 

 

 

9. Press b 5 1 for Menu 5:Calculus, 

1:Derivative (Figure 27). 

• A derivative template appears. 

10. Enter the variable x in the denominator of the 

derivative template and the function a(x) in 

the argument field. 

 

 

11. Add the next comment shown in Figure 28 to 

guide users. 

 

 

 

 

 

 

12. Press b 4 1 for Menu 4:Algebra, 

1:Solve (Figure 29). 

• Use the Solve command to find the zeros of 

the equation. 

13. In order to insert the expression for the first 

derivative, either re-type it here, or scroll up 

to the result, and press ·. 

Figure 26 

Figure 27 

Figure 28 

Figure 29 
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14. Complete the solve command (Figure 30). 

15. Press c 1 to add a new Calculator 

application page. 

 

 

 

 

 

16. Add the comment as shown in Figure 31. 

 

 

 

 

 

We are going to use the second derivative test so 

we will need to find another derivative. 

17. Add the comments as shown in Figure 32. 

18. Press c 1 to add a new Calculator 

page. 

 

 

 

 

19. Add the comments as shown in Figure 33, 

and calculate the length and area. 

20. Press c 1 to add a new Calculator 

page. 

 

 

 

Figure 30 

Figure 31 

Figure 32 

Figure 33 
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21. Add the comments shown in Figure 34 to 

conclude this part of the solution. 

Note: This could also have been done using a 

Notes page. 

 

Alternate Solution 

There is an alternate solution using more 

geometry tools. 

1. Press / c 2 8 to create a new 

problem if desired. 

2. Add a Graphs & Geometry page. 

3. Press b 4 1 for Menu 4:Window, 

1:Window Settings. 

4. Change the settings as shown in Figure 35. 

5. Press b 2 1 for Menu 2:View, 

1:Hide Axes (Figure 36). 

• Notice that you can also use this same menu 

to hide the entry line. 

6. Hide the entry line as well. 

 

This solution will use the scale feature. 

7. Press b 2 4 for Menu 2:View, 

4:Show/Hide Scale (Figure 37). 

• A line segment should appear in the upper 

right corner of the screen with the label  

“1 cm” beneath it. 

 

 

Figure 34 

Figure 35 

Figure 36 

Figure 37 
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8. Move the cursor to the label, and press x. 

• This will allow you to edit the unit of 

measurement. 

9. Change the “1 cm” to “5 ft” (Figure 38). 

10. Press b 6 5 for Menu  

6:Points & Lines, 5:Segment. 

11. Construct two segments – one at the top of 

the screen and a second one in the lower part 

of the screen. 

12. Label point A as soon as you create it. 

13. Press b 6 2 for Menu  

6:Points & Lines, 2:Point On. 

14. Construct points B and C as shown in Figure 

39, and label them immediately. 

15. Press b 1 5 for Menu 1:Tools, 

5:Text. 

16. Add the label BARN above the upper line 

segment. 

17. Press b 7 1 for Menu 

7:Measurement, 1:Distance. 

18. Click on point A and then point B. 

19. Move the measurement off to the side 

(Figure 40). 

• This measurement will be used as the width 

of the garden. 

20. Press b 9 1 for Menu 

9:Constructions, 1:Perpendicular. 

21. Click on Point C and the line segment 

through point C (Figure 41). 

• A perpendicular line will appear through 

point C. 

Figure 38 

Figure 39 

Figure 40 

Figure 41 
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22. Press b 6 8 for Menu  

6:Points & Lines, 8:Vector (Figure 42). 

23. Construct two vectors, one south of point C 

and one due east of point C. 

24. Once you chosen the vector tool, press x 

while on point C and then click x again on 

the line segments passing vertically through 

point C. 

25. Before you press anything else, press x on 

point C and then press x again on the line 

passing horizontally through point C  

(Figure 43). 

 

 

 

26. Use the text tool to create an expression for 

the length of the garden (Figure 44). 

 

 

 

 

 

 

27. Press b 1 7 for Menu 1:Tools, 

7:Calculate (Figure 45). 

• We will use this tool to calculate the value 

for the length of the garden. 

28. Click on the expression “62-2*w”. 

• As you move away from this expression, you 

will see a “w” in the caption. 

 

Figure 42 

Figure 43 

Figure 44 

Figure 45 
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29. Click on the measurement, and move the 

result to a spot beside the formula  

(Figure 46). 

• The measurements for width and length can 

be transferred to the two vectors in the 

diagram. 

30. Press b 9 8 for Menu 

9:Constructions, 8:Measurement transfer 

(Figure 47). 

 

 

 

 

 

31. Click on the measurement for width and then 

the vector pointing south. 

32. Immediately label this point E (Figure 48). 

33. Click on the measurement for length and 

then the vector pointing east. 

34. Immediately label this point D (Figure 48). 

35. Drag point B to see the location of these 

points change. 

36. Use the Hide/Show tool to hide the vectors, 

the perpendicular line, and the points  

(Figure 49). 

• It might be necessary to extend the horizontal 

line segment through C. 

 

 

 

 

Figure 46 

Figure 47 

Figure 48 

Figure 49 
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 37. To complete the rectangle representing the 

garden, construct a line segment connecting 

C to E (Figure 50). 

38. Construct a perpendicular to CE at E and a 

perpendicular to CD at D. 

 

• It might be necessary to extend the line 

through E so that it intersects the line  

through D (Figure 51). 

39. Press b 6 3 for Menu  

6:Points & Lines, 3:Intersection Point(s).  

 

 

 

40. Construct the intersection of the two 

perpendicular lines, and immediately label it 

as F (Figure 52). 

 

 

 

 

41. Hide the perpendicular lines, and construct 

line segments EF and DF. 

• We now have the widths CE and DF and 

length EF (Figure 53). 

• The measurements for these are also on the 

screen. 

42. Assign the variables “W” and “L” to the 

measurements for width and length on the 

screen. 

 

Figure 50 

Figure 51 

Figure 52 

Figure 53 
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43. Using the Text tool, create the expression 

“CE*EF” (Figure 54). 

• This will represent the area of the garden. 

44. Use the Calculate tool to evaluate the 

expression “CE*EF”. 

 

 

45. Click on the values for “W” and “L” to 

complete the calculation (Figure 55). 

 

 

 

 

 

46. Add a new Lists & Spreadsheet page. 

47. Label the first two columns “awidth” and 

“aarea” (Figure 56). 

 

 

 

 

48. With the cursor on the formula line for 

column A, press b 3 2 1 for 

Menu 3:Data, 2:Data Capture,  

1:Automated Data Capture (Figure 57). 

• A formula will appear in column A. 

 

 

 

Figure 54 

Figure 55 

Figure 56 

Figure 57 
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49. Replace the text “var” with variable W and 

press · (Figure 58). 

• A dialog box will appear asking you to 

indicate if “W” is a cell or variable reference.  

 

 

 

50. Open the dialog box, and select Variable 

Reference (Figure 59). 

51. Press · or e to move to the OK 

button, and press ·. 

 

 

 

 

52. For column B, choose the variable “area” 

(Figure 60).  

• The numbers that appear in the first row are 

the current values for W and area from the 

construction on page 3.1. 

53. Press c 2 to add a Graphs & 

Geometry page. 

 

54. Press b 3 3 for Menu  

3:Graph Type, 3:Scatter Plot (Figure 61). 

 

 

 

 

Figure 58 

Figure 59 

Figure 60 

Figure 61 



Maximize the Area of a Garden 

T3 PROFESSIONAL DEVELOPMENT SERVICES FROM TEXAS INSTRUMENTS 

EXPLORING MATHEMATICS WITH TI-NSPIRE™ TECHNOLOGY   © 2007 TEXAS INSTRUMENTS INCORPORATED 

 

  

55. Press · to open the drop down box, and 

select “awidth” for the x-variable  

(Figure 62). 

56. Press e to move to the y-variable drop 

down box and select “aarea” (Figure 62). 

• The window will need to be changed to 

accommodate the data. 

57. Press b 4 1 for Menu 4:Window, 

1:Window Settings. 

58. Change the values as shown in Figure 63. 

 

 

 

• At the moment, there is only one data point. 

You will see it on the screen with the label 

(awidth, aarea) (Figure 64). 

59. Press / ¥ twice to move back two 

pages. 

 

 

 

 

 

60. Grab point B at the bottom of the screen 

(Figure 65). 

 

 

 

 

Figure 62 

Figure 63 

Figure 64 

Figure 65 
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• As you drag point B, you will be changing 

the width, length, and area (Figure 66). 

 

 

 

• Also, as point B is dragged on page 3.1, new 

rows of data were be captured in the 

spreadsheet on page 3.2 and plotted on the 

graph on page 3.3 (Figure 67). 

• The graph appears quadratic. 

 

 

 

 

61. To test the relationship, press b 3 

1 for Menu 3;Graph Type, 1:Function 

(Figure 68).  

62. Type the equation f1(x) = x*(62-2x) and 

press ·. 

63. To test the relationship, press / ¥ to 

move back to page 3.2. 

 

64. In column C, move to the formula line, press 

=, and enter the formula f1(awidth) 

(Figure 69).  

65. Press ·.  

• The fact that the function values in column C 

match up perfectly with the captured data 

values in column B indicate that the function 

matches the data. 

Figure 66 

Figure 67 

Figure 68 

Figure 69 
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66. Press / ¦ to move back to page 3.3.  

67. Add a trace point, and drag it horizontally 

using the ¡ and ¢ NavPad controls  

(Figure 70). 

• When the caption with a capital “M” appears, 

you have found the maximum value of the 

area. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 70 
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L e s s o n  P l a n  N o t e s  f o r   
M a x i m i z e  t h e  A r e a  o f  a  G a r d e n  

 Course(s):  Calculus, Pre-Calculus (without the CAS part) 

Topic(s): Area of a rectangle, Perimeter of a rectangle, 
Representing widths and lengths of rectangles 
in terms of a variable 

NCTM Standards:  

All students should… 
Grades 9-12 Algebra Standards: 

• generalize patterns using explicitly defined and 
recursively defined functions 

• understand and perform transformations such as 
arithmetically combining, composing, and inverting 
commonly used functions, using technology to perform 
such operations on more-complicated symbolic 
expressions 

• understand and compare the properties of classes of 

functions, including exponential, polynomial, rational, 
logarithmic, and periodic functions 

• interpret representations of functions of two variables 

• use symbolic algebra to represent and explain 
mathematical relationships 

• judge the meaning, utility, and reasonableness of the 

results of symbol manipulations, including those carried 
out by technology 

• draw reasonable conclusions about a situation being 
modeled 

Grades 9-12 Geometry Standards: 

• analyze properties and determine attributes of two- and 
three-dimensional objects 

• use Cartesian coordinates and other coordinate systems, 

such as navigational, polar, or spherical systems, to 
analyze geometric situations 
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• investigate conjectures and solve problems involving 

two- and three-dimensional objects represented with 
Cartesian coordinates 

• draw and construct representations of two- and three-
dimensional geometric objects using a variety of tools 

• use geometric models to gain insights into, and answer 
questions in, other areas of mathematics 

Suggested Total Time: 50 minutes 

Specific Pre-requisite knowledge:  

Students need to be able to: 

• represent the dimensions of a rectangle in terms of a 

single variable with the constraint of how much fence 
is available. 

• graph equations, create regression equations, and plot 
data using TI-Nspire™. 

Students using CAS should be familiar with these 
features: derivatives; solving equations; defining 
functions; evaluating functions. 

Materials Required/Classroom Set-up/ Preparation:  

There are two versions of this activity: 

1. The file “D3_7MaximizeArea.tns”should be 
downloaded to each student’s TI-Nspire™ handheld. 

2. The teacher version “D3_7MaximizeAreaTch.tns” has 
the same information as the student version, but it also 
has the answers and solutions to all questions. 

Besides their TI-Nspire™ learning handheld, each student 
will need a piece of paper. A straightedge is optional. 

Lesson Notes: 

The activity is self-directed. The students need to have the 
activity on each of their calculators and pieces of paper to 
make some sketches and to explore some algebraic 
representations and manipulations. 
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L i v e  D a ta  S h a r i n g  

Materials 
• TI-Nspire™ Computer Software for 

Math and Science 
• D3_8LiveDataSharing.tns file  

Overview 
Linking of data between a scatter plot and spreadsheet is explored. With that 
linking the impact of moving data points on the regression line is explored.  

 
NCTM Standards 
All students should… 

Grades 6-8 Algebra Standards: 

1. represent, analyze, and generalize a variety of 
patterns with tables, graphs, words, and, 
when possible, symbolic rules 

2. relate and compare different forms of 
representation for a relationship 

3. identify functions as linear or nonlinear and 
contrast their properties from tables, graphs, 
or equations 

4. explore relationships between symbolic 
expressions and graphs of lines, paying 
particular attention to the meaning of 
intercept and slope 

5. model and solve contextualized problems 
using various representations, such as graphs, 
tables, and equations 

6. use graphs to analyze the nature of changes 
in quantities in linear relationships 

Grades 9-12 Algebra Standards: 

1. interpret representations of functions of two 
variables 

2. use symbolic algebra to represent and explain 
mathematical relationships 

3. judge the meaning, utility, and 
reasonableness of the results of symbol 
manipulations, including those carried out by 
technology 

4. draw reasonable conclusions about a 
situation being modeled 
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Introduction 

There are two choices with this activity: 

• Open the prepared TI-Nspire™ .tns 

document file “D3_8LiveDataSharing.tns” 
and move to next section of steps called 
Working with Linked Data, or 

• Start this activity from a blank document and 

create from the beginning by following the 
steps in Constructing the Basic Document 
section immediately following this 
introduction. 

  

Constructing the Basic Document 

1. Open a new TI-Nspire™ document. 

• This example will be completed with the  

TI-Nspire™ Computer Software, not the  
TI-Nspire™ math and science learning 
handheld. 

2. Click on the blank page, and add a Graphs & 

Geometry application (Figure 1). 

• This activity will be completed in split screen 
mode. 

3. Using the Page Layout menu, choose a 

vertical page split  to create two work 

areas on one page. 

4. Click on the new, blank work area, and add a 

Lists & Spreadsheet application (Figure 2). 

5. Click in the Graphs & Geometry work area, 

click the Window menu , and select the 

Zoom - Quadrant 1   tool to reset the axes 

to the first quadrant (Figure 3). 

Figure 1 

Figure 3 

Figure 2 
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6. Next, click the Points and Lines menu , 

and select the Point tool . 

7. Place and label nine (9) points, A through I, 

randomly distributed in the first quadrant of 

the graph (Figure 4). 

• The best way to label these points is to “label 
on the fly” by typing the label immediately 
after each point is created. 

• If you do not label points as they are created, 

use the Text tool in the Tools menu to create 
these labels later. 

Note: Labels are automatically attached to 

points and vertices so that the label 

moves when the point is dragged; you 

cannot drag a label off a point, only 

reposition it. 

8. Pres Esc to exit the Points tool. 

9. From the Tools menu , select the 

Coordinates & Equations tool  to display 

the coordinates of points A through I  

(Figure 4). 

10. Mouse click on the point to display the 

coordinates.  

11. Then mouse click again to place the 

coordinates in convenient places so that they 

are clearly associated with the correct points 

on the screen. 

Figure 4 
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• You may want to readjust the position of 

these coordinates, the labels, the points 
themselves, or the two work areas. 

12. Press Esc to exit the Coordinates tool. 

13. Select the x-coordinate of point A by clicking 

on the number once with the mouse. 

14. Then click the Variable button on the 

main tool bar to open the variable storage 

menu on the Graphs & Geometry work area 

(Figure 5). 

15. Store this value as the variable ax (for the  

x-coordinate of point A). 

• The x-coordinate for A will becomes bold to 
indicate it is a variable. 

16. Repeat this same procedure for the  

y-coordinate of point A storing it as the 

variable ay. 

17. Repeat this process for all the other 

coordinate pairs on the screen, naming them 

appropriately for each of the individual 

points B through I. 

• The end result is that there are 18 identifiable 

stored variables that can be linked to other 
applications within this problem. 

We are going to create two lists in the Lists & 

Spreadsheet application, one with all the  

x-coordinates of the points (column A) and one 

with all the y-coordinates (column B). 

Figure 5 
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18. Click on the Lists & Spreadsheet work area, 

and select cell A1 by clicking in the cell. 

• You are now ready to Link this cell to a 
stored variable. 

Note: Do not name either of the two list columns 

when doing this type of data linking. 

 

19. After the A1 cell is selected, click the 

Variables Menu button  on the main tool 

menu again. 

20. From the Link To: list, choose ax (Figure 6).  

• This places the x-coordinate of point A into 
cell A1. 

 

 

 

 

 

21. Cell B1 should contain the y-coordinate of 

point A, the variable named ay in this 

example (Figure 7). 

22. As you move down to Row 2, the cells A2 

and B2 will hold the x- and y-coordinates of 

point B respectively. 

• Each time another coordinate is entered into 

a cell, select the cell first with the mouse and 
then Link to: the variable so the value will be 
placed into the correct cell.  

23. Repeat this linking of variables into the cells 

of the spreadsheet until all 9 points with their 

18 coordinates are linked (Figure 8). 

Figure 6 

Figure 7 

Figure 8 
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• The final product of this process will be two 
lists of coordinates (Figure 9). 

  

24. Click in the Graphs & Geometry work area 

to activate the mouse cursor. 

 

 

 

 

25. Now drag different points around the graph, 

one at a time (Figure 10). 

• Notice that the coordinates of the points 
change in both the graph and the spreadsheet.  

 

 

26. On the Tools menu , use the Hide/Show 

tool  to hide all of the coordinate pairs 

showing on the graph (Figure 11). 

• This does not break the connection to the 
values showing in the spreadsheet. 

• Drag the points again to check this link. 

Note: The width of a column in the spreadsheet 

can be changed by grabbing and moving 

the column divider bar between the top-

most cells that might contain column 

names. 

 

 

 

Figure 9 

Figure 10 

Figure 11 
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27. Click on the Lists & Spreadsheet work area. 

28. Double-click in a cell, such as B3 

representing the y-coordinate of point C, and 

type a new value for this coordinate  

(Figure 12). 

 

 

 

29. Press Enter on your keyboard, and the point  

C on the graph “jumps” to the new location 

defined by the entered coordinate  

(Figure 13 as compared to Figure 11). 

• The result of this process is a “live” two-way 

linking of the coordinates of the points on the 
graph and in the spreadsheet. 

 

Working with Linked Data 

If you have not constructed the file using the 

previous steps, you can open the TI-Nspire™ 

.tns document file D3_8LiveDataSharing.tns 

and start here. 

Now that the live link is created between the 

points on the graph screen and their numerical 

equivalents (coordinates) in the spreadsheet, let’s 

treat these values as “data” by performing a 

regression analysis on the two “lists.” 

1. With your mouse, select both columns of 

data by clicking on the ‘A’ and dragging 

across the top until both columns A and B 

are highlighted (Figure 14). 

Figure 12 

Figure 13 

Figure 14 
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2. From the Statistics menu , select the Stat 

Calculations submenu, and choose either 

‘Linear Regression (mx + b)’ or ‘Linear 

Regression (a + bx)’ for the first analysis 

(Figure 15). 

 

 

 

• Once the regression model is chosen, a 

dialogue box appears with the selected lists 
entered in the order they were selected 
(Figure 16). 

• The results of the regression analysis will be 
started in the 1st Result Column for data, or 
“c[ ]” in this case. 

Notes:  If you do not select the two columns of 

values for the regression analysis by 

dragging before selecting a Linear 

Regression command, or if the columns 

are not adjacent to each other in the 

correct order on the spreadsheet, you 

have two choices while in the Linear 

Regression dialog box: 1) enter any 

column name you want by typing the list 

or column name manually into the 

appropriate fields; or 2) select a list name 

from the drop-down menus to the right of 

each field (Figure 16). 

 

 

 

 

Figure 15 

Figure 16 
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 Note: The column names entered into the field 

for “x-list” and “y-list” are really 

characters like “a[ ]” and “b[ ]” making 

use of the square bracket symbols with 

no space between ( [  ] ). They appear so 

close together that you might mistake 

them for some alternate symbol. 

 You can also change the function 

definition where the regression equation 

will be automatically saved and the 

column name where you wish to have the 

results of the analysis begin—or use the 

defaults (See Figure 16 on the previous 

page).  

3. Click the OK button to perform the selected 

regression, report the results in the 

spreadsheet, and store the resulting 

regression equation in the chosen function 

location in the Function Menu (Figure 17).  

4. Drag any one of the points A through I 

around in the graph, and observe what 

happens to the regression model. 

• Figure 18 shows the “data” points  
dragged into a more linear pattern. The 
values for r and r2 both respond  
accordingly. 

• What happens to the model when one  

point is dragged to a position very different 
than the trend of the others? Explore. 

5. Click in the Function Entry Line at the very 

bottom of the Graphs & Geometry work area. 

Figure 17 

Figure 18 
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• The equation for the currently active 

regression analysis will appear in the chosen 
function definition location (f1(x) in this 
case) but will not be graphed. 

6. Scroll to the stored function definition in the 

Function Entry Line (up or down), and press 

Enter on your keyboard to graph this 

equation (Figure 19). 

7. Drag any of the “data” points A through I, 

and observe what happens to the graph of the 

regression model. 

• Explain how the position of the “data” points 

affects the position of the regression line and 
the numerical values in the regression model. 

The residuals of a regression model represent the 

“error” terms. In other words, the residuals give 

insight into how closely the regression model 

represents the actual data set. 

Also, patterns within the residuals give an 

indication about the appropriateness of the 

chosen model to adequately represent the data 

set. 

During the regression analysis, the residual 

values are stored in a list called stat.resid. 

These residuals can be represented graphically as 

a scatter plot on the same axes with the 

regression line and the “data.” 

8. In the Lists & Spreadsheet work area, scroll 

to the right to display a blank column. 

 

 

Figure 19 
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9. Name the empty columns xcoords in order 

to create a copy of the x-coordinates of the 

“data” points in a named list (Figure 20). 

 

 

 

10. In the xcoords list rule box (the gray cell 

below the name of the column), enter the 

commands =a[ ] to create the named list with 

a copy of the live-linked x-coordinates 

(Figure 21). 

• Dragging any of the “data” points will 

confirm that this new named list is linked to 
the x-coordinates of the moving points.  

 

 

 

 

11. Use the Page Layout tool on the main tool 

bar to split the screen into 4 views or work 

areas  (Figure 22). 

12. In the lower left view, add another Graphs & 

Geometry application. 

13. Click the Window menu , and select the 

Zoom - Quadrant 1   tool to show the first 

quadrant of the new graph. 

14. In the new Graphs & Geometry application, 

click on Graph Type  and select Scatter 

Plot . 

Figure 20 

Figure 21 

Figure 22 
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 15. In the new work area, choose the two named 

lists xcoords and stat.resid for the x 

and y lists, respectively (Figure 23). 

 

 

 

 

16. Once the scatterplot of the residuals appears, 

adjust the window to view all data points 

(Figure 24). 

17. Click to the first Graphs & Geometry work 

area, and drag any of the “data” points A 

through I around the graph screen to observe 

the reaction of the residual plot (Figure 24).  

 

 

 

 

• Figure 25 shows the “data” points  

dragged so that there appears to be a  
pattern in the residual plot. 

• As one “data” point is dragged, explain  
the exact connection of this point to the  
point representing its residual. 

• Also, why do all the residual points move 

when only one “data” point is dragged? 
Explain. 

 

 

 

 

Figure 23 

Figure 24 

Figure 25 
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Extension Activity 

Additional Regression and Residual Models 
on the Same Graph 

Sometimes it is advantageous to compare two or 

more regression models of the same data set on 

the same set of coordinate axes. For example, 

using a linear, quadratic, and exponential model 

might give valuable predictive information about 

the future trends based on conservative, 

moderate, and liberal interpretations of the data. 

While additional regression models are easy to 

add to the analysis, the automatically saved 

residual set stored in the generic list 

stat.resid is replaced with new values 

from the latest regression model executed, every 

time a new regression is performed. 

In order to store or save the current residual list 

as a dynamic list under a different name, we will 

compute the residuals mathematically based on 

the dynamic variables in columns a[ ] and b[ ] in 

the spreadsheet. 

The residuals of a data set are sometimes called 

the “error terms.” This name suggests one way to 

think about the residuals, as the amount the 

regression line “missed” the actual data points.  

Each datum point is described by a coordinate 

pair, (xi, yi). For each datum point’s x-coordinate, 

or each xi, the computed regression model 

predicts a corresponding y-coordinate, or what is 

known as the iŷ value. 
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So for each datum point (xi, yi), there is a 

predicted point (xi, iŷ ). Notice that these two 

points have the same x-coordinate. The 

difference between the two y-values for each 

datum point constitutes the set of residuals, or 

the set of values yi- iŷ . 

Since the regression model is stored in a function 

definition f(x), the differences we want can be 

computed using the regression equation as  

yi – f(xi). 

1. Create a list by naming a column of the 

spreadsheet linresids, and compute the 

set of residuals as  

linresids:= b[] - f1(a[])  

(Figure 26). 

2. Select the lower left Graphs & Geometry 

work area. 

3. Set up Scatter Plot S2 with lists xcoords 

and linresids as the x- and  

y-coordinates, respectively (Figure 27). 

• This scatter plot will exactly match the 
previous plot of stat.resid versus 
xcoords for now. 

• When we add a new regression model, the 

generic scatter plot of stat.resid versus 
xcoords will automatically be a plot of the 
new model’s residuals. 

4. To add another regression model, repeat the 

same steps as before, except the new model 

will be stored in a different function 

definition and the results will be placed in 

different columns in the spreadsheet. 

Figure 26 

Figure 27 
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5. Select the data columns, a[ ] and b[ ], and 

choose the model from the Statistics menu 

, Stat Calculations submenu, Quadratic 

Regression in this example (Figure 28). 

 

 

 

6. Save the new regression equation in function 

f2 (if appropriate for your situation), and start 

the report of the regression values in a blank 

column of the spreadsheet (column g, in this 

case) (Figure 29). 

 

 

 

 

 

 

7. Go to the original Graphs & Geometry work 

area with the data set, and select function 

f2(x) to graph the new regression equation 

over the data and other models (Figure 30). 

• Notice that the new residual plot is already 
showing on the lower graph. 

 

 

 

 

 

Figure 28 

Figure 29 

Figure 30 
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8. Add another Graphs & Geometry application 

in the lower right work area, and change the 

window to the first quadrant using the 

Window menu , and Zoom - Quadrant 1  

 tool (Figure 31). 

9. Select the S1 scatter plot definition, and plot 
stat.resid versus xcoords to show 
only the most recent set of residuals by 
themselves. 

10. Adjust the window as needed to show the 
residual plot you chose. 

11. Drag the original data points around the 
screen, and watch the various representations 
change. 

12. Compare the linear and quadratic models by 
dragging data points to new locations. 

• What do the residual plots tell you about the 
models? Explain. 

13. Add more regression models to the data set 
to compare their reaction as you drag the data 
points around the screen. 

Figure 32 shows quadratic, cubic, and quartic 
models overlaid on the same data set. Notice 
how the three models are nearly identical in the 
inner data range. 

• Could these models be used effectively for 
predictions outside the data range? Explain.  

Figure 33 shows how the three polynomial 
models can all appear nearly linear for a very 
“linear” data set. 

• Explain the value of these models for 
predicting within or outside the data range. 

Figure 31 

Figure 32 

Figure 33 
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